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บทนําบทนํา  
 

การติดตั้ง และยกเลิกการติดตัง้ Install & Uninstall 
 
Minimum System Requirement 

โปรแกรม Phonik Config Builder ถูกออกแบบมาเพื่อใหสามารถรองรับการใชงานไดบนเครื่อง
คอมพิวเตอรที่มีคุณสมบัติไมสูงมากนัก  แตอยางไรก็ตาม  หากสามารถจัดหาเครื่องคอมพิวเตอร
ที่มีคุณสมบัติที่ดีขึ้น  ก็จะทําใหโปรแกรมทํางานไดรวดเร็วยิ่งขึ้น  ความตองการของระบบขั้นต่ํา
สําหรับโปรแกรม  Phonik Config Builder มีดังนี้ 

ระบบปฏิบัติการ (OS)                                – Windows 98 ขึ้นไป 
หนวยประมวลผล(CPU)                              – Pentium2 450 MHz ขึ้นไป 
หนวยความจํา (RAM)                                 – 128 MB 
ความละเอียดจอภาพ (Resolution)               – 1024 x 768 Pixels 
 

How to install 
1. ขั้นตอนการลงโปรแกรม  ใหดับเบิ้ลคลิกที่                 
2. หนาจอแสดงรายละเอียดของโปรแกรม  Phonik Config Builder  จากนั้นใหคลิกปุม Next > 
 

 
 
3. หนาจอแสดงตําแหนงการลงโปรแกรม  จากนั้นใหคลิกปุม Next > 
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4. หนาจอแสดงยืนยนัการลงโปรแกรม     คลิกปุม Next -> 
 

 
5. รอสักครูจนกวาจะ Install เสร็จ   เมื่อติดตั้งเสร็จแลว ใหทานคลิกปุม  -> Close 
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6.  เมื่อติดตั้งเสร็จเรียบรอยแลว  ทานสามารถเขาสูโปรแกรมไดโดย   icon ที่หนา Desktop 
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หรือเขาที่   Start menu    
                                         All Programs  
                                                                    Phonik   ConfigBuilder 
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How to Uninstall 
ในขั้นตอนการ Uninstall ทานสามารถ ทําไดโดยไปที่  Start  Control panel  
 

 
 
Add or Remove Programs 
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2. จากนั้นหาชือ่โปรแกรม Phonik Config Builder    Remove   Yes 
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บทที1่ 
 

การใชงานเบื้องตน 
 

1. คลิกที่ปุม       -> All Program -> Config Builder 
    
 หรือ ดับเบิ้ลคลิกที่ไอคอน    
2. จะแสดงหนาตางดังรูป 
3. โปรแกรมจะใหเลือกโหลดขอมูลเกาหรือไม ตองการกด OK หรือใชคาจากโรงงาน กด Cancel 
4. หรือจะเลือกเปดไฟล default.pnk หรือไฟลอ่ืนที่ตองการ 
 

 
  

 

3. คลิกปุม OK เพื่อยืนยันคําสั่ง ที่จะใหโหลดขอมูล 
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สวนประกอบหนาจอของโปรแกรม 
                     ปรากฏหนาตางโปรแกรมดังรูป  
 
 
           
  

 
 
 
 
 
 
 
 
 
 

Title bar : แสดงชื่อโปรแกรม และ IP ที่ใชงานอยู 

Menu bar : คําสั่งที่ใชในการทํางาน Tool bar : แถบคําสั่งที่ใชในการทํางานบอย 

System Config:   
รายการโปรแกรมทั้งหมด 

Page แสดงขอมูลโปรแกรมที่เรียกขึ้นมาแสดงสถานะ Read/Write 
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Tool Bar 

 
 

 
เปดหนาตางโปรแกรมขึ้นมาใหม 

  

 
เปดไฟลโปรแกรมที่สรางไวใชงาน 

  

 
บันทึกขอมูลเปนไฟล 

  

 แสดงสถานะ การทํางานของโปรแกรม 
ไมมีสีสถานะ Offline ไมไดติดตอกับระบบโทรศัพท 
สีแดงสถานะ Online กับระบบโทรศัพท 

  

 คําสั่งอานขอมูลจากระบบโทรศัพท ขณะออนไลน 
Online Manual Read Write  
Online Auto Read  
Online Read Only 

  

 คําสั่งเขียนขอมูลไปยังระบบโทรศัพท ขณะออนไลน 
Online Manual Read Write  
Online Auto Read  
แต Online Read Only จะไมสามารถใชงาน 

  

 คําสั่งบันทึกการโปรแกรมการทํางานแตละ Page ช่ัวคราวใน Global Data 
ยังไมเก็บในไฟลหรือเขียนเขาไปในระบบโทรศัพท 

  

 ปดหนา Page การทํางาน 
 

   แสดง วัน/เดอืน/ป และ เวลา ของ PBX  ขณะออนไลน 
หรือแสดง วนั/เดือน/ป และ เวลา ของ PC  ขณะออฟไลน 

  
 แสดง ช่ือของระบบ PBX (โปรแกรมจะอานจาก P049 ขณะออนไลน) 
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Status Bar  แสดงเมื่ออานหรือเขียนขอมูลจากระบบโทรศัพท 

  
 

 
 

Pop up  แสดงเมื่อ เขียนขอมูลไปยังระบบโทรศัพท แสดงรายการ P ที่เขียนขอมูลเขาระบบโทรศัพท
และผลการทํางาน (OK หรือ Fail  ในแตละ P) 
***** การ Fail ในแตละ P จะมีผลเฉพาะ P นั้นๆ ***** 
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Tree Bar (System Configuration) 
จะใชเลือกหวัขอที่ตองการตั้งคาระบบ 
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คําแนะนํา : เพือ่ความเขาใจรวมกันในการใชคูมือ ขอกําหนดคํานิยามตางๆ ใหเขาใจรวมกันกอน  
 

นิยามของขอมูลท่ีเก่ียวของ 
การคอนฟกระบบโทรศัพทดวยโปรแกรม Phonik Config Builder นั้น เมื่อผูใชรันโปรแกรม

เพื่อทําการแลกเปลี่ยนขอมูลกับระบบโทรศัพท ขอมูลที่กลาวถึงนี้มีหลายสวน ซ่ึงผูใชควรทําความ
เขาใจกับนิยามขอมูลเหลานี้ ไดแก 
 - Global Data คือ ขอมูลกลางของโปรแกรม ที่ถูกสรางขึ้นและคงอยูเมื่อโปรแกรมทํางาน 
การออกจากโปรแกรมโดยไมจัดเก็บเปนไฟล ขอมูลนี้จะหายไป 
 - Page Data คือ ขอมูลของแตละ Page ที่ผูใชเรียกใชงาน ขอมูลสวนนี้จะสําเนามาจาก Global 
Data เฉพาะ P ที่อยูใน Page นั้น เพื่อใชงานชั่วคราวและจะเคลียรทิ้งเมื่อปด Page 
  ดังนั้น หากเพจนั้นมีการแกไขขอมูล เมื่อตองการเปลี่ยนเพจ โปรแกรมจะถามวา
ตองการใหบันทึกเก็บไวใน Global Data หรือไม 
 - PBX Data คือ ขอมูลที่อยูในหนวยความจําของระบบโทรศัพท 
 
 ชนิดของไฟลคอนฟก 

โปรแกรม Phonik Config Builder สนับสนุนไฟลคอนฟก 2 รูปแบบ ไดแก 
 

1) *.dat ไฟลคอนฟกที่มีนามสกุล .dat เปนไฟลคอนฟกที่มีรูปแบบการจัดเรียงขอมูลตรงกัน
กับไฟลที่เก็บใน SD Card หรือ Compact Flash (CF) ซ่ึงเสียบกับแผงควบคุมหลักของระบบ (DX-
LPU V3) หรือ (JSD-CPU V3) เมื่อผูใชทําคําสั่ง P905    จะเปนการสรางไฟลดังกลาวขึ้นมาใน SD/CF 
ดังนั้นเราสามารถนําไฟล .dat นี้มาโหลดขอมูลเขาโปรแกรมไดโดยตรง (บางครั้งจึงเรียกไฟล .dat นี้
วา Native format) เรียกวาการ Import โดยเรียกเมนู File -> Import from SD/CF 

และเมื่อทําการแกไขขอมูลดวยโปรแกรมเสร็จเรียบรอยแลว เราสามารถสรางไฟล .dat นี้ได
โดยเรียกเมนู File -> Export to SD/CF ผลลัพธที่ไดคือไฟลคอนฟกที่สามารถนําไปโหลดเขาระบบ
โทรศัพทไดเลย เมื่อผูใชทําคําสั่ง P906 จะเห็นไดวา ดวยความสามารถของการ Import / Export  ของ
โปรแกรม Phonik Config Builder ทําใหเราสามารถโปรแกรมระบบของ Phonik ไดไมจําเปนตองตอ
ออนไลนกับระบบโทรศัพท 

 

2) *.pnk ไฟลคอนฟกที่มีนามสกุล .pnk เปนไฟลคอนฟกที่ใชเฉพาะโปรแกรม Phonik 
Config Builder เทานั้นที่จะอานและเขาใจความหมายของขอมูลภายในไฟล เนื่องจากการจัดเรียง
ขอมูลของไฟล .pnk นี้จะไมตรงกับขอมูลของ PBX Data ดังนี้เราจึงไมสามารถสําเนาใส SD/CF แลว
โหลดเขาระบบโทรศัพทไดโดยตรง ตองจัดการผานโปรแกรม Phonik Config Builder เทานั้นทั้งการ
สรางและการโหลดขอมูลเขาระบบโทรศัพท 



 

 

B - 7 

 

การโหลดคา Global 
ในหัวขอ "นิยามของขอมูล" ไดอธิบายถึง Global Data แลววา โปรแกรม Phonik Config 

Builder จะตองมี Global Data อยูเสมอเมื่อรันโปรแกรม  
 
ผูใชสามารถสราง Global Data ไดดวยหลายวิธี 
1. การโหลดคา Global Data ดวยวิธีอานจากไฟลคอนฟกที่ตองการ (นามสกุล .pnk) 
การใชเมนู File -> New จะมีเมนูยอยใหเลือกอีก 2 รายการ คือ Default Config และ Blank 

Config 
 
Default Config เมื่อผูใชเลือกเมนูนี้ โปรแกรมจะสราง Global Data ของทุกรายการ P ใหตรง

กับคาที่กําหนดของโรงงาน เหมาะสําหรับผูใชที่ตองการโปรแกรมระบบโทรศัพทโดยเริ่มจากคาจาก
โรงงาน (ในทางเทคนิคแลว คาที่กําหนดของโรงงานจะถูกเก็บไวในไฟล ช่ือ default.pnk ดังนั้นหาก
ผูใชตองการสรางคาใหมของตนเองก็สามารถทําได โดยการสรางไฟล default.pnk ขึ้นมาใหมใหมี
ขอมูลตามตองการ) 

 
Blank Config เมื่อผูใชเลือกเมนูนี้ โปรแกรมจะสราง Global Data ของทุกรายการ P ตรงกับ

คาของโรงงานเชนเดียวกับกรณี Default Config ยกเวนวารายการ P ตางๆ จะอยูในสถานะ Inactive  
 
การอานคาจากไฟลนั้นทานสามารถเรียกไฟลขอมูลที่ทานตองการอานคาขึ้นมาไดโดยการ 

ไปที่ file -> open จากนั้นเลือกชื่อไฟลที่ทานตองการอานขึ้นมาจากภาพจะเปนการเรียกไฟล ช่ือ 
test.pnk  จากนั้น คลิก Open เพื่อทําการเปดไฟล หรือไฟลอ่ืนๆที่สรางเก็บไวกอนแลว 

 
 2. การโหลดขอมูลจากระบบโทรศัพท ขณะออนไลน 
 การใชเมนู Operation -> Download เมื่อตองการขอมูลจากระบบโทรศัพท PBX Data มาไว
ในโปรแกรมคอนฟกบิ้วเดอร Global Data 
 สําหรับเมนOูperation -> Upload เปนการนําขอมูลจาก Global Data ไปยัง PBX Data 

 
การ Download / Upload นี้ ทานสามารถเลือก Download / Upload ขอมูลได 2 แบบ คือ 
แบบทั้งหมด  All P (s) ……………….แบบทั้งหมดทุกโปรแกรม 
แบบทั้งหมดเฉพาะ P ……………….. โดยทานสามารถเลือกที่จะดาวนโหลดมาเฉพาะกลุม

ของโปรแกรมที่ทานตองการดูหรือแกไขได เพื่อเปนการสะดวกและประหยัดเวลา ในการทํางาน  โดย
แยกออกเปน   P0XX , P1XX , P2XX , P3XX , P4XX , P8XX , P9XX (Special Program)     
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3. การนําขอมูลจากหนวยความจํา SD Card หรือ CF Disk 
ใชเมนู File -> Import from SD/CF นําขอมูลเขา Global Data จากไฟลนามสกุล .dat 
 
เปนการนําคอนฟกของระบบโทรศัพท PBX Data ที่บันทึกไวใน SD/CF Memory แลวนํามา

ตรวจสอบแกไขดวยโปรแกรมคอนฟกบิ้วเดอรบนเครื่องคอมพิวเตอร เมื่อแกไขแลวจะสามารถนํา
กลับไปใสในระบบโทรศัพทได 

 
Partial P 

 ระบบโทรศัพท Phonik อนุญาตใหผูใชแกไขรายการคอนฟกเพื่อใหเหมาะสมกับความ
ตองการ เรียกวาการโปรแกรม (Program) หรือที่เรียกสั้นๆวา P ซ่ึงแตละรายการจะกํากับดวย
หมายเลข 3 หลัก เชน P001 เปนการกําหนดหมายเลขการใชงานทั้งหมดภายในระบบ เชนหมายเลข
ภายใน หมายเลขคําสั่งตางๆ หรือ P013 การกําหนดหมายเลขสมาชิกของกลุม Hunting เปนตน ... 

โปรแกรมคอนฟกบิ้วเดอรก็สามารถบันทึกขอมูลเพียงบางโปรแกรม (บาง P) ที่ตองการได 
เมื่อเรียกกลับมาใชจะแสดงเฉพาะบางโปรแกรม (บาง P) นั้น 

 
*** หมายเหตุ ไฟลคอนฟกแบบนามสกุล . pnk สนับสนุนความสามารถเรื่อง Partial P ดังนั้นหาก
ไฟลคอนฟกที่เลือกนั้นมีขอมูลรายการ P เฉพาะบางรายการ โปรแกรมจะแสดงรายการ P เหลานั้นใน
สถานะ Active (ตัวอักษรจะมีสีเขม) สวนรายการที่ไมมีขอมูลอยูจะแสดงสถานะเปน Inactive 
(ตัวอักษรสีจาง) 
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การใชงานเมนูบาร Menu Bar  
เมนูไฟล File 
 เมนูไฟล ประกอบดวนเมนยูอยๆ ดังนี ้
  New สําหรับสรางไฟลใหม 
  Open สําหรับเปดไฟลที่มีอยูแลว 
  Save to File สําหรับเก็บขอมลูเขาในไฟล 
  Import from SD/CF สําหรับรับขอมูลจาก แผนความจําชนิด SD หรือ CF 
  Export to SD/CF สําหรับสวขอมูลไป แผนความจําชนดิ SD หรือ CF 
  Exit สําหรับออกจากโปรแกรม 
 
1. การเปดเรียกใชงานหนาตางการโปรแกรมดวยขอมูลใหม  

1. คลิกเมนู File ->New -> Default Config   หรือคลิกท่ีปุม  

 
      

 2. โปรแกรมจะถามยืนยันทีจ่ะสรางขอมูลใหมแทนที่ขอมูลเดิม คลิกปุม Yes เพื่อยนืยันการ
ทํางาน หรือ กด No เพื่อยกเลิกการสรางขอมูลใหม 
 
 

Note… . คลิกเมนู File -> New -> Default Config or Blank Config   
Default Config เปนการเรียกคาจากโรงงานใหกับทุกๆพารามิเตอร 
Blank Config เปนการเรียกโปรแกรมทั้งหมดแตจะอยูในสถานะไมทํางาน Inactive 
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2. การเปดไฟลท่ีสรางไวมาใชงาน 

 1. คลิกเมนู File ->Open หรือคลิกที่ปุม  
 2. เลือกตําแหนงโฟลเดอรที่เก็บไฟล 
 3. เปดไฟลที่ตองการ 
 

 
 
*** หมายเหตุ ไฟลคอนฟกแบบนามสกุล . pnk สนับสนุนความสามารถเรื่อง Partial P ดังนั้นหาก
ไฟลคอนฟกที่เลือกนั้นมีขอมูลรายการ P เฉพาะบางรายการ โปรแกรมจะแสดงรายการ P เหลานั้นใน
สถานะ Active สวนรายการที่ไมมีขอมูลอยูจะแสดงสถานะเปน Inactive  
 
3. การบันทึกขอมูลเก็บไวเปนไฟล 
 เปนการนําขอมูลการคอนฟกระบบโทรศัพทเก็บไวในไฟล โดยผูใชสามารถกําหนดชื่อ และ
ตําแหนงของโฟลเดอรที่ตองการได  

***** นามสกุลของไฟลประเภทนี้จะเปน .pnk 
 
Save Selection 

 เปนเทคนิคของการบันทึกทีส่ามารถทําการบันทึกบางสวนหรือทั้งหมดได 
 

3. ดับเบิ้ลคลิกไฟลที่ตองการเปด   
หรือ     คลิกเลือกไฟลแลวกดปุม Open 

2. เลือกตําแหนงที่เก็บไฟล จากชอง Look in  
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เทคนิคการใช Save Selection 
1. Save ทุกรายการ P เปนการเก็บทุกรายการ P ที่อยูในสถานะ Active  มีขั้นตอนดงันี้ 

1) คลิกเลือกเมนู File -> Save to File จะปรากฎหนาจอ ดังภาพ 

 
 
2) คลิกที่ปุม Save แลวตั้งชื่อไฟล 
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2. Save รายการ P ท่ีมีหมายเลขขึ้นตนดวย 0 และ 1 (P0XX และ P1XX) มีขั้นตอนดงันี้ 
1)  คลิกเลือกเมน ูFile -> Save to File จะปรากฎหนาจอ ดังภาพ 
2) ที่กรอบ Selection ใหคลิกที่ Group of P(s) แลวทําเครื่องหมายถูกเฉพาะ P0XX และ P1XX 
 

 
 

 จะสังเกตวาภายในชอง Include P(s) จะมีเฉพาะรายการ P ที่ขึ้นตนดวยหมายเลข 0 และ 1 
คลิกที่ปุม Save แลวตั้งชื่อไฟล เชนเดยีวกบัการ save หวัขอที่แลว 

 
3. Save รายการ P ท่ีมีหมายเลขขึ้นตนดวย 3 แตไมรวม P305 

1) คลิกเลือกเมนู File -> Save to File จะปรากฎหนาจอ ดังภาพ 
2) ที่กรอบ Selection ใหคลิกที่ Group of P(s) แลวทําเครื่องหมายถูกเฉพาะ P3XX 
3) ที่ชอง Include P(s) ใหคลิกเลือก P305 แลวกดปุม Move to Exclude 
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 จะสังเกตวาภายในชอง Include P(s) จะมีรายการ P3XX แตไมมีรายการ P305 
 

 
 

4) คลิกที่ปุม Save แลวตั้งชื่อไฟล 
 



 

 

B - 14 

4. Save เฉพาะรายการ P001 , P002 , P003 , P091 และ P092 
1) คลิกเลือกเมนู File -> Save to File จะปรากฎหนาจอ ดังภาพ 
 

 
 

2) ที่ชอง Include P(s) ใหคลิกเลือกทุกรายการ P แลวกดปุม Move to Exclude จะไดผลลัพธดังภาพ 
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3) ที่ชอง Exclude P(s) คลิกเลือกรายการ P001, P002, P003, P091 และ P092 แลวกดปุม Move to 
Include จะไดผลลัพธดังภาพ 
 

 
 

จะสังเกตวาภายในชอง Include P(s) จะมีเฉพาะรายการ P001, P002, P003, P091 และ P092 
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4) คลิกที่ปุม Save แลวตั้งชื่อไฟล 
วิธีการเลือกรายการ P ในหนาจอ Save Selection 
 ฟงกช่ัน Save Selection ของโปรแกรม Phonik Config Builder จะใชไดอยางมีประสิทธิภาพ
และยืดหยุนมาก หากวาผูใชสามารถเลือกรายการ P ไดอยางรวดเร็ว และตรงตามความตองการ ดังนั้น
ในหัวขอนี้จะขออธิบายวิธีการ "เลือก" รายการ P ในรูปแบบตาง ๆ 

1) การเลือกรายการ P ที่อยูติดกนัเปนชวง 
ตัวอยาง …  

  เชนหากเราตองการเลือกรายการ P001 จนถึงรายการ P020 สามารถทําไดโดย 2 วิธี 
 

- คลิกเมาสปุมซายที่ P001คางไวแลวลากมาจนถึงรายการ P020 ผลลัพธที่ไดเปนดังภาพ 
- กดปุม SHIFT คางไว แลวคลิกเมาสที่ P001 และ P020 ตามลําดับ ผลลัพธที่ได ดังภาพ 
 
 

 
  

 
ผูใชสามารถประยุกตใชวิธีการเลือกรายการ P แบบนี้เพื่อเลือกทุกรายการ P ได 
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2) การเลือกรายการ P ที่ไมอยูติดกนั 
 ตัวอยางเชน จากภาพ ... หากเราตองการเลือกรายการ P001 , P012 และ P014 ซ่ึงไมอยูติดกัน 
สามารถทําไดโดยกดปุม CTRL คางไว แลวคลิกที่รายการ P001, P012 และ P014 ผลลัพธที่ไดดังภาพ  
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4. การนําขอมูลจาก SD/CF 
 เปนการนําขอมูลซ่ึงถูกเก็บไวดวยโปรแกรม P905 ซ่ึงเปนการเก็บขอมลูในหนวยความจํา
แบบ SD หรือหนวยความจําแบบ CF มาใชงาน 
  

วิธีอิมพอรตจาก SD/CF 
ขั้นตอนการอมิพอรตขอมูลจาก SD Card หรือ Compact flash นั้นทานจะตองโหลดผาน Card 

reader ที่สามารถเสียบ SD Card หรือ Compact Flash ได   ขึ้นอยูที่วาทานเลือกใช Card แบบไหน  
- ทําการโหลดขอมูล PBX Data เขา SD/CF Memory ดวย P905 
- จากนัน้ทานก็ถอด Card ออกจากระบบโทรศัพท  
- เสียบ Card เขากับ Card Reader ที่ตออยุกับเครื่องคอมพิวเตอร 
- เครื่องคอมพิวเตอรจะเหน็ Drive ซ่ึงเปน Drive ของ Card Reader  
- จากนัน้ทานมาที่โปรแกรม Config Builder  
- แลวไปที่ File ->  Open -> (Drive Card ของทาน) 
- แลวเลือกไฟล .dat ที่ทานตองการ   
- กด  Open  

 
5. การสงขอมูลไป SD/CF 
 เปนการเก็บขอมูลไปยังหนวยความจําแบบ SD หรือ CF เพื่อนําไปโหลดเขาระบบโทรศัพท
ดวยโปรแกรม P906  

 ช่ือไฟลที่ไดจาก SD/CF จะเปน .dat 
วิธีเอ็กพอรตไป SD/CF 
การเอ็กพอรตขอมูลไป Card  SD / CF เพื่อนําเขาระบบโทรศัพทนั้นตางจากการ Up Load คือ

ทานสามารถโปรแกรมขอมูลโปรแกรมที่ตองการตรงตามความใชงานของทานจากโปรแกรม Config 
Builder  หรือ ทาน Copy ไฟลขอมูลที่ทานตองการจากระบบโทรศัพทอ่ืนก็ได ทีเ่ปนไฟล .dat       
Copy หรือ Save ขอมูลที่ตองการลง Card ผานทาง Card Reader  จากนัน้ ถอด Card ออก     เสียบเขาที่
แผง DX-LPU.V3 หรือ JSD-CPU.V3 หรือ JSD-CPU.V5 แลวทําโปรแกรม P906 

เพียงเทานี้ทานก็จะไดระบบโทรศัพทที่มโีปรแกรมตามที่ทานไดตั้งคาไว 
 

การอิมพอรตไฟลจาก SD/CF Card   นั้นทานสามารถโหลดไดแบบทั้งหมด  All P (s) เทานั้น
ไมสามารถโหลด แบบแยก P ได 

 
 

***** ในการใชงานกับ SD/CF Memory จะตองใหตรงกับเวอรชั่นระบบโทรศัพทดวย 
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6. Generate CSV file for Extention  สรางไฟล .CSV สําหรับเบอรภายใน  
           ความสามารถของฟเจอรนี้ คือ โปรแกรม ConfigBuilder จะสรางไฟลนามสกุล .csv จากขอมลู
หมายเลข  Extension และ CO. ได เพื่ออํานวยความสะดวกใหแกผูใชในการทําตารางเขาสาย MDF ทั้ง
โหมด OnLine และ OffLine 
 

 
 
( *** CSV  หรือ Comma Separate Value คือไฟลขอมูลที่ใชเครื่องหมายคอมมา (',') เปนตัวแบงแยก
ขอมูลในแตละฟลด ซ่ึงไฟลขอมูลชนิดนี้สามารถนํามาเปดดวยโปรแกรม Speedsheet เชน Microsoft 
Excel หรือ OpenOffice Calc ได ) 

วิธีการสรางไฟล csv สําหรับหมายเลข Extension 
1) กรณี On Line ใหอานขอมูลของ P001และ P092  เขามาที่โปรแกรมกอน 
2) คลิกที่เมนู File -> Generate CSV file for Extension 
3) หนาจอจะแสดงหมายเลขภายในตั้งแตชองที่  1 ถึง 256 โดยแสดงเปนแถว ๆ ละ 10 

หมายเลข 
4) กาํหนดชวงของหมายเลขภายในที่ตองการ ในชอง Start Position และ End Position 
5) กําหนดจํานวนหมายเลขภายในตอหนึ่งแถว  โดยเลือกจาก Item / Row มีคา 8, 10, 16 และ 

25 (คาปริยาย คือ 10) 
6) กําหนดวาตองการแสดงชือ่ของหมายเลขภายใน (P092) หรือไม โดยคลิกที่เช็คบอกซ 

"Print Ext./CO. Name"  (คาปริยายคือ แสดง แตหากคาใน P092 เปนคาวาง ก็จะไมมช่ืีอปรากฎ) 
7) กําหนดวาตองการแสดงหมายเลขลําดับที่หรือไม (คาปริยายคือ ไมแสดง) 
8) เมื่อไดหนาจอดังที่ตองการแลว ก็คลิกทีปุ่ม "Save CSV" จะปรากฎหนาตางใหกําหนดชื่อ

ไฟล 
9) ใหกําหนดชื่อไฟลดังที่ตองการแลวกดปุม "OK"  โปรแกรม ConfigBuilder จะสรางไฟล 

csv ตามชื่อที่กาํหนด 
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การใชงานปุม Original 
    เมื่อผูใชทําการจัดหมายเลขภายในบนหนาจอแลวมคีวามผิดพลาด ตองการเริ่มตนทําใหม 

ใหกดปุม "Original" ซ่ึงโปรแกรมจะกลับสูสถานะเหมือนตอนแรกเขามา เชนสําหรับ "Generate CSV 
file for Extension" ก็จะอานคา P001 และ P092 แลวกําหนดคา Start Position เปน 1 และ End 
Position เปน 256 เปนตน 

การใชงานปุม  Blank 
     ปุม Blank นั้นมีไวเพื่อ "ลบ" หมายเลขที่แสดงบนเซลล  โดยกอนที่จะกดปุม Blank นั้น 

ตองเลือกกอนวาจะ "ลบ" ชองใดบาง วิธีการเลือกคลิกเมาสซายที่ชองแรกที่ตองการ คางไวแลวลาก
เมาสไปยังชองสุดทายที่ตองการ จากนัน้ปลอยปุม ชองที่เลือกจะถูกมารค จากนั้นจึงกดปุม Blank  เพื่อ
ลบหมายเลขภายในชอง 

การใชปุม Delete Blank 
    ปุมนี้ใชเพื่อเล่ือนหมายเลขขางเคียงของชองที่วางมาแทนที่ชองที่วางอยูโดยอัตโนมัติ 
 

7. Generate CSV file for CO.  สรางไฟล .CSV สําหรับเบอรภายนอก 
   การใชงานเฉกเชนเดยีวกับ Generate CSV file for Extention  ดังที่กลาวขางตน 
 
8. Exit การออกจากโปรแกรม  เมื่อส้ินสุดการทํางานและไดทําการบันทึกขอมูลเรียบรอยแลว 

 มีขั้นตอนการทํางานดังนี้  
1. คลิกที่เมนู File->Exit  หรือ คลิกปุม   

 

 
 

2. มีหนาตางถามตองการบันทกึขอมูลกอนการปดโปรแกรมหรือไม 
โดยมีตัวเลือก 
ปุม  บันทึกกอนทีจ่ะปดไฟล 
   
ปุม  ปดไฟลโดยไมตองบันทึกขอมูล 
   
ปุม  ยกเลิกการปดไฟลเพื่อทํางานตอ 
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เมนูวิว View 
การเรียก Page ของแตละพารามิเตอรเรียงตามหมายเลขโปรแกรมขึ้นมาใชงานเพื่อแสดงคา

หรือแกไขโปรแกรม สําหรับเมนูนี้เหมาะกับผูชํานาญการโปรแกรมดวยเครื่องโทรศัพทหรือเครื่องคีย  
สามารถหาตําแหนงที่ตองการแกไขไดโดยการกําหนดจากหมายเลขของโปรแกรม เชน P100 
 
1.เลือกเมนู View-> Pxxx เลือก P ที่ตองการโปรแกรม 
 

 
 
 
เมนูโอเปอเรชั่น Operation 
 เมนูนี้แบงเมนูยอยเปน Down Load กับ Up Load ซ่ึงจะทํางานทั้งสองอยางนี้ไดจะตองอยู
ทํางานอยูใน Mode Online 
 การ Down Load เปนการรับขอมูลจากระบบโทรศัพทเขามายังโปรแกรมคอนฟกบิ้วเดอร
โดยตรง  

การ Up Load คลายกับการ Down Load แตทํางานในดานตรงกันขามคือ เปนการสงขอมูล
จากโปรแกรมคอนฟกบิ้วเดอรไปยังระบบโทรศัพทโดยตรง  

นอกจากนี้ยังมีเมนูยอยเปนการตั้งวันที่เวลา, การตั้งรหัสผาน, การขอดูเวอรช่ันของระบบ
โทรศัพท, การกําหนดชื่อของระบบ PBX และการ Reset PBX 
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การใชงานเมน ูDownload 
 เมื่อผูใชคลิกที่เมนู Operation -> Download และเลือกรายการ P ที่ตองการ download 
โปรแกรมจะอานขอมูลจากระบบโทรศัพทตามเงื่อนไขที่ผูใชเลือก ไดแก 
 

 
 

 - All P(s)  อานขอมูลทุกรายการ P001-P499 (ถามี) 
 - P0XX อานขอมูลรายการ P ที่ขึ้นตนดวยหมายเลข 0 คือ P001 - P099 (ถามี) 
 - P1XX อานขอมูลรายการ P ที่ขึ้นตนดวยหมายเลข 1 คือ P100 - P199 (ถามี) 
 - P2XX อานขอมูลรายการ P ที่ขึ้นตนดวยหมายเลข 2 คือ P200 - P299 (ถามี) 
 - P3XX อานขอมูลรายการ P ที่ขึ้นตนดวยหมายเลข 3 คือ P300 - P399 (ถามี) 
 - P4XX อานขอมูลรายการ P ที่ขึ้นตนดวยหมายเลข 4 คอื P400 - P499 (ถามี) 

 

 
 

ภาพหนาจอเมือ่ระบบกําลังงาน 
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จอแสดงรายการ P ที่โปรแกรมอานขอมูลจากระบบโทรศัพทและผลการทํางาน (OK หรือ Fail) 
การใชงานเมน ูUpload 

 เมื่อผูใชคลิกที่เมนู Operation -> Upload และเลือกรายการ P ที่ตองการ Upload โปรแกรมจะ
เขียนขอมูลไปยังระบบโทรศัพทตามเงื่อนไขที่ผูใชเลือก ไดแก 
 

 
 

 - All P(s)  เขียนขอมูลทุกรายการ P001-P499 (ถามี) 
 - P0XX เขียนขอมูลรายการ P ที่ขึ้นตนดวยหมายเลข 0 คือ P001 - P099 (ถามี) 
 - P1XX เขียนขอมูลรายการ P ที่ขึ้นตนดวยหมายเลข 1 คือ P100 - P199 (ถามี) 
 - P2XX เขียนขอมูลรายการ P ที่ขึ้นตนดวยหมายเลข 2 คือ P200 - P299 (ถามี) 
 - P3XX เขียนขอมูลรายการ P ที่ขึ้นตนดวยหมายเลข 3 คือ P300 - P399 (ถามี) 
 - P4XX เขียนขอมูลรายการ P ที่ขึ้นตนดวยหมายเลข 4 คือ P400 - P499 (ถามี) 

 
 
 
 
 
 
 
 
 
 
 
 

ภาพหนาจอเมือ่ระบบกําลังทํางาน 
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จอแสดงรายการ P ที่โปรแกรมเขียนขอมูลเขาระบบโทรศัพทและผลการทํางาน (OK หรือ Fail) 

*** หมายเหต ุ เมนู Download/Upload Operation จะสามารถทําไดก็ตอเมื่อโปรแกรมอยูในโหมด 
Online Manual RW และ Online Auto Read เทานั้น หากผูใชทําฟงกช่ันนี้ในโหมด OffLine 
โปรแกรมจะแสดงหนาตางเตือน ดังภาพ 
 

                                          
 

*** การดาวนโหลดหรืออัพโหลด จะไมทําโปรแกรมที่ P000 การตั้งคาวันที่เวลา และ P015 การตั้ง
รหัสผานของระบบ 

 
การเปล่ียนรหสัผาน Change Password  ทําไดขณะออนไลนโดยไปที่ 

 เลือกเมนู Operation-> Chang Password แสดงหนาตางดงัรูป 
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System Password   รหัสผานของระบบ คาที่กําหนดจากโรงงาน คือ 1234 
Confirm System Password ยืนยนัรหัสผานของระบบอีกครั้ง 
Admin Password  รหัสของผูดูแลระบบ  
Confirm Admin Password  ยืนยนัรหัสของผูดูแลระบบ 

หนาจอจะขอยนืยันการตองการแกไขรหัสผาน 

       
คลิก OK เพื่อยืนยนั 
นอกจากนี้ทานสามารถเปลี่ยนรหัสผานไดจากเครื่อง โทรศัพทคีย ไดเชนกันโดย 

 หนาจอแสดงผล ความหมาย 
ยกหู กด * 0 1 2 3 # Password เขาโปรแกรม 
กด 1 2 3 4 # System Program ใสรหัสผาน  

(Password เดิมจากโรงงาน 1234) 
กด * 0 1 5 # P015_1 เขาโปรแกรมการ ขอP015 
กด 1 #  P015_1_XXXX XXXX จะแสดงรหัสผานที่ใชงานปจจุบนั 
กด ABCDEFGH  P015_1_ABCDEFGH หากตองการตัง้ Password ใหม  

กด ABCDEFGH ได 8 หลัก ทับคาเดิม 
กด # P015_2 กด # ยืนยันการเปลี่ยนคา  

แลวจะเขาสูการปอนขอมูลถัดไป 
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 การตั้งคา วัน วันท่ีของระบบ Date & Time Setting 
ทานสามารถตั้งคา วัน เดือน ป และเวลาของระบบโทรศัพทไดโดยไปที่เมน ู
Operation -> Date & Time PBX 
 

 
1. คลิกเลือกปุม Date แสดงวันที่/เดือน/ป  คาที่กําหนดมาจากระบบโทรศัพท  
 

2. กําหนดวัน เดือน ป วนัของสัปดาห   
     ที่ตองการหรือแกไข   

3. คลิกปุม Set  เพื่อยืนยันคําสั่ง กําหนด ว/ด/ป  

3. แสดงขอมูลที่ไดกําหนด   

6. คลิกปุม Set  เพื่อยืนยันคําสั่ง   

4. แสดงเวลา ณ ปจจุบนั 
    ของระบบโทรศัพท  

 5. กําหนดวัน เดือน ป วนัของสัปดาห   
     ที่ตองการหรือแกไข   
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การตั้งคา ชื่อของระบบ เพื่อแสดง ท่ี Toolbar    
1. เลือกเมนู Operation->System name  

  

 
 

2. แสดง Page ดงัรูป (P049) 
 

 
 
 
 
 
 

คา Default ....PHONIK PBX   
3. หนาตาง Popup เพื่อแสดงใหเปลี่ยนแปลงคา 

 
 
 
 
 

 
   
 
 

 

 

กําหนดชื่อของระบบ จากนัน้คลิกปุม Write  

คลิกปุม Yes เพื่อยืนยันการกําหนดคา 

Note…System Name การกําหนดคาของระบบจะแสดงชื่อของระบบชื่อใหมเมื่อมีการเปลี่ยน
โหมดการทํางานของโปรแกรมเปนออนไลน 
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การตรวจสอบ Version  
1.   เลือกเมนู Operation->Get version   
 

  

 
 
 

2. แสดง หนาตาง ดังรูป 
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การ Reset PBX  
เมนู  Reset PBX สามารถรีเซทตู ที่กําลังออนไลนได  เมื่อมีการแกไขโปรแกรม หรือตองการ

ปดแลวเปดตูใหม สามารถสั่งงานไดจากโปรแกรม Config Builder   มีประโยชนสําหรับผูดูแลระบบ
ไมตองกดปุม Reset หนาตู  

 
1. เลือกเมนู Operation->Reset PBX   
 

 
 
 
 
2. แสดงหนาตาง เพื่อยืนยันการ Reset PBX  
 
 
 
 
 
 
 
 
 
 

Note…การ Reset PBX สามารถใชงานผานการเชื่อมตอทั้งแบบ LAN และ  Serial 
เมื่อทําการ Reset PBX  การทํางานของโปรแกรม Config Builder จะเปลี่ยนเปนโหมด Offline  
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เมนูโหมด Mode 
Phonik Config Builder ไดถูกออกแบบมาใหผูใชสามารถสรางและแกไขขอมูลระบบ

โทรศัพท Phonik ไดอยางอิสระ ยืดหยุนในแตละสภาวะแวดลอม ดังนั้นโปรแกรมจึงมีโหมดการ
ทํางานสําหรับใหผูใชเลือกตามความเหมาะสม 4 สถานะ คือ  

• Mode Offline การทํางานไมเชื่อมกับระบบโทรศัพท 

• Mode Online Manual Read Write เชื่อมกับระบบโทรศัพท แตจะอาน-เขียน เมื่อส่ัง 

• Mode Online Auto Read เชือ่มกับระบบโทรศัพท จะอานอัตโนมัต ิ

• Mode Read Only เชื่อมกับระบบโทรศัพท สําหรับอานคาจากตูสาขาโทรศัพทเทานัน้ 
 
โหมด Off Line 

 โหมด Off Line เปนโหมดที่ไมมีการเชื่อมตอกับระบบโทรศัพท ดังนั้นหากผูใชเลือกโหมดนี้
จะไมสามารถอานหรือแกไขขอมูลภายในระบบโทรศัพทได แตจะเหมาะสําหรับผูใชที่ตองการสราง
คอนฟกขึ้นมาใหม หรือโหลดขอมูลจากไฟลคอนฟกมาทําการแกไขแลว save กลับเปนไฟลสงใหกับ
ลูกคา การใชงานโหมดนี้จึงไมจําเปนตองมีระบบโทรศัพท โดยโปรแกรมจะเขาโหมดนี้โดยเมื่อเปด
โปรแกรมขึ้นมา 
 

 
 
 

 
โหมด Online Manual RW (Read/Write) 

 โหมด Online Manual RW เปนโหมดที่มีการเชื่อมตอกับระบบโทรศัพท ผานชองทางที่
โปรแกรมสนับสนุน (ไดแก Serial Port, Modem และ LAN) ในโหมดนี้ผูใชสามารถอาน เขียนขอมูล
ของระบบโทรศัพทไดก็ตอเมื่อผูใชเปนผูส่ังเอง (Manual) โดยอาศัยปุม Read และ Write บน Toolbar 

 

 
 

*** หากทานอยูในโหมด Online จะมีชองสี่เหล่ียมสีแดง แสดงสถานะ Online อยู 
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โหมด Online Auto Read 
 โหมด Online Auto Read เปนโหมดที่มีการเชื่อมตอกับระบบโทรศัพท เชนเดียวกันกับโหมด 
Online Manual Read Write แตตางกันที่โหมด Auto Read นี้จะทําการอานคาจากระบบโทรศัพท 
(PBX data) ใหอัตโนมัติเมื่อผูใชเลือก Page ซ่ึงในแตละ Page จะระบุวาตองอานขอมูลของ P ใดบาง 
ดังนั้นผูใชโหมดนี้จะเห็นขอมูลที่แสดงบนหนาจอโปรแกรมตรงกับขอมูลของระบบโทรศัพ (PBX 
Data) เสมอ นอกจากนั้น หากผูใชมีการแกไขขอมูลใดๆ ในหนา Page เมื่อปดหรือออกจาก Page นี้ 
โปรแกรมจะถามวาตองการเขียนขอมูลที่เปลี่ยนแปลงเขาระบบโทรศัพทหรือไม ซ่ึงผูใชสามารถเลือก
ได  
 

 
 
*** หมายเหต ุ ในคูมือหากมีการอางถึงโหมด Online ใหหมายถึงทั้งโหมด Online Manual RW 
และ Online Auto Read นอกจากระบุเปนอยางใดอยางหนึ่ง 
 
 

โหมด Online Read Only 
โหมด Online Read Only เปนโหมดที่มีการเชื่อมตอกับระบบโทรศัพท เชนเดยีวกับโหมด 

Online Manual RW  และ Online Auto Read แตตางกันที่โหมด Online Read Only จะทําการอานคา
ไดอยางเดียวจากระบบโทรศัพท       

 

 
 

 
 
 
 
 
 
 
 
 
 

Note…. การใชงานของโหมด  Online Read Only สามารถใชงานดูขอมูลในขณะทีม่ีการ
ใชงานการโปรแกรมตู  และสามารถเขาใชงานไดหลายเครื่องพรอมกัน  
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การเปล่ียนโหมดการทํางานของโปรแกรม 
 คาโดยปริยายเมื่อเปดโปรแกรม Phonik Config Builder ขึ้นมาจะอยูในโหมด Off Line ผูใช 
สามารถเปลี่ยนโหมดได 2 วิธีคือ 
1) ใชรายการเมนู Mode แลวคลิกเลือกโหมดที่ตองการ 
2) คลิกที่ Mode combo บน Toolbar แลวเลือกโหมดที่ตองการ 
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ในการเปลี่ยนโหมดจาก Off Line มาเปน On Line นั้น ผูใชจะตองทราบรหัสผานของระบบโทรศัพท
ที่เชื่อมตอ โดยโปรแกรมจะแสดงหนาตางใหใสรหัสผาน ดังรูป 
 

 
   
 หากรหัสผานถูกตองโหมดจึงเปลี่ยน กรณีที่รหัสผานไมถูกตองจะปรากฎหนาตาง ดังรูป 
 

 
   

Automatic Disconnect Detection 
ในขณะที่ใชงานอยูในโหมด Online โปรแกรมจะมีระบบตรวจสอบชองทางเชื่อมตอวาปกติ

หรือไม หากพบวามีความขัดของ เชน สายหลุด โปรแกรมจะสลับกับมาที่โหมด Off Line โดย
อัตโนมัติ ซ่ึงผูใชสามารถสังเกตไดจาก Mode Toolbar และเพื่อจะไดดําเนินการแกไขให Online 
ตอไป 

 
 ในการเปลี่ยนโหมดจาก Online มาเปน Offline ผูใชงานจะตองทําการยืนยนัอีกครัง้วาตอง- 
การ เปลี่ยนโหมดหรือไม ดังรูป 
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เมนู Setting 
 เมนูนี้จะเปนการตั้งคาของ 

• Connection 

• Color of States 

• Power Customize 

• Modem Parameters 

• SMDR Data 

• Debug On 

• Debug Off 
 

Connection ชองทางการเชื่อมตอกับระบบโทรศัพท 
  การเชื่อม Config Builder กับตูสาขาฯ แบบอัตโนมัต ิ ลักษณะการทํางานคือ เมื่อเปด
โปรแกรม Cinfig Builder ขึ้นมา จะเชื่อมตอกับตูสาขาฯ Auto ทันที (จะเชื่อมตออยูใน Mode Read 
Only ซ่ึงหมายความวาดไูดอยางเดยีว) และสามารถกําหนดไดวา เมื่อเชือ่มตอแลวให Show หนาไหน
เปนหนาแรก 

ในการเชื่อมตอคอมพิวเตอรกับระบบโทรศัพททั้งสองฝงจะตองใชชองสัญญาณ
ส่ือสารใหตรงกันจึงจะสื่อสารกันได  

ในดานระบบโทรศัพทมีชองสญัญาณสื่อสารดังนี้ 
 ชองสัญญาณสื่อสารชองที่ 1 เปนชองสัญญาณ RS-232 
 ชองสัญญาณสื่อสารชองที่ 2 เปนชองสัญญาณ RS-232 
 ชองสัญญาณสื่อสารชองที่ 3 เปนชองสัญญาณUSB Port 
 ชองสัญญาณสื่อสารชองที่ 4 เปนชองสัญญาณLAN Port 

ดานคอมพิวเตอรที่ใชโปรแกรม  Config Builder เชื่อมตอเขากับระบบโทรศัพท ได 
3 ชองทางดังนี้คือ  

ทางชองสื่อสารอนุกรม RS-232 Serial Port 
ทางชองสัญญาณ USB Port 
ทางชองสัญญาณ LAN Port 
โดยการไปที่  
Setting -> Connection  แลวเลือก การเชื่อมตอที่ทานตองการ 

   - คลิกเลือก Auto Connect หากตองการ เมื่อเปด Config builder ขึ้นมาแลว ใชเชื่อมตอกับตูสาขาฯ  
 โดยอัตโนมัต ิ
  -  เลือกหนาที่จะใหแสดงเปนหนาแรก เมื่อเชื่อมตอแลว มใีหเลือกดังนี ้
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  Blank -> แสดงเปนหนาวางๆ 
  P001 -> แสดงไปหนาของ P001 
  Monitor All -> แสดงไปหนาแรกของ System Monitor 
  Monitor Custom1-> แสดงไปหนา Monitor Custom1 
  Monitor Custom2-> แสดงไปหนา Monitor Custom2 
  Monitor Custom3-> แสดงไปหนา Monitor Custom3 
  Monitor Custom4-> แสดงไปหนา Monitor Custom4 
              

 
 
Serial Port   
สําหรับการใชสาย Serial port นั้น จะตองกาํหนด COM Port ของเครื่องตนเอง และ

กําหนดโปรโตคอลสื่อสารใหตรงกับฝงตรงขามสําหรับในที่นี้กําหนดตามในภาพ 
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LAN Port 
เมื่อระบบโทรศัพท และเครื่องคอมพิวเตรอยูในวงเครือขายคอมพิวเตอรเดียวกัน ให

ตั้งคา IP Address ของระบบโทรศัพทที่ตองการติดตอกัน 

 
 
Modem Port  

  เมื่อส่ือสารผาน Serial Port สามารถติดตอผานโมเด็มได 

 
Color of States 
เปนการกําหนดสีใหแตละสถานะของการใชโทรศัพทได (การกําหนด Color of Status ได

จะตองอยูในโหมด Offline เทานั้น 
 

 
 



 

 

B - 37 

 

Power Cutomize 
เปนการแสดงสถานะ (ระยะเวลาการใชงาน Power , สถานะของ Power เชน ปดการใชงาน ,

เปดใชงานแบบจํากัดเวลา , เปดใชงานแบบไมจํากัดเวลา 
 Modem Parameters 
 เปนการกําหนดคาใหกบัโมเด็มที่จะตดิตั้งดานระบบโทรศัพท โดยจะตองนําโมเดม็นั้นมาตั้ง
คาใหตรงกับดานของคอมพิวเตอรกอนจึงจะใชงานได 
 SMDR Data 
 เปนการใช System Monitor เพื่อดูขอมูลของ SMDR แตมขีอควรระวังคอื หากใช System 
Monitor ดู SMDR ตูที่ 1 แลว และนําไปดูตูที่ 2 ระบบจะทําการลบขอมูลของ SMDR ตูที่ 1 ออก
ทั้งหมด (เพื่อปองกันการนํา SMDR ของตูที่ 1 และ 2 มารวมกัน) 
 Debug On/Off 
 เปนการเปดชองทางใหผูเขียนโปรแกรมสามารถเขาตรวจสอบความผิดพลาดจากการทํางาน
ของโปรแกรมได โดยทัว่ไปในการใชงานจะออฟไว 
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เมนู Tools 
 เปนเมนูสําหรับเปนเครื่องมือวิเคราะหการทํางาน หรือชวยงาน แบงปนเมนูยอย ดังนี้  

• Analysis Current Config 

• Log File 

• Statistics 

• Console 
 

ตรวจสอบรายการ P ดวย Analysis Current Config 
 ขณะที่โปรแกรม Phonik Config Build ทํางานอยูนั้น หากผูใชตองการทราบวาใน Global 
Data หรือคอนฟกปจจุบันนั้นมีรายการ P ใดอยูบาง ใหผูใชคลิกที่เมนู 

Tools -> Analysis Current Config 
 จะไดหนาจอลักษณะดังภาพ 
 

  
 

โดยจะมีเฉพาะรายการ P ที่อยูในสถานะ Active เทานั้น 
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 Log File 
 สําหรับเก็บขอมูลดิบการสื่อสารระหวางคอมพิวเตอรกับระบบโทรศัพท 

Tools -> Log File 
 จะไดหนาจอดงัภาพ 

          

 
  
 Statistics 
 สําหรับเก็บสถิติการใชงานตดิตอส่ือสารระหวางคอมพวิเตอรกับระบบโทรศัพท 

Tools -> Statistics 
 จะไดหนาจอดงัภาพ 
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Console 
 สําหรับการปอนคําสั่งจากแปนคียบอรดเพื่อติดตอกับระบบโทรศัพท การทํางานจะใชการ
ปอนคําสั่งโดยอาศัยโปรโตคอลสื่อสารจากระบบโทรศัพท ดังนั้น เมนูนี้จะใชไดเมื่อการทํางานของ
โปรแกรมอยูในโหมดออนไลน 
 การเรียกใชงาน  Tools -> Console 
 จะไดหนาจอดงัภาพเมื่ออยูในโหมดออนไลน 
 

 
 

ขอมูลสงมาจากระบบโทรศัพท 

พื้นที่แสดงผล พื้นที่ปอนคําสั่ง 
   Clear ลบพื้นที่แสดงผล 
   Send สงคําสั่งที่ปอน 
   Save บันทึกขอมูลในพื้นทีแ่สดงผล  

พื้นที่แสดงคาการสื่อสาร
กับระบบโทรศัพท 
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เมนู Help 
สําหรับดูขอมูลเกี่ยวกับ โปรแกรม  Config Builder และ Firmware ที่รองรับการใชงาน  แบงเปนเมนู 
ยอย ดังนี ้
        Help -> About            
         

                       
 
 
  
        Help -> Version 
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บทที่ 2 
 

โปรแกรมทั่วไป P0XX General Programming 
  
 การโปรแกรมเกี่ยวกับสวนหลักของระบบ 
 ในหัวขอนี้จะเปนการโปรแกรมกําหนดคาตางๆ ที่เปนเรื่องสวนหลักทั่วๆ ไปของระบบ  ซ่ึง
ถือเปนสวนที่สําคัญที่สุดสวนหนึ่งในการที่จะทําใหระบบทํางานไดอยางมีประสิทธิภาพและ
กอใหเกิดประสิทธิผลใหกับผูใชงานไดมากที่สุด 
 เนื่องจากการโปรแกรมในกลุมนี้มีคาที่ตองตั้งใหกับผูใชงานจํานวนมาก  และคาการ
โปรแกรมมีบางโปรแกรมเกี่ยวโยงถึงกัน บางโปรแกรมเปนอิสระจากเรื่องอื่น ดังนั้นจึงไดจัดแบงเปน
เพจเพื่อใหงายตอการโปรแกรม ดังนี้ 

1. System numbering 
2. Call Restriction Code 
3. Holiday, Day/Night Service 
4. Call Pick Up 
5. Music, Page, Short Key 
6. Console, Key, DSS. 
7. Memory Number 
8. Department 
9. OGM., Message, Logger 
10. Link Number 
11. SMDR. 
12. Group Event 
13. Printing 
14. IP Networking 
15. SIP Extension 
16. Account Code 
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1. โปรแกรม P0XX System Numbering 
คลิกเลือก P0XX General Programming -> Extension & Hunting จะแสดง Page ดงัรูป  
 
 

 
 
 
 
 

 
 
 

รูปแสดงการทาํงานของระบบเมื่อไดรับคําสั่งจากแปนโทรศัพทของผูใชงาน 
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P001  กําหนดหมายเลขของระบบ (Numbering Assignment)   
การกําหนดหมายเลขการทํางานของระบบทั้งหมดสามารถกําหนดไวในโปรแกรมขอนี้   
พอรตที่ 001 – พอรตที่ 512 เปนพอรตกําหนดหมายเลขเครื่องโทรศัพทภายใน จะเปนตัวเลข

กี่หลักก็ไดแตสามารถมีไดสูงสุด 8 หลัก โดยสวนใหญแลวนิยมกําหนดหมายเลขเปนตัวเลข 4 หลัก 
แตทั้งนี้ขึ้นอยูกับความตองการและความเหมาะสมของผูใชในแตละรายที่จะใหงายแกการจดจําหรือ
สะดวกในการใชงาน  

การนับพอรตของเครื่องโทรศัพทภายในจะขึ้นอยูกับตําแหนงของแผงสายในที่เสียบในแตละ
ชองเสียบแผงวงจร (SLOT) จะเห็นวาแตละชองเสียบมี 16 พอรต หากเสียบแผงวงจรที่มีสายในเพียง 8 
พอรต เชน แผง JSD-8SLT, JSD-4ATI, JSD-8ATI, DX-8SLT, DX-4ATI, DX-8ATI จะทําใหพอรต
สายในที่เหลือไมถูกใช ในการนับพอรตสายในใหนับขามไป 

สามารถยกหูโทรศัพทเพื่อถามพอรตสายในของเครื่องนั้นไดดวยการกด *545# 
 

ชองเสียบ 
แผงวงจร 

การนับพอรตสายในของตู 

JSD-64 JSD-128 Diamond Platinum (256P) Platinum (512P) 

ชองที่ 1 พอรตที่ 1-16 พอรตที่ 1-16 พอรตที่ 1-16 พอรตที่ 1-16 พอรตที่ 257-272 

ชองที่ 2 พอรตที่ 17-32 พอรตที่ 17-32 พอรตที่ 17-32 พอรตที่ 17-32 พอรตที่ 273-288 

ชองที่ 3 พอรตที่ 33-48 พอรตที่ 33-48 พอรตที่ 33-48 พอรตที่ 33-48 พอรตที่ 289-304 

ชองที่ 4 พอรตที่ 49-64 พอรตที่ 49-64 พอรตที่ 49-64 พอรตที่ 49-64 พอรตที่ 305-320 

ชองที่ 5 พอรตที่ 65-80 พอรตที่ 65-80 พอรตที่ 65-80 พอรตที่ 65-80 พอรตที่ 321-336 

ชองที่ 6 - พอรตที่ 81-96 พอรตที่ 81-96 พอรตที่ 81-96 พอรตที่ 337-352 

ชองที่ 7 - พอรตที่ 87-112 พอรตที่ 87-112 พอรตที่ 87-112 พอรตที่ 353-368 

ชองที่ 8 - พอรตที่ 113-128 พอรตที่ 113-128 พอรตที่ 113-128 พอรตที่ 369-384 

ชองที่ 9 - พอรตที่ 128-144 พอรตที่ 128-144 พอรตที่ 128-144 พอรตที่ 385-400 

ชองที่ 10 - - พอรตที่ 145-160 พอรตที่ 145-160 พอรตที่ 401-416 

ชองที่ 11 - - พอรตที่ 161-176 พอรตที่ 161-176 พอรตที่ 417-432 

ชองที่ 12 - - พอรตที่ 177-192 พอรตที่ 177-192 พอรตที่ 433-448 

ชองที่ 13 - - พอรตที่ 193-208 พอรตที่ 193-208 พอรตที่ 449-464 

ชองที่ 14 - - พอรตที่ 209-224 พอรตที่ 209-224 พอรตที่ 465-480 

ชองที่ 15 - - พอรตที่ 225-240 พอรตที่ 225-240 พอรตที่ 481-496 

ชองที่ 16 - - พอรตที่ 241-256 พอรตที่ 241-256 พอรตที่ 497-512 
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พอรตที่ 801– 900 (Function port) เปนพอรตที่ใชกําหนดหมายเลขการใชงานรหัสคําสั่งที่ 1 – 
100 (Function Number) ทําใหสามารถเปลี่ยนคําสั่งการใชงานได 

พอรตที่ 901 - 940 (Hunting Port) เปนพอรตที่ใชกําหนดหมายเลขนําหมู (Hunting Number) 
ซ่ึงสามารถแบงกลุมไดสูงสุดถึง 40 กลุมแตละกลุมมีสมาชิกเครื่องภายใน 10 หมายเลข หากมีความ
ตองการใชกลุมละมากกวา 10 เครื่องจํานวนกลุมที่จะใชงานไดก็จะนอยลง 

เมื่อกําหนดหมายเลขของกลุมนําหมูแลวตองไปทําโปรแกรมที่ P012/P013 เพื่อกําหนด
สมาชิกของกลุมและลักษณะการทํางานของกลุมนั้นดวย 

พอรตที่ 941 – 948 (Operator Port) จะเปนพอรตที่มีไวสําหรับกําหนดหมายเลขการใชงาน
โอเปอเรเตอร (Operator Number) กําหนดไดสูงสุดถึง 8 หมายเลข เปนตน หมายเลขที่ถูกใชเปน
โอเปอเรเตอรนั้นจะสามารถใชงานแตกตางไดระหวางกลางวันกับกลางคืน และสามารถใชงานเรียก
เครื่องปลายทางใหแตกตางระหวางแผนกทั้งการถูกเรียกจากสายในหรือการถูกเรียกจากสายนอก 

เมื่อกําหนดหมายเลขโอเปอเรเตอรแลวใหไปทําโปรแกรม P002/P003 ดวย 

 รูปแสดงการทาํงานของหมายเลขโอเปอเรเตอร 
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P091  กําหนดกลุมสายภายใน (Extension Group Assignment) 
 การกําหนดกลุมการใชงานของหมายเลขภายใน โดยจะแบงออกเปน 32 กลุม (สามารถ
กําหนดตัวเลขตั้งแต 1 – 32 เทานั้น) ซ่ึงลักษณะการทํางานของแตละกลุมนั้นสามารถอางอิงไดจาก
หัวขอ Group Name หรือ P250 โดยในระบบที่ถูกกําหนดมาจากโรงงานจะเปนหมายเลขกลุมที่ 32 
(System) แตทั้งนี้ผูใชสามารถเปลี่ยนแปลงกลุมเพื่อความเหมาะสมในการใชงานไดในโปรแกรมนี้ 
 
P092  ชื่อของเครื่องโทรศัพทภายใน (Extension Name) 
 การกําหนดชื่อใหกับหมายเลขภายใน เพื่อความสะดวกในการจดจํา เชน กําหนดชื่อใหกับ
เครื่องหมายเลข 1001 เปนชื่อ “ Phonik ” และ เครื่องหมายเลข 1002 เปนชื่อ “โฟนนิค ”  เมื่อมีการ
โทรหากันขึ้นเครื่องที่เปนผูโทร (Caller)  จะแสดงชื่อของเครื่องที่กําลังโทรไปหา  สวนเครื่องที่เปนผู
ที่ถูกโทรหา (Called)  ก็จะแสดงชื่อของผูที่กําลังโทรเขามา ทําใหทราบวามีใครกําลังโทรเขามาหา  แต
ถาไมมีการกําหนดชื่อใหกับเครื่องภายใน ระบบจะแสดงเปนชื่อของกลุมสายในแทน เชน คาจาก
โรงงานนั้นหมายเลขภายในถูกกําหนดใหเปนกลุมที่ 32 ดังนั้นเมื่อมีการโทรหากัน ที่หนาจอเครื่องคีย
จะแสดงคําวา System  ซึ่งเปนชื่อของกลุมสายในที่ 32 เปนตน 
    
 

 
 
 
 
 
 
 
 
 
 
 การคลิ้กที่หัวตารางของ Port จะจดัเรียงหมายเลขตามลําดับพอรต ซ่ึงเปนคามาตรฐาน 

การคลิ้กที่หัวตารางของ P001 จะสามารถจัดเรียงขอมูลเรียงตามหมายเลขใหใหม 
 การคลิ้กที่หัวตารางของ P091 จะสามารถจัดเรียงใหมตามลําดับหมายเลขกลุม 
 การคลิ้กที่หัวตารางของ P092 จะสามารถจัดเรียงตามลําดับชื่อ 
 การดับเบิ้ลคล๊ิกที่หัวตารางของ P จะมีหนาตาง Array เพื่อยืนยันที่ตองการใชคาที่กําหนดจาก
โรงงาน (Default) 

ลําดับ 

คลิกเพื่อเรียก เรียงตามลําดับหมายเลข, กลุม, ช่ือ 

หมายเลขกลุมสายใน  

หมายเลขที่ตองการ 

ช่ือของสายใน 
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P002  การใชงานเปนโอเปอเรเตอร (กลางวัน) (Operator Assignment (Day)) 
P003  การใชงานเปนโอเปอเรเตอร (กลางคนื) (Operator Assignment (Night)) 

การเติมหมายเลขเครื่องโทรศัพท หรือ หมายเลขเรียกนําหมูมาเติมในชอง P002/P003 ซ่ึง
หมายเลขนี้จะทําหนาที่เปนโอเปอเรเตอร 

หมายเลขโอเปอเรเตอรจาก P001_[941-948]_ นั้นจะมีคุณสมบัติพิเศษคอื  
สามารถกดหมายเลขเดียวกันแตสัญญาณกระดิ่งไปดังที่เครื่องโทรศัพทปลายทางที่แตกตาง

กันระหวางกลางวันกับกลางคืน ใชไดทั้งการเรียกจากสายภายใน หรือสายนอก 
สามารถกดหมายเลขเดียวกันแตสัญญาณกระดิ่งไปดังที่เครื่องโทรศัพทปลายทางที่แตกตาง

กันระหวางแตละแผนก ซ่ึงกําหนดที่ P028 และ P029 ดังนั้น สามารถใชไดทั้งการเรียกจากสายภายใน 
หรือสายนอก 

 

 
หมายเลขที่ตองการใช เพื่อเปนโอเปอเรเตอรนั้น จะตองไปกําหนดใน P001 ในพอรตที่ 941–

948 ซ่ึงจะเปนตัวเลขใดก็ไดขึ้นอยูกับความสะดวกในการใชงานของผูใช โดยจะเรียงลําดับตามพอรต
ที่ 941 – 948 นั่นหมายถึงเครื่องโอเปอเรเตอรเครื่องที่ 1 ถึง เครื่องที่ 8 นั่นเอง 

 
 

 
 
 
 
 
 
 

เมื่อนําหมายเลขนําหมู ไปใชเปนโอเปอเรเตอรจะมีรูปแบบการใชตามหมายเลขนําหมูนั้น  
 

หมายเลข โอเปอเรเตอร 

P003 กําหนดการใชงาน
โอเปอเรเตอรกลางคืน  

P002 กําหนดการใชงาน
โอเปอเรเตอรกลางวัน  
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P012  กําหนดวิธีการเรียกใชเลขนําหมู (Hunting Type) 
P013  กําหนดกลุมการใชงานเลขหมู (Hunting Group Assignment) 

HuntGroup นั้นจะมีตัวเลขตั้งแต 01–40 หมายถึงการแบงกลุมของ Hunting Group ที่สามารถ
แบงไดสูงสุดถึง 40 กลุม โดยแตละกลุมจะมี 10 หมายเลข ดังนั้นหมายเลขใดที่ตองการจะใหอยูใน
กลุมใดก็ใหนําหมายเลขดังกลาวนั้น มากําหนดลงไปในชองวางจากซายไปขวา หามมีชองวางในแต
ละชอง ถามีสมาชิกในกลุมไมเต็มแถว ชองที่เหลือจะไมใช   

เมื่อเรากําหนดสมาชิกในกลุม P013 เรียบรอยแลว อีกสวนหนึ่งที่สําคัญในเรื่องของการจัด
กลุม นั่นคือการกําหนดรูปแบบการดังของเสียงกระดิ่งเรียก P012 จะมีใหเลือกอยู 4 รูปแบบตาม
ลักษณะความเหมาะสมของการใชงาน  เชน 

Disable   แสดงถึงผูใชที่ไมตองการใชงานกลุม Hunting กลุมดังกลาว   
Terminate แบบมีจุดเริ่มตน  เมื่อผูใชกดหมายเลขของกลุม  โทรศัพทเครื่องแรกจะดังกอน

ทุกครั้ง  ถาเครื่องโทรศัพทเครื่องแรกไมวาง  จึงจะไปดังที่เครื่องถัดไป  แตถาเครื่องที่สองไมวางก็จะ
ไปดังที่เครื่องถัดไป  จะเปนเชนนี้ไปเรื่อยจนถึงเครื่องลําดับสุดทายของกลุม  รูปแบบนี้เหมาะสําหรับ
เรียกเปนแผนกและมีผูรับสายประจําแผนกนั้นๆ เชน แผนกขาย  แผนกบริการ  แผนกแมบาน  แผนก
ยานยนต  เปนตน 

Circulate  แบบวนรอบ  เมื่อผูใชกดหมายเลขของกลุม  ในการโทรเขาครั้งแรกจะดังที่
เครื่องที่หนึ่ง  เมื่อมีการโทรเขาครั้งตอมาจะมาดังที่เครื่องที่สอง  การโทรเขาครั้งที่สามจะมาดังที่
เครื่องที่สาม  เปนเชนนี้ไปจนครบเครื่องสุดทายที่มีอยูในกลุมแลววนกลับมาเริ่มใหมที่เครื่องที่ดังเปน
เครื่องแรกสุด  รูปแบบลักษณะนี้เหมาะสําหรับงานที่ตองแบงหนาที่การรับสายใหเทาๆ กัน 

Broadcast แบบดังพรอมกัน เมื่อผูใชกดหมายเลขของกลุม เครื่องโทรศัพทภายในกลุมจะ
ดังพรอมกันทุกเครื่อง เมื่อเครื่องใดเครื่องหนึ่งรับสาย กระดิ่งของเครื่องที่เหลือทั้งหมดจะหยุดดัง  
รูปแบบนี้เหมาะสําหรับใชเรียกจุดที่ตองการบริการลูกคาเรงดวน เชน โอเปอเรเตอร เปนตน 

 
 
 
 
 
 
 
 
 
 

  เลือกคาที่ตองการกําหนด 

เติมหมายเลขภายในที่ตองการ 
- เรียงตามลําดบัสมาชิกในกลุม หามเวนชองวาง 
- ถามีตําแหนงที่ 10 และตําแหนงที่ 1 ในกลุมถัดไป จะถอืเปนลําดับที่ 11 
- จะมีสีแสดงกลุมชวยใหเหน็ชัดเมื่อสมาชกิในกลุมมากกวา 10 เครื่อง 
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Hunting Number ในรูปแบบใหมที่เพิ่มขึ้นมา จะสามารถใชงานไดหลากหลายมากขึ้น 
- ใชงานในรูปแบบเดิม เมื่อเลือกใช Hunting Type ชนิด Terminate, Circulate หรือ Broadcast 

โดยมีเลขนําหมู Hunting Pilot Number 
- เมื่อเลือกใช Hunting Type ชนิด Terminate 2, Circulate 2 จะยังคงใชเลขนําหมู hunting 

Pilot Number ได ถามี และยังสามารถใชเครื่องโทรศัพทภายในเปนการทํา Hunting ดวย 
 
Terminate 2  แบบมีจุดเริ่มตน  เมื่อผูใชกดหมายเลขของกลุม  โทรศัพทเครื่องแรกจะดัง

กอนทุกครั้ง  ถาเครื่องโทรศัพทเครื่องแรกไมวาง  จึงจะไปดังที่เครื่องถัดไป  แตถาเครื่องที่สองไมวาง
ก็จะไปดังที่เครื่องถัดไป  จะเปนเชนนี้ไปเรื่อยจนถึงเครื่องลําดับสุดทายของกลุม  เหมือน Terminate 
แตเพิ่มการใชงานในลักษณะ Extension Number Hunting ดวย คือเมื่อกดหมายเลขภายในกลุมนั้นแลว
ไมวาง จะเรียกไปยังเครื่องลําดับตอไปในกลุม เมื่อถึงลําดับสุดทายจะไมวนมาเริ่มใหม 

เหมาะกับระบบคอลเซ็นเตอร ที่มีกําหนดผูบังคับบัญชา ซ่ึงจะเปนหมายเลขทายๆ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ringing
สถานะ การใชงาน
สมาชิกลําดับท่ี1

พรอมใชงาน

สถานะ การใชงาน
สมาชิกลําดับท่ี2

ไมพรอมใชงาน

Ringing
พรอมใชงาน

สถานะ การใชงาน
สมาชิกลําดับท่ี3

ไมพรอมใชงาน

สถานะ การใชงาน
สมาชิกลําดับสุดทาย

Ringing
พรอมใชงาน

Ringing
พรอมใชงาน

โทรเรียกเขา
สมาชิกลําดับท่ี1

โทรเรียกเขา
สมาชิกลําดับท่ี2

โทรเรียกเขา
สมาชิกลําดับท่ี3

โทรเรียกเขา
สมาชิกลําดับสุดทาย

ไมพรอมใชงาน

เรียกเบอรนําหมู

ไมพรอมใชงาน

BUSY

ผังการทํางาน ชนิด Terminate 2 
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Circulate 2 แบบวนรอบ  เมื่อผูใชกดหมายเลขของกลุม  ในการโทรเขาครั้งแรกจะดังที่
เครื่องที่หนึ่ง  เมื่อมีการโทรเขาครั้งตอมาจะมาดังที่เครื่องที่สอง  การโทรเขาครั้งที่สามจะมาดังที่
เครื่องที่สาม  เปนเชนนี้ไปจนครบเครื่องสุดทายที่มีอยูในเหมือน Circulate ปกติ แตเพิ่มการใชงานใน
ลักษณะ Extension Number Hunting ดวย คือเมื่อกดหมายเลขภายในกลุมนั้นแลวไมวาง จะเรียกไปยัง
เครื่องลําดับตอไปในกลุม เมื่อถึงลําดับสุดทายจะวนมาเริ่มใหม 

เหมาะกับระบบคอลเซ็นเตอรที่ผูรับสายจะเฉลี่ยกันรับสาย 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
ขอแตกตาง ระหวาง Circulate และ Circulate-2, Terminate และ Terminate-2  คือ  
- Circulate กับ Terminate เมื่อโทรเขาหมายเลขเครื่องโทรศัพทภายในที่ไมวางใชงาน ระบบจะไม
สามารถใหกระดิ่งไปดังในหมายเลขที่วางใน Hunting Group เดียวกันwfh 
- Circulate-2 กับ Terminate-2 เมื่อโทรเขาหมายเลขเครื่องโทรศัพทภายในที่ไมวางใชงาน ระบบจะให
กระดิ่งไปดังในหมายเลขที่วางใน Hunting Group เดียวกนัได 

Ringing
สถานะ การใชงาน
สมาชิกลําดับท่ี1

พรอมใชงาน

สถานะ การใชงาน
สมาชิกลําดับท่ี2

ไมพรอมใชงาน

Ringing
พรอมใชงาน

สถานะ การใชงาน
สมาชิกลําดับท่ี3

ไมพรอมใชงาน

สถานะ การใชงาน
สมาชิกลําดับสุดทาย

Ringing
พรอมใชงาน

Ringing
พรอมใชงาน

โทรเรียกเขา
สมาชิกลําดับท่ี1

โทรเรียกเขา
สมาชิกลําดับท่ี2

โทรเรียกเขา
สมาชิกลําดับท่ี3

โทรเรียกเขา
สมาชิกลําดับสุดทาย

ไมพรอมใชงาน

เรียกเบอรนําหมู
ครั้งท่ี1

ไมพรอมใชงาน

เรียกเบอรนําหมู
ครั้งที่2

เรียกเบอรนําหมู
ครั้งที่3

เรียกเบอรนําหมู
ครั้งสุดทาย

ผังการทํางาน ชนิด Circulate 2 
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การกําหนดกลุมสมาชิกสํารอง 
ในการใชงานคอลเซ็นเตอร ในกลุมกลุมของ Agent ที่รับสายปกติ เมือ่คูสายเต็ม จะมีความ

ตองการใหสายเรียกเขาไปยงักลุมสํารองได 
สามารถกําหนดใหมกีารใชงานเปนกลุม Hunting หลัก และกลุม Hunting สํารอง ได โดยการ

ใส *#909 เปนตัวคั้นระหวางHunting หลัก และ Hunting สํารอง โดยคณุสมบัติของ Hunting สํารองมี
ดังนี ้

- เมื่อสมาชิกกลุม Hunting หลัก คูสายไมวางทั้งหมด กลุม Hunting สํารอง จึงจะทํางาน 
- Hunting หลัก จะตองกําหนดเปนโหมด Terminate และ Circulate เทานั้นกลุม Hunting 

สํารอง จึงจะทาํงาน 
- การทํางานของ Huntingสํารอง จะทํางานในโหมด Terminate เทานั้น 
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2. โปรแกรม P0XX Call Restriction Code 
คลิกเลือก P0XX General Programming -> Restriction จะแสดง Page ดังรูป  

 
 

P006  กําหนดระดับการโทรออก (Restriction Code Setting)   
เปนการกําหนดรายละเอยีดของหมายเลขทีใ่ชโทรออก ระดับที1่-20  
ระดับการโทรออกที่ 21-31 เปนคาที่ถูกกําหนดจากโรงงาน หากมีความตองการใชล็อกการ

โทรออกที่แตกตางจากคาโรงงาน ใหกําหนดไดที่โปรแกรมนี้ เมื่อตองการนําไปใช ใหนําหมายเลข
ระดับ (Class) ไปใชที่ P116/P117, P226/P227, P236/P237 

การปอนคาใน P006 ของทั้ง 20 ระดับ (Class) จะตองปอนคาในรูปแบบหลักเกณฑที่กําหนด
เทานั้น จึงจะทํางานได  

คาที่สามารถใสไดใน คือ ตัวเลข 0-9,*,#, ตัวอักษร d , ตัวอักษร e , เครื่องหมาย , (จุลภาค), 
เครื่องหมาย – (ลบ) เทานั้น 

 
หลักเกณฑในการโปรแกรม P006 ดังนี้  

1. คาเริ่มตนของทุกระดับ (Class) จะใช d หรือ e อยางใดอยางหนึ่งเทานั้น และในแตละระดับจะ
ใชเพียงครั้งเดียว โดย 

d = disable (ไมอนุญาต หมายเลขหรือกลุมหมายเลขที่ตามหลัง) 
  e = enable (อนุญาต หมายเลขหรือกลุมหมายเลขที่ตามหลัง) 
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2. ถามีหมายเลขมากกวาหนึ่งกลุมใหคั่นดวยเครื่องหมาย , (จุลภาค) สามารถใชเครื่องหมาย
จุลภาคไดไมจํากัดจํานวนครั้ง 
  , = and  (และ) 

3. การยกเวนใชเครื่องหมาย – (ลบ)  
ถาเริ่มตนดวยอนุญาต การยกเวนคือไมอนญุาต  
แตถาขึ้นตนดวยไมอนุญาต การยกเวนคืออนุญาต  
สามารถใชเครื่องหมายลบไดเพียงครั้งเดยีวในแตละระดบั 

- = except (ยกเวน) 
4. ตามดวยหมายเลขขึ้นตนทีต่องการ หลังเครื่องหมาย “D”, ”E”, ” , ”, “ – ” 
ในหนาจอคอมพิวเตอรของโปรแกรมคอนฟกบิว้เดอรมีตัวอยาง เชน 
d0,10-01,032 

 = ไมอนุญาตใหโทรออกดวยหมายเลขที่ขึ้นตนดวย 0 และ 10 ยกเวนหมายเลขที่จะอนุญาตให
โทรออก 01 และ 032 

กรณีนี้จะโทรออกหมายเลขที่ขึ้นตนดวยเลขอื่นได เชน 191 หรือ 1234 
e1,2,3,4,5-10,11 
 = อนุญาตใหโทรออกหมายเลขที่ขึ้นตนดวย 1 และ 2 และ 3 และ 4 และ 5 ยกเวน หมายเลข

ไมอนุญาตใหโทรออกที่ขึ้นตนดวยหมายเลข 10 และ11  
กรณีนี้จะโทรออกดวยหมายเลขที่ขึ้นตนดวยเลข 0,6,7,8,9 ไมได 

e13,191,2457354,2467253  
= อนุญาตใหโทรออกหมายเลขที่ขึ้นตนดวย 13 และ 191 และ2457354 และ 2467253 
กรณีนี้จะเจาะจงเฉพาะหมายเลขขึ้นตนทีต่องการเทานัน้ 

เนื่องจากในปจจุบันมีหมายเลขใหมเกิดขึ้นตลอดเลา ผูติดตั้งโปรแกรมระบบจะตองออกแบบ
ระดับการโทรออกจะตองออกแบบใหครอบคลุมหมายเลขที่ตองการใหมากที่สุด 
 
P007  กําหนดจํานวนหลักของหมายเลขที่ใชโทรออก (Restriction Digit Setting)   

การกําหนดจํานวนหลักของหมายเลขที่จะใชโทรออกวา  จํานวนหลักสูงสุดที่อนุญาตใหโทร
ออกไดนั้นอยูที่จํานวนกี่หลัก  แตถาเรากําหนดเปนเลข 99 ตามคาที่ใหมาจากโรงงาน  นั่นหมายความ
วาเราไมตองการที่จะจํากัดจํานวนหลักของหมายเลขโทรออก  แตในกรณีที่ตองการจะจํากัดจํานวน
หลักของหมายเลขโทรออก  ทําไดโดยกําหนดเปนตัวเลข 2 หลักลงไปในชองคอลัมน P007 ตาม
จํานวนหลักที่เราตองการจะจํากัด   
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3. โปรแกรม P0XX Holiday, Day/Night Service 
คลิกเลือก P0XX General Programming -> Holiday, Day/Night จะแสดง Page ดังรูป  
 

 
 
P008  กําหนดวันหยดุ (Holiday Setting)  

การกําหนดวันหยุดในแตละเดือนนั้น  ถือเปนอีกคุณสมบัติหนึ่งที่สําคัญ  เราสามารถกําหนด
วันหยุดในแตละเดือนทั้ง 12 เดือนไดในตารางนี้ จากตารางเราจะสังเกตเห็นวามีตัวเลข 1–12 ใน
แนวตั้ง (คอลัมน) ตัวเลขดังกลาวนี้หมายถึงเดือนทั้ง 12 เดือน สวนที่วางทางขวามือนั้นเปนสวนที่มีไว
กําหนดวันหยุดของแตละเดือน เราสามารถกําหนดคาโดยการพิมพวันที่ ที่เราตองการกําหนดเปน
วันหยุดลงไปในตารางแลวใชเครื่องหมาย ( , ) เปนตัวค่ันระหวางวันที่ในแตละวัน หรือใชวิธีการ
กําหนดวันหยุดโดยการ Double click  ลงไปตรงสวนกลางขอมูลตารางของแตละเดือน  จะมีกลอง
ขอความ Check  Array  ใหทําเครื่องหมายถูกลงในชองสี่เหล่ียมเพื่อแสดงความประสงควาจะใหวันที่
ดังกลาวนั้นเปนวันหยุดของเดือน 
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ตัวอยางการใช Check Array เพื่อเปนเครื่องมือชวยในการปอนคา เมื่อทําดับเบิ้ลคลิกที่ชองที่
จะเติมวันที่จะได ดังภาพ 

 

 
 

เมื่อคลิก OK จะไดดังภาพ 
 

 
 

ตารางแสดงผลที่ไดจากการกําหนดวันหยุดในตัวอยางขางตน  หมายถึงวันที่ 4  และวันที่ 6 
ของเดือนมกราคม ถูกกําหนดเปนวันหยุด  

การทํางานของระบบเมื่อเปนวันหยดุจะเปนการทํางานแบบกลางคืน(Night Mode) 
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P009    การเปลี่ยนบริการระหวางกลางวนั/กลางคืน (Day/Night Switching Mode) 
 เปนการเลือกวธีิการเปลี่ยนการทํางานระหวางกลางวนักบักลางคืน 

ระบบโทรศัพทสามารถทํางานที่แตกตางกันระหวางกลางวันกับกลางคืน เชนลักษณะการ
โทรเขา การล็อกทางไกล เปนตน  
 ในการเปลี่ยนการทํางานระหวางกลางวันกับกลางคืนมี 2 แบบ คือ 
 การเปลี่ยนการทํางานระหวางกลางวันกับกลางคืนดวยคําสั่งใชงาน (Manual) คําสั่งใชงาน 
  *531# ตองการเปลี่ยนการทํางานเปนกลางวัน 
  *532# ตองเปลี่ยนการทํางานเปนกลางคืน 

ผูใชคําสั่งนี้จะตองมีความสามารถควบคุมระบบ กําหนดที่ P261 
 การเปลี่ยนการทํางานระหวางกลางวันกับกลางคืนอัตโนมัติ (Automatic) จะใชเวลาที่ตั้งไวใน
โปรแกรมที่ P010 และ P011 

จากตารางตัวอยางขางลางเปนตารางที่มีไวกําหนดคาการเปลี่ยนแปลงเวลาการทํางานเปน
กลางวันและเวลากลางคืน จะมีใหเลือกเปนแบบรอคําสั่งจากผูดูแลระบบ (Manual) และแบบอัตโนมัติ 
(Automatic)   

 
 

P010    กําหนดเวลาเริ่มบริการกลางวัน (Day Mode Start Time) 
P011    กําหนดเวลาเริ่มบริการกลางคืน (Night Mode Start Time) 

การกําหนดเวลาเริ่มตนการทํางานของระบบเปนเวลากลางวันและเปนเวลากลางคืน  สามารถ
กําหนดไดในของ P010 สําหรับเวลาเริ่มการทํางานเปนเวลากลางวัน และใน P011 สําหรับเวลาเริ่มตน
การทํางานเปนเวลากลางคืน การกําหนดตัวเลขเปนเวลาที่เราตองการจะใหเปนเวลาเริ่มตนการทํางาน
ของระบบของแตละเวลาลงไปในตารางใหถูกตอง  
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4. โปรแกรม P0XX Call Pick Up 
คลิกเลือก P0XX General Programming -> Pick Up จะแสดง Page ดงัรูป  

 

 
P014    กําหนดการรับสายแทน (Pick Up Assignment) 
 เปนการกําหนดกลุมการรับสายแทน โดยทั้งระบบมี 400 ตําแหนง  

การกําหนดหมายเลขที่ตองการจะใหอยูในกลุมเดียว ทําไดโดยการกําหนดหมายเลขที่
ตองการลงไปในตารางใหอยูชิดติดกันไปเรื่อยๆ อยาใหมีชองวางมาคั่นระหวางหมายเลขที่ตองการให
อยูในกลุมเดียวกัน มิเชนนั้นโปรแกรมจะเขาใจวา ตองการที่จะแยกหมายเลขลาสุดนี้ออกจากกลุมของ
หมายเลขกอนหนา ซ่ึงในโปรแกรมนั้นจะมีแถบสีเปนตัวบงชี้วาอยูในกลุมเดียวกันหรือตางกลุมกัน 
ถามีแถบสีเดียวกันแสดงถึงการอยูในกลุมเดียวกัน (สีเดียวกันโดยที่ไมมีสีอ่ืนมาคั่น) เราจะสามารถ
กําหนดใหอยูในกลุมเดียวกันไดเร่ือยๆ จนกวาตารางที่ใหกําหนดนั้นจะเต็ม แตมีขอแมวาหามเวน
ชองวางระหวางหมายเลขที่ตองการใหอยูในกลุมเดียวกัน หรือจะกําหนดใหมีหลายกลุมยอยก็ใช
วิธีการเวนใหเกิดเปนชองวางระหวางหมายเลขเพื่อใหโปรแกรมเขาใจความตองการที่จะใหอยูตาง
กลุมกันดังที่ไดกลาวมาแลวขางตน     
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การใชงานการรับสายแทน แบงเปน 2 ประเภท คือ 
1. การรับสายแทนภายในกลุม ที่กําหนดในโปรแกรม P014 จะใชคําสั่งใชงาน *40 ผูที่

ตองการรับสายแทนไมตองรูวากระดิ่งที่ดังนั้นดังที่เครื่องโทรศัพทหมายเลขอะไร 
2. การรับสายแบบเจาะจงเครื่องที่ตองการ ไมจําเปนตองอยูในกลุม จะใช *41[Ext. No.]  โดย 

Ext. No. หมายถึงหมายเลขเครื่องโทรศัพทที่จะถูกรับสายแทน ดังนั้น กรณีนี้ ผูที่ตองการรับสายแทน
เครื่องอื่นจะตองรูวากระดิ่งโทรศัพทที่ดังนั้น ดังที่เครื่องโทรศัพทหมายเลขอะไรจึงจะรับสายแทนได 

 
ตัวอยางการตั้งกลุมการรับสายแทนสังเกตสีของแตละกลุม 

 
 
 

หมายเลขเครื่องภายในของกลุมการรับสายแทน 
แยกแตละกลุมจากกันโดยการเวนชองวาง 
มีสีที่หนาจอแสดงแยกแตละกลุม 
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5. โปรแกรม P0XX Music, Page, Short Key 
คลิกเลือก P0XX General Programming -> Music, Page, Short Key จะแสดง Page ดังรูป  
 

 
 
P016  กําหนดเสียงเพลงขณะพักสาย (Music On Hold Assignment) 

การพักสายทั้งสายนอกและสายใน เครื่องปลายทางที่ถูกพักสายจะไดยนิเสียงเพลงพกัสาย 
ระบบโทรศัพทสามารถเลือกเสียงเพลงพกัสายไดดังนี ้

เสียงเพลงพักสายภายตู เสียงเพลงจากโรงงาน หมายเลข 1-4 
เสียงเพลงพักสายภายตู เสียงเพลงจากบันทึกเสียงเพลงลวงหนา หมายเลข 5-8 
เสียงเพลงพักสายนอกตู เชน วิทยุ เทป หรือซีดี หมายเลข 9 

คําสั่งใชงานเพื่อทดลองฟงเสียงเพลง คือ *540# 
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ผูที่สามารถควบคุมระบบตาม P261 จะสามารถใชคําสั่งเปลี่ยนเสียงเพลงที่ตองการได 
คําสั่งเกี่ยวกับเสียงเพลงพักสาย คือ  
*536*# เลือกเสียงเพลงพักสายจากทีต่ั้งโปรแกรมไวใน P016 
*536**[5-8]  บันทึกเสียงเพลงพักสายที่ 5-8 ไวในตู 
*536[0-9]# เลือกใชเสียงเพลงพักสายทีต่องการ 
การกําหนดคาในโปรแกรมนั้นทําไดโดยการนําตัวเลขที่เปนรหัสของรูปแบบเสียงแบบที่เรา

ตองการใชงานมากําหนดลงไปในตาราง  เชน การกําหนดเปนเลข 0 นั่นแสดงวา  ผูใชตองการจะใช
เสียงเพลงพักสายที่ไดจากแหลงที่มาจากภายนอกตูสาขาฯ  อันไดแก  วิทยุ  เครื่องเลนเสียงเพลงตางๆ  
เปนตน 

 

 
 

P017  กําหนดการออกประกาศ (Paging Assignment) 
การกําหนดเรื่องการออกประกาศผานเครื่องขยายเสียง (Paging) เปนการตอสัญญาณโทรศัพท

ออกไปยังเครื่องขยายเสียง (ศึกษาเพิ่มเติมถึงวิธีการตอใชงานจากคูมือการติดตั้ง) โดยในขณะที่ใช
เครื่องโทรศัพทประกาศออกเครื่องขยายเสียงนั้น เครื่องโทรศัพทเครื่องดังกลาว ยังสามารถรองรับการ
รับสายจากเครื่องภายในไดอีกดวย  

*44 [0,1,2]  คําสั่งใชงานออกประกาศผานเครื่องขยายเสียง 
*45 [0,1,2]  คําสั่งใชงานรับสายจากผูประกาศ 
การกําหนดคานั้นจะกําหนดเปนตัวเลขลงในตารางโปรแกรม P017 ดังตารางตัวอยางขางลาง

นี้ 
 

 
 
 
 
 

 *** สามารถใชออกประกาศทั้ง ชอง 1 และ 2 เมื่อไมใชเสยีงเพลงพักสายนอกตู 

  เลือกคาที่ตองการ 
ขึ้นอยูกับการเขาสาย 
ในที่นี้ คูแรกเปนออกประกาศ 
คูที่สองเปนเสียงเพลงพักสายนอกตู 
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P018  กําหนดคุณสมบัติไดโทนตางๆ (Dial Tone Assignment) 
การกําหนดความถี่เสียง Dial Tone ที่ระบบจะสงใหกับเครื่องโทรศัพทจะกําหนดลงในตาราง

ของโปรแกรมนี้ เมื่อเราสังเกตจากตาราง จะเห็นถึงประเภทของโทนเสียงประเภทตางๆ เชน Dial 
Tone , Auto Route Tone , DISA Tone  และ  Non Define (ยังไมกําหนด)   ซ่ึงโทนเสียงแตละประเภท
สามารถกําหนดรูปแบบความถี่เสียงไดประเภทละ 4 รูปแบบความถี่เสียง  โดยการกําหนดเปนตัวเลข 
0 – 3 ลงในตาราง P018 
 

 
 
 ในโปรแกรม P018 เปนการกําหนดคาความถี่ของเสียง Dial Tone ประเภทตางๆ ใน
โปรแกรมมีใหเลือกอยู 4 รูปแบบความถี่เสียง เมื่อตองการใชเสียง Dial Tone เสียงใด  ใหกําหนด
ตัวเลขลงไปในตารางใหตรงกับประเภทโทนตางๆ ทั้ง 4 โทนดังที่ไดกลาวมาแลวขางตน    
 
P019  กําหนดปุมลัด (Short Key Assignment) 

การเปลี่ยนการทํางานของปุมการทํางานทางลัดตามที่ตองการ โดยใชตัวเลขปกติที่มีอยูบน
แปนของเครื่องโทรศัพททั่วไปไมวาจะเปนตัวเลข 0 – 9 หรือเครื่องหมาย *  #     

1. ปุมเพื่อจองสาย (Booking) คาจากโรงงาน คือ 6  
การจองสายใน เมื่อโทรหาเครื่องภายในแลวสายไมวาง ตองการกดรหัสเพื่อจองสาย หากสาย

นั้นวาง ระบบจะสงสัญญาณกระดิ่งเรียกกลับ เมื่อผูจองสายนั้นยกหู จะมีสัญญาณกระดิ่งดังเครื่อง
ปลายทางโดยไมตองกดหมายเลขภายในใหม  

การโทรออกขอสายนอกแลวสายไมวาง ตองการกดรหัสเพื่อจองสาย หากสายนั้นวาง ระบบ
จะสงสัญญาณกระดิ่งเรียกกลับ เมื่อผูจองสายนั้นยกหูจะไดสัญญาณไดโทนจากสายนอก สามารถกด
หมายเลขปลายทางที่ตองการ 

2. ปุมเพื่อคอยสาย (Waiting) คาจากโรงงาน คือ 3 
การคอยสาย เมื่อโทรหาเครื่องภายในนั้นแลวสายไมวาง สามารถกดปุมรหัสนี้ เครื่อง

ปลายทางจะมีสัญญาณเตือนวามีผูคอยสาย เมื่อปลายทางวางสายจะมีสัญญาณกระดิ่งดัง 
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3. ปุมเพื่อแทรกสาย (Intrusion) คาจากโรงงาน คือ 1 
การแทรกสาย เมื่อโทรหาเครื่องภายในนั้นแลวสายไมวาง สามารถกดปุมรหัสนี้ เครื่อง

ปลายทางจะมีสัญญาณเตือนวามีการแทรกสาย ผูทําการแทรกสายจะเขารวมการสนทนาสาย 
4. ปุมเพื่อดักฟง (Observation) คาจากโรงงาน คือ 0 
การดักฟง เมื่อโทรหาเครื่องภายในนั้นแลวสายไมวาง สามารถกดปุมรหัสนี้จะสามารถดักฟง

การสนทนาไดโดยฝายถูกดักฟงจะไมทราบวาถูกดักฟงแลว 
5. การเปลี่ยนรหัสหรือเลือกภาษาที่ใชในเสียงตอบรับและโอนสายจากสายนอก (OGM.) 

สามารถกําหนดในโปรแกรมตารางนี้ไดเชนกัน โดยกําหนดไวใน Duty ที่ 11–14 ในชองของ 
Language ที่ 1 – 4  เปนตน 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

การดับเบิ้ลคลิกที่หัวตารางของ P019 จะมีหนาตาง Array เพื่อยนืยันทีต่องการใชคาที่กําหนดจาก
โรงงาน (Default) 

หมายเลขที่ตองการในแตละหนาที ่
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6. โปรแกรม P0XX Console, Key, DSS. 
คลิกเลือก P0XX General Programming -> Console, Key, DSS. จะแสดง Page ดังรูป  

 

Key Telephone & DSS. (Direct Station Selection) 
เคร่ืองโทรศัพทแบบพิเศษ หรือ Operator Console เปนเครื่องโทรศัพทที่มีจอแสดงผล และ

ไฟแสดงสถานะการทํางานของเครื่องโทรศัพทภายใน ในที่นี้จะเปนเครื่อง Key Telephone และเครื่อง 
DSS. ปจจุบัน ตูสาขาโทรศัพทโฟนนิค สามารถติดตั้งเครื่องโทรศัพทแบบพิเศษไดหลายแบบ ในที่นี้
จะแบงตามแผงที่ใชควบคุม คือ 

1. Hybrid Digital Key Telephone จะใชแผงควบคุม รุน DX-4ATI, DX-8ATI  โดย 
แผง DX-4ATI ประกอบดวย Console Port จํานวน 4 พอรต, Ext. Port จํานวน 8 พอรต 

สามารถตอเครื่องคียได 4 เครื่องและเครื่องโทรศัพทแบบมาตรฐานได 4 เครื่อง, หรือจะสามารถตอ
เครื่องคียได 2 เครื่องและเครื่องโทรศัพทแบบมาตรฐานได 6 เครื่อง 

แผง DX-8ATI ประกอบดวย Console Port จํานวน 8 พอรต, Ext. Port จํานวน 8 พอรต 
สามารถตอเครื่องคียไดสูงสุด 8 เครื่องและเครื่องโทรศัพทแบบมาตรฐานได 0 เครื่อง หรือจะสามารถ
ตอเครื่องคียได 6 เครื่องและเครื่องโทรศัพทแบบมาตรฐานได 2 เครื่อง 
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เครื่องคียที่ใชไดในปจจุบัน มีดังนี้  
1.1 PK-32T/W, PK-32T/B เครื่องคียจอแสดงผลภาษาไทยเครื่องแรกในโลก พรอมปุม

ที่โปรแกรมเปลี่ยนหนาที่ได 24+8 ปุม 
1.2 PK-32E/W, PK-32E/B เครื่องคียจอแสดงผลภาษาอังกฤษ พรอมปุมที่โปรแกรม

เปลี่ยนหนาที่ได 24+8 ปุม เครื่องคียทั้ง 2 รุน ในการใชงานจะตองตอสาย 4 เสน (เครื่องละ 2 พอรต 
จาก Ext. 1 พอรต และจาก Console 1 พอรต) คือ สายคูกลางของ Modular RJ11 จํานวน 2 เสน (1 
พอรต) ตอจากแผงเชื่อมเครื่องโทรศัพทภายใน (JSD –SLT/C) และสายคูขางของ RJ11 จํานวน 2 เสน 
เรียกคูคอนโซล จะตอจากแผง JSD-ATI และการตอสายคูคอนโซล ตองระวังการกลับขั้วสาย จะทําให
เครื่องคียใชไมได  

1.3 PK-24G เครื่องคียจอแสดงผล 4 บรรทัด โดยแสดงผลไดทั้งภาษาไทย และ
ภาษาอังกฤษ พรอมปุมที่โปรแกรมเปลี่ยนหนาที่ได 24 ปุม Support Firmware ตั้งแต V3.8R0 เปนตน
ไป  

เครื่อง Hybrid Key Telephone เมื่อติดตั้งใชงานไดแลว สามารถนําเครื่องโทรศัพท
มาตรฐานมาเสียบทํางานแทนไดเมื่อเครื่องคียนั้นเสีย 

1.4 PK-DSS เครื่อง DSS. (Direct Station Selection) เปนเครื่องโทรศัพทพิเศษ มีปุมที่
โปรแกรมหนาที่ได 96 ปุม จะทํางานรวมกับเครื่องคีย การติดตั้งจะไมตองใชวงจรสายใน  
  เครื่องคีย 1 เครื่องสามารถใชรวมกับเครื่อง DSS. ไดมากกวา 1 เครื่อง 

 
2. Digital Key Telephone จะใชแผงควบคุมรุน DX-4ATI, DX-8ATI  โดย 

แผง DX-4DTI ประกอบดวย Console Port จํานวน 4 พอรต, Ext. Port จํานวน 8 พอรต 
สามารถตอเครื่องคียแบบดิจิตอลไดสูงสุด 4 เครื่องและเครื่องโทรศัพทแบบมาตรฐานไดสูงสุด 8 
เครื่อง หรือจะตอเครื่องคียแบบดิจิตอลได 2 เครื่องและเครื่องโทรศัพทแบบมาตรฐานได 8 เครื่อง 

แผง DX-8DTI ประกอบดวย Console Port จํานวน 8 พอรต, Ext. Port จํานวน 8 พอรต 
สามารถตอเครื่องคียดิจิตอลไดสูงสุด 8 เครื่องและเครื่องโทรศัพทแบบมาตรฐานไดสูงสุด 8 เครื่อง 
หรือจะตอเครื่องคียได 6 เครื่องและเครื่องโทรศัพทแบบมาตรฐานได 8 เครื่อง 

เครื่อง Digital Key Telephone รุน PK-32D ทําหนาที่ไดคลาย PK-32T/W แตเพิ่มการ
ทํางานอื่น เชน กระดิ่งเรียกเปนเสียงดนตรี ปรับความดังดวยดิจิตอล มีสมุดโทรศัพทในตัว เพียงแตไม
สามารถเสียบใชงานแทนดวยเครื่องโทรศัพทมาตรฐานได หรือหากตองการใชคูกับเครื่อง DSS. 
จะตองใช DSS. รุน PK-96S และเพิ่มแผงควบคุม JSD-ATI สําหรับควบคุมเครื่อง DSS. ดวย 

ตําแหนงที่เสียบในตูของแผง JSD-ATI หรือ JSD-DTI จะสามารถเสียบตําแหนงชอง
สลอตที่สามารถเสียบแผงสายใน JSD-SLT ได ใน 1 ระบบ ของตู JSD-Series หรือ DX-Series 
สามารถใสไดรวมกันทั้งสองแบบไมเกิน 8 แผง 
การนับคอนโซลพอรต  

บนแผง DX-AUX จะเปนพอรตที่ 61-64 
บนแผง JSD-AUX จะเปนพอรตที่ 61-64 
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สําหรับแผง DX-4ATI, DX-8ATI, JSD-4ATI, JSD-8ATI ขึ้นกับตําแหนงที่เสียบของ
แผงวงจร (SLOT) ทั้งระบบสามารถเสียบได 8 แผง หรือ 64 พอรต นับลําดับจากชองเสียบแผงวงจร
จากซายไปขวา แตละชองเสียบนับเปน 8 พอรต ถาใชแผงที่มี 4 พอรตทําใหพอรตที่เหลือถูกขามไปใช
ไมได และถามีการเสียบแผงที่ 8 ทําใหวงจรในแผง DX-AUX หรือ JSD-AUX จะใชไมได 
P020  กําหนดจุดตอเคร่ืองโทรศัพทแบบพิเศษ (Key & DSS.)  (Attendance Console Assignment)   

การจับคูของ Ext. Number กับ Console Port นั้นจะเกิดขึ้นอัตโนมัติ โดยเมื่อเขาสายได
ถูกตองแลว ในขณะเสียบสายเขาเครื่องคีย ระบบโทรศัพทจะจับคูใหอัตโนมัติโดยไมตองใชโปรแกรม
นี้ 

การจับคูเครื่อง DSS. ใหเขากับเครื่องคียนั้นเพียงแคนําหมายเลขประจําเครื่องคียที่ตองการ
จับคูดวยนั้น  มากําหนดลงไปในชองพอรตคอนโซลที่เครื่อง DSS. เสียบอยู  เชน 
 

 
 

ตัวอยางจะเห็นวาจะกําหนดใหเครื่อง DSS. เครื่องที่อยูในพอรต 1 คูกับเครื่องคียหมายเลข 
1001  ดังนั้นเมื่อมีการกดปุมโทรที่เครื่อง DSS. พอรต 1 จะใชเครื่องคียหมายเลข 1001 สนทนา   

การติดตั้งเครื่อง DSS. สายจากแผงควบคุมจะตองระวังเรื่องขั้วไฟของสาย หากเขาขั้วไม
ถูกตองจะใชไมได เมื่อเขาขั้วไฟถูกตองแลว ใหโปรแกรมจับคูกับเครื่องคีย หากการโปรแกรมจับคูให
เครื่อง DSS. ไมถูกตองเครื่อง DSS. จะแสดงไฟสถานะเทานั้นไมสามารถกดปุมเรียกสายได 

 
P021  กําหนดหนาแสดงผลเครื่องพิเศษ (Key & DSS.)  (Attendance Page Assignment)   
 เครื่อง Key และ DSS. ในระบบสามารถใชงานไดสูงสุด 64 เครื่อง (64 พอรต) และระบบ
สามารถเปลี่ยนหนาที่การทํางานของปุมตางๆได 4 หนา (Page) คาที่โปรแกรมนี้ เปนการกําหนดจุด
เร่ิมทํางานของแตละเครื่องวาจะเริ่มทํางานที่เพจไหน 
 หากเครื่องไหนตองการการทํางานเปลี่ยนเพจได สามารถกําหนดปุมการเปลี่ยนเพจได ที่การ
กําหนดหนาที่ของปุม 
 
P022  กําหนดหนาท่ีปุมของ Key ในแตละหนา (Key – Pad Assignment) 
 เครื่องคีย รุน PK-32 Series จะมีปุมที่สามารถโปรแกรมได 32 ปุม สามารถโปรแกรมการใช
งานที่แตกตางกันได 4 เพจ (Page) แตละเพจจะทําหนาที่ได คือ 
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 ปุม 24 ปุมแรก มีไฟสถานะ 2 สี สามารถตั้งเปนปุมเรียกสายนอก ปุมเรียกสายในปุมพักสาย
แบบพารค ปุมเปลี่ยนหนาแตละเพจ ปุมควบคุมเปด-ปดไฟฟา ปุมโทรออกจากหนวยความจํา
หมายเลขยอ โดยไฟสถานะจะทํางานสัมพันธกับการทํางานนั้น 
 ปุม 8 ปุมหลัง ไมมีไฟแสดงสถานะ สามารถกําหนดหนาที่ไดเหมือน 24 ปุมแรก แตเนื่องจาก
แตละปุมไมมีไฟแสดงสถานะอาจจะทําใหผูใชงานสับสน จึงถูกกําหนดคาจากโรงงานใหทําหนาที่
เปนปุมโทรออกจากหนวยความจําหมายเลขยอ 

การกําหนดหนาที่ของปุมกดนั้นก็เพื่อเปนการสะดวกในการโทรออกโดยที่ไมจําเปนตองกด
หมายเลขที่ยาวหรือยากแกการจํา  เมื่อมีเครื่องคียใชแลว  ผูใชเพียงแคจําใหไดวาปุมกดของเครื่องคีย
ปุมนี้เปนปุมที่เราไดกําหนดวาทําหนาที่อะไร   

การกําหนดคาจะใชวิธีการนําเลขตามรูปแบบที่กําหนดมาเติมลงไปในตารางซึ่งจะมีคําอธิบาย
อยูแลววา  ตองปอนขอมูลอยางไรจึงจะไดคาที่ตองการ เมื่อกดปุม Tips ทางขวามือจะไดหนาจอ
แนะนําการปอนคา ดังรูป 

 

 
 

P023  กําหนดหนาท่ีปุมของ DSS.  (DSS – Pad Assignment) 
เครื่อง DSS. ตองทํางานรวมกับเครื่องคีย ปุมที่กําหนดหนาที่การทํางานได 96 ปุม แตละปุมมี

สีแดงสีเดียว สามารถกําหนดหนาที่ไดหลายอยางเหมือนปุมของเครื่องคีย แตนิยมใหในเครื่องคียเปน
ปุมสายนอกเนื่องจากมีจํานวนนอย และปุมของเครื่อง DSS. เปนปุมของเครื่องภายในเนื่องจากมี
จํานวนมาก และสามารถใชเครื่องคียหนึ่งเครื่องตอเคร่ือง DSS. หลายเครื่องเพื่อเพิ่มจํานวนปุมใหได
ครบตามจํานวนเครื่องภายในที่ตองการ 

การกําหนดหนาที่ปุมของ DSS. ใชวิธีเดยีวกับการปอนคาใหกับปุมของเครื่องคีย P022 
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7. โปรแกรม P0XX Memory Number 
คลิกเลือก P0XX General Programming -> Memory Number จะแสดง Page ดังรูป  

 

 
 

การทํางานของโปรแกรมจะเปนเรื่องที่เกี่ยวกับการโทรออกดวยหมายเลขยอ (Speed Dial or 
Abbreviate Dial) เปนการยอหมายเลขที่มีความยาวมากหรือหมายเลขที่มีการโทรออกเปนประจําให
เหลือเปนหมายเลขยอส้ันๆ เพื่องายแกการจดจําและสะดวกในการโทรออก ผูที่สามารถใชหมายเลข
ยอไดนั้น จะตองกําหนดหมายเลขโทรออกไวแลวกอนหนาและเปนผูมีสิทธิ์ใช สวนการ ล็อกทางไกล
ที่ครอบคลุมหมายเลขยอของเครื่องภายใน จะทําใหการโทรออกสายนอกดวยหมายเลขยอนั้นใชงาน
ไมได  

ชนิดหมายเลขยอแบงออกเปน 2 ชนิด คือ 
1. หมายเลขยอสวนรวม (System Speed Dial) เปนหมายเลขยอของระบบ  ใชงานไดทุก

เครื่องภายใน มีทั้งสิ้น 500 หมายเลข อยูที่ตําแหนง 500 – 599 หากตองการใชมากกวานี้ สามารถนํา
ตําแหนงที่เก็บบันทึกหมายเลขยอสวนตัวมาใชเปนหมายเลขยอสวนรวมได 

2.  หมายเลขยอสวนตัว (Personal Speed Dial) เปนหมายเลขยอสวนตัวประจําเครื่อง   
ผูที่สามารถใชหมายเลขยอสวนตวัไดนั้น จะตองโปรแกรมไวแลวกอนหนา ที่ P024  
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P024  กําหนดเลขหมายภายในที่ใชหมายเลขยอสวนตัว (Personal Memory Assignment) 
 การกําหนดใหหมายเลขเครื่องภายในสามารถใชหมายเลขยอสวนตวัได สามารถกําหนดได 
50 ตําแหนง (ตําแหนงละ 10 หมายเลขยอ) ตําแหนงที ่ 1-10 หมายเลขหามซ้ํากัน หลังจากนั้น แตละ
ตําแหนงจะใชหมายเลขภายในซ้ํากันไดไมเกิน 5 คร้ัง ถาใชครบ 5 คร้ังจะมีหมายเลขยอได 50 
หมายเลข ถาใชหมายเลขภายใน 3 คร้ังจะมีหมายเลขยอสวนตัวได 30 หมายเลข 

ซ่ึงจาก P024 จะเห็นวา สามารถกําหนดหมายเลขเครื่องภายในได 50 ตําแหนง (50 เครื่อง) แต
ละเครื่องจะสามารถใสหมายเลขยอได 10 หมายเลข รวม 500 ตําแหนง แตเพื่อรองรับความการตองที่
หลากหลาย อาจจะใชงานที่เครื่องภายในได 10 เครื่องๆละ 50 เลขหมายไดดวย โดยอาศัย
หนวยความจํา 500 ตําแหนงนี้ 
 
P093  กําหนดหนวยความจําของระบบ (System Memory Setting) 
 เปนคาในตารางขนาด 100 แถว คูณ 10 คอลัมภ เทากับ 1000 ตําแหนงของหมายเลขยอ จะมี
หมายเลขประจําตําแหนงของหมายเลขยอเปน 0-999 

ตําแหนงที่ 00-99 เปนหมายเลขยอสวนตัว ของเครื่องภายใน ที่อนุญาตใหใชงานไดที่ P024 
ตําแหนงที่ 1-10 โดยหมายเลขของหมายเลขยอจะถูกบันทึกโดยคําสั่งใชงาน *57[00-09] และโทรออก
ดวย *7[00-09] 

ตําแหนงที่ 100-499 เปนหมายเลขยอสวนตัวขึ้นกับการกําหนดของ P024 ตําแหนงที่ 11-50
หมายเลขยอ 400 ตําแหนงนี้ จะใชงานแตกตางกัน 

- สามารถบันทึกไดจากเครื่องโทรศัพทภายใน *57[00-09] และโทรออกดวย 
*7[00-09] เมื่อหมายเลขภายในนั้นถูกใชคร้ังแรกใน P024  

- บันทึกไดจากเครื่องโทรศัพทภายใน *57[10-19] หรือ P093 และโทรออกดวย 
*7[10-19] เมื่อเครื่องภายในนั้นถูกเรียกใชคร้ังที่ 2 ใน P024 

- บันทึกไดจากเครื่องโทรศัพทภายใน *57[20-29] หรือ P093 และโทรออกดวย 
*7[20-29] เมื่อเครื่องภายในนั้นถูกเรียกใชคร้ังที่ 3 ใน P024 

- บันทึกไดจากเครื่องโทรศัพทภายใน *57[30-39] หรือ P093 และโทรออกดวย 
*7[30-49] เมื่อเครื่องภายในนั้นถูกเรียกใชคร้ังที่ 4 ใน P024 

- บันทึกไดจากเครื่องโทรศัพทภายใน *57[40-49] หรือ P093 และโทรออกดวย 
*7[40-49] เมื่อเครื่องภายในนั้นถูกเรียกใชคร้ังที่ 5 ใน P024 
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ตําแหนงที่ 100-499 นอกจากบันทึกเปนหมายเลขยอสวนตัว ยังสามารถนําไปใชเปน
หมายเลขสวนรวมได ถาไมมีหมายเลขภายในที่ใชหมายเลขยอสวนตัวใน P024  

- ถาไมมีหมายเลขภายใน ใน P024 ตําแหนง 11-20 จะเปนหมายเลขยอสวนรวม 
ตําแหนงที่ 100-199 
ใชการโทรออก *71[00-99] 

- ถาไมมีหมายเลขภายใน ใน P024 ตําแหนง 21-30 จะเปนหมายเลขยอสวนรวม 
ตําแหนงที่ 200-299 
ใชการโทรออก *72[00-99] 

- ถาไมมีหมายเลขภายใน ใน P024 ตําแหนง 31-40 จะเปนหมายเลขยอสวนรวม 
ตําแหนงที่ 300-399 
ใชการโทรออก *73[00-99] 

- ถาไมมีหมายเลขภายใน ใน P024 ตําแหนง 41-50 จะเปนหมายเลขยอสวนรวม 
ตําแหนงที่ 400-499 
ใชการโทรออก *74[00-99] 

ตําแหนงที่ 500-999 เปนตําแหนงหมายเลขยอสวนรวม บันทึกหมายเลขยอที่โปรแกรม P093 
นี้ และโทรออกดวย *7[500-999] 
 การโทรออกดวยหมายเลขยอ สามารถเปลี่ยนคําสั่งการใชงานไดที่ P001_870-879 
 จากโปรแกรมคอนฟกบิ้วเดอร จะเห็นวาตําแหนงของหนวยความจําหมายเลขยอนี้สามารถใส
ช่ือที่ตองการได เพื่อเปนคําอธิบายถึงหมายเลขยอที่ใชงานอยู  
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8. โปรแกรม P0XX Department 
คลิกเลือก P0XX General Programming -> Department จะแสดง Page ดังรูป  

 

 
 
P028  กําหนดแผนกของกลุมสายนอก (Department of CO. Group) 
P029  กําหนดแผนกของกลุมสายใน (Department of Ext. Group) 

แผนกของกลุมสายนอก ถูกนําไปใชกับเสียงตอบรับอัตโนมัติ (OGM.) ที่แตกตางกันในแตละ
แผนก และเมื่อผูโทรเขากลุมสายนอกของแตละแผนก เมื่อกดไปหมายเลขโอเปอเรเตอร จะไปดังที่
เครื่องโทรศัพทภายในที่ถูกกําหนดใหเปนโอเปอเรเตอรของแผนก 

แผนกของกลุมสายใน เมื่อมีการเรียกไปหมายเลขโอเปอเรเตอรของแผนก สัญญาณกระดิ่ง
อาจจะไปดังที่เครื่องภายในที่แตกตางกันระหวางแตละแผนก 

การกําหนดคาจะกําหนดโดยการเติมตัวเลข 1–8 ลงในชองวางของตาราง P028   เพื่อเปนการ
กําหนดแผนกของกลุมสายนอก และตาราง P029 สําหรับการกําหนดแผนกของกลุมสายใน ซ่ึงตัวเลข
ที่ถูกกําหนดเหลานี้หมายถึงแผนกที่ 1-8   และจะตองกําหนดตัวเลขลงในชองวางของกลุมที่ตองการ
แบงแผนกในแถวที่ 1–32 ใหถูกตองดวย 
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9. โปรแกรม P0XX OGM., Message, Logger 
คลิกเลือก P0XX General Programming -> OGM., Message, Logger จะแสดง Page ดังรูป  

 

 
 
 
P030  กําหนดเสียงตอบรับของกลุมสายนอก (กลางวัน) (Outgoing Message Assignment (Day))  
P031  กําหนดเสียงตอบรับของกลุมสายนอก (กลางคืน) (Outgoing Message Assignment (Night)) 
 ระบบเสียงตอบรับและโอนสายอัตโนมัติ จะทํางานเมื่อ P110/P111 กําหนดการตอบรับการ
โทรเขาของสายนอกดวย OGM. 
 เสียงตอบรับและโอนสายอัตโนมัติ สามารถใชเสียงตอบรับที่แตกตางกันระหวางกลางวันกับ
กลางคืน โดยโปรแกรมที่ P030 กับ P031 

เสียงตอบรับและโอนสายอัตโนมัติ สามารถใชเสียงตอบรับที่แตกตางกันระหวางแตละแผนก
ของกลุมสายนอก เมื่อมีการแบงแผนกของสายนอก P028 

เสียงตอบรับและโอนสายอัตโนมัติ มีเสียงมาตรฐาน ทํางานโตตอบการโทรเขาดวยเสียงที่
แตกตาง 6 เสียง สามารถบันทึกเสียงไดดวยเครื่องโอเปอเรเตอร 
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หนาท่ีการทํางานของเสียง 
เสียงที่ 1 เสียงพูดสวัสด ีGreeting Message เปนเสียงตอบรับเสียงแรก  
เสียงที่ 2 เสียงพูดบอกสายไมวาง Busy Line Message เปนเสียงตอบรับ เมื่อไดรับหมายเลข

จากผูโทรเขาแลวหมายเลขนั้นสายไมวาง โดยผูโทรเขาจะสามารถคอยสาย เมื่อปลายทางวางจะเรียก
ไปทันที หรือ กดเปลี่ยนไปเรียกหมายเลขอื่น หรือกด *11# เพื่อฝากขอความ เมื่อระบบมีการติดตั้ง
ระบบฝากขอความเสียง 

เสียงที่ 3 เสียงพูดบอกไมมีผูรับสาย No Answer Line Message เปนเสียงตอบรับ เมื่อเรียกไป
แลวไมมีผูรับสาย ผูโทรเขาจะสามารถคอยสาย หรือ กดเปลี่ยนไปเรียกหมายเลขอื่นหากตองการ หรือ
กด *11# เพื่อฝากขอความ เมื่อระบบมีการติดตั้งระบบฝากขอความเสียง 

เสียงที่ 4 เสียงพูดจะตัดสาย Disconnect The Line Message เมื่อเปน OGM.1 ระบบจะตัดสาย
เมื่อไมมีผูรับสาย หรือไมสามารถทํางานตามที่ผูโทรเขากดหมายเลขมา 

เสียงที่ 5 เสียงพูดกรุณาคอยสักครู Ring back Message เปนเสียงใหคอยสักครู ระบบกําลัง
โอนสายไปให เสียงนี้สามารถบันทึกเปนเสียงเพลงเรียกสายได 

เสียงที่ 6 เสียงพูดบอกกรุณากดหมายเลขภายในใหม Reenter Message เปนเสียงใหผูโทรเขา
กดหมายเลขใหม เนื่องจากระบบไดรับหมายเลขไมถูกตอง หรือไดไมครบหลัก 

เสียงที่ 9 เสียงพูดบอกใหทราบวามีขอความฝากถึงทาน ตองการฟงขอความที่ฝาก กด * 12 # 
เสียงที่ 10 เสียงพูดบอกใหทราบวาระบบฝากขอความไมวาง 
เสียงที่ 12 เสียงพูดบอกใหทราบกรณีที่ทานถูกจํากัดวงเงินชั่วคราว และบอกใหทานติดตอกับ

เจาหนาที่ที่ทําการดูแล 
  

ตัวอยาง…เสียงตอบรับของตูสาขาโทรศัพทโฟนนิค 

เสียง1 
= สวัสดีคะ กรุณากดหมายเลขภายใน ท่ีทานตองการติดตอ หรือกด 0 เพือ่ติดตอโอเปอเรเตอร 
= สวัสดีคะ ท่ีนี่ … กรุณากดหมายเลขภายใน ท่ีทานตองการติดตอ หรือกด 0 เพื่อ ติดตอ  
= สวัสดีคะ ท่ีนี่ … ติดตอฝายขายกด 11 ฝายบริการกด 12 ติดตอโอเปอเรเตอรกด0 หรือถอื

เสียง2 
= หมายเลขที่ทานตองการติดตอไมวาง กรุณารอสักครูหรือกดหมายเลขใหม ขอบคุณคะ 
= หมายเลขที่ทานตองการติดตอไมวาง กรุณารอสักครูหรือกดหมายเลขใหมหากตองการฝาก

เสียง3 
= ไมมีผูรับสาย กรุณากดหมายเลขใหม หรือกด 0 เพื่อติดตอโอเปอเรเตอร ขอบคุณคะ 
= ไมมีผูรับสาย กรุณากดหมายเลขใหม หากตองการฝากขอความกด *11#  ขอบคุณคะ 

เสียง4 = ไมสามารถติดตอได กรุณาติดตอกลับมาใหม ขอบคุณคะ 
เสียง5 = กรุณารอสักครู ระบบกําลังโอนสายใหคะ 
เสียง6 = ไมสามารถติดตอได กรุณากดใหม หรือกด 0 เพื่อติดตอโอเปอเรเตอร 
เสียง9 = มีขอความฝากถึงทานคะ ฟงขอความกด * 12 # 
เสียง10 = ระบบฝากขอความไมวางคะ 
เสียง12 = ทานถูกจํากัดวงเงินชั่วคราว กรุณาติดตอเจาหนาท่ีคะ 
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การทํางานของระบบเสียงตอบรับอัตโนมตั ิ
  
 สายเขา +->  RINGING MODE --> CO-RINGING 
              | 
            +->  OGM/DISA MODE --> รับสายอัตโนมัติ --> (S) 
 
 (S) เสียง1  +->  กดถูก  -->  (A)  +->  FREE  -->  เสียง5  -->  (รอการรับสาย) 
             |                    +->  BUSY  -->  เสียง2  -->  (รอการรับสาย) 
             | 
             +->  ไมกด  -->  (B)  +->  SERVICE-PORT         -->  (A) 
             |                    +->  No SERVICE-Port    -->  (E) 
             | 
             +->  กดผิด  -->  (C)  -->  เสียง6  +->  กดถูก  -->  (A) 
                                            +->  ไมกด  -->  (D)  +->  MODE1  -->  (E) 
                                            |                    +->  MODE2  -->  (B) 
                                            | 
                                            +->  กดผิด  -->  เสียง6  +->  กดถูก  -->  (A) 
                                                                  +->  ไมกด  -->  (D) 
                                                                  +->  กดผิด  -->  (D) 
(E) เสียง1  +->  กดถูก  -->  (A)                                   
            +->  ไมกด  -->  เสียง4  -->  วางสาย 
            +->  กดผิด  -->  (F) เสียง1 +--> กดถูก --> (A) 
                                                               +--> ไมกด --> เสียง4 --> วางสาย 
                                                               +--> กดผิด --> เสียง4 --> วางสาย 
 
 (รอการรับสาย)  +->  รับสาย  -->  สนทนา 
                       +->  ไมรับสาย   -->  เสียง3   +->  กดถูก --> (A) 
                                                            +->  ไมกด  -->  (D) 
                                                            +->  กดผิด  -->  (C) 
 
*** รายละเอียดอาจจะแตกตางกันเล็กนอยในแตละรุน *** 
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ประโยคเสียง 
ในระบบจะมีเสียงที่ผูติดตั้ง ดูแลระบบสามารถบันทึกเสียงได 60 ประโยค ในแตละประโยค 

มี 4 ภาษา 
การบันทึกเสียง ใชคําสั่งการใชงาน *534[1-4][01-60]#...... 
การฟงเสียงทีบ่ันทึก ใชคําสัง่การใชงาน *535[1-4][01-60]#...... 
เครื่องที่จะสามารถบันทึกเสียงไดจะตองอยูในกลุมสายในที่สามารถควบคุมระบบได โดย

การกําหนดใน P261 
 ในการกําหนดคานั้นจะใชตัวเลขประโยคเสียงที่แทนรูปแบบเสียงตางๆ  มาเติมลงในชองวาง
ใหสอดคลองกับตําแหนงขอความที่ตองการใช ซ่ึงจะมีคําอธิบายเพื่อแสดงถึงหนาที่ของชองวางแตละ
ชองที่ใชเติมนั้นเปนชองของเสียงที่ใชกับสถานการณใด   

 
 

 

เลือกแผนก เมือ่มีการใชแผนกใน P028, P029 เลือกภาษา เมือ่มีการใชงานภาษาที่ 1-4 

เลือก กลางวัน/กลางคืน เปลี่ยนประโยคเสียงที่ตองการ 
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 ประโยคเสียงภายในระบบสามารถบันทึกเสียงใหมไดดวยเครื่องโทรศัพทภายใน มีการ
ทํางานตามรูปขางลางนี้ 
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P032  กําหนดเสียงของระบบ (System Message Assignment) 
เปนตารางที่มีไวสําหรับกําหนดรูปแบบเสียงตางๆ ใหกับเครื่องโทรศัพทภายใน  หากสังเกต

ในตารางทางขวาจะเห็นวามีคําอธิบายของชองที่ใชเติมตัวเลขนั้นๆ วาเปนของรูปแบบเสียงใด  จึงควร
เติมตัวเลขประโยคเสียงใหถูกตองและสัมพันธกัน   

 

            

ขอความที่ 

เปลี่ยนประโยคเสียงที่ตองการ 

ความหมาย 
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ขอความที่  
(Message no.) 

ความหมาย หมายเหต ุ

ขอความที่ 1  
(Message no.1) 

Dial Message. เมื่อยกหู ของเครื่องโทรศัพท จะไดยนิเสียงพูด
ประโยคนี้ เชน บันทึกวา “หมายเลขของทาน 
1001” แลวจะไดยินเสียง Dial Tone ตามมา 
สามารถกดหมายเลขสวนไปสัญญาณเสียงได 

ขอความที่ 2  
(Message no.2) 

Busy Message. เมื่อกดเรียกไปยังเครื่องภายในอื่นที่กําลังใชสายอยู 
จะไดยินเสียงพูดประโยคทีต่องการ (เสียงของแต
ละประโยคจะถูกบันทึกลวงหนาแลว) เชน “สาย
ไมวาง” 

ขอความที่ 3  
(Message no.3) 

Ring Back 
Message. 

เมื่อกดเรียกไปยังเครื่องภายในแลว กอนจะไดยิน
สัญญาณเรียก จะมีเสียงพดูประโยคที่ไดโปรแกรม
และบันทึกไว เชน “1008” ซ่ึงหมายถึง หมายเลข
ของเครื่องที่ถูกเรียก จะมีกระดิ่งดังปลายทาง 
พรอมกับเสียงพูดที่ผูเรียก 

ขอความที่ 4  
(Message no.4) 

Error Message. เมื่อยกหูโทรศัพทและกดหมายเลขที่ระบบไม
สามารถใหบริการได กอนที่จะไดรับสัญญาณ 
Error Tone อาจจะทําใหมีเสียงพดู เชน “กด
หมายเลขผิด” ซ่ึงถูกโปรแกรมและบันทกึเสียงไว
แลวลวงหนา 

ขอความที่ 5  
(Message no.5) 

DND Message เมื่อโทรไปหาเครื่องโทรศัพทที่ถูกตั้งหามรบกวน
จะมีเสียงแจงวาเครื่องนั้นถูกตั้งหามรบกวนไว เชน
บันทึกเสียงวา “ เลขหมายปลายทางตั้งหามรบกวน
ไวคะ” แลวระบบจะตั้งสายอตัโนมัติ 

ขอความที่ 6  
(Message no.6) 

Dial on DND. 
Message. 

เมื่อเครื่องโทรศัพทไดถูกสั่งงานให ทํางาน หาม
รบกวน จะทําใหไมสามารถโทรเขายังเครื่องนั้นได 
เมื่อไปยกหูเครื่องโทรศัพทนั้น จะไดยินเสียง “ถูก
ตั้งหามรบกวน” เชนบันทึกเสียงวา “เครื่องของ
ทานตั้งหามรบกวนแลวคะ” ซ่ึงถูกโปรแกรมและ
บันทึกเสียงไวแลวลวงหนา 
*** คําสั่งใชงาน หามรบกวน จากสายนอกและ
สายใน  *509#   (ด-ูคูมือใชงาน) 
*** ยกเลิกคําสั่งใชงาน หามรบกวน  

*50#     (ด-ูคูมือใชงาน) 
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ขอความที่ 7  
(Message no.7) 

Dial on Call 
Forward Message. 

เมื่อเครื่องโทรศัพทไดถูกสั่งงานให ทํางาน ฝาก
สายไปเครื่องอื่น จะทําใหเมื่อโทรไปเครื่องนั้นแลว 
สัญญาณกระดิ่งจะไปดังที่เครื่องอื่น เมื่อไปยกหู
เครื่องโทรศัพทนั้น จะไดยินเสียง “ถูกตั้งฝากสาย” 
ซ่ึงถูกโปรแกรมและบันทึกเสียงไวแลวลวงหนา 
*** คําสั่งใชงาน ตั้งฝากสาย  

*51[Ext. No.]#  (ด-ูคูมือใชงาน) 
*** ยกเลิกคําสั่งใชงาน ตั้งฝากสาย  

*50#     (ด-ูคูมือใชงาน) 
ขอความที่ 8  

(Message no.8) 
Dial on Wake Up 
Set Message. 

เสียงในการตั้งปลุก 
ผูตั้งปลุก หลังจากทําคําสั่งปลุก (ใหเครื่องตนเอง
หรือใหเครื่องอื่น) แลวจะไดยินเสียง “ขณะนี้เวลา 
21.34 นาฬิกา ตั้งปลุกเวลา 5.30 นาฬิกา” 
ผู ถูกตั้ งปลุก  หลังจากถูกตั้ งปลุกแลว  เมื่อยก
หูโทรศัพทจะไดยินเสียง  “ขณะนี้ เวลา  21.35 
นาฬิกา ตั้งปลุกเวลา 05.30 นาฬิกา” 
*** คําสั่งใชงาน การตั้งปลุก  

 *58[HHMM]#    ตั้งปลุกเครื่องตนเอง 
  *58# ยกเลิกปลุกเครื่องตนเอง 

(ด-ูคูมือใชงาน) 

ขอความที่ 9  
(Message no.9) 

Get Voice Mail 
Message. 

เมื่อมีการใชระบบฝากขอความ รวมกับตูสาขา
โทรศัพท ผูใชจะรูวาเครื่องตนเองมีขอความฝากไว
ได 2 วิธี คือ  
1. Voice Mail Message Lamp จะมีไฟแสดงที่

เครื่องโทรศัพท โดยจะตองใชเครื่องที่รับ
สัญญาณจากตูได 

2. Voice Mail Message เมื่อยกหู โทรศัพทจะมี
เสียงพูด จากโรงงานจะเปนประโยคที่ 69 พูด
วา “ทานมีขอความฝากไว” สามารถแกเปน
ประโยคอื่นได (แนะนําใหเปนประโยคที่ 9) 
แลวอัดเสียงที่ตองการ ขึ้นอยูกับผูติดตั้งวาง
ระบบ 
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ขอความที่ 10  
(Message no.10) 

Voice Mail Busy เนื่องจากระบบฝากขอความภายในตู มีจํานวน
วงจรนอยกวาเครื่องโทรศัพทภายในมาก ทําให
บางครั้งไมสามารถใหบริการ ผูตองการ ฟง หรือ
ฝาก พรอมกันหลายๆคน ดังนั้น ผู เรียกใช เมื่อ
ระบบฝากขอความกําลังใหบริการผูอ่ืน จะไดยิน
เสียงของระบบพูดวา “ระบบฝากขอความไมวาง” 
*** จะตองมีแผงรับฝากขอความ EVM. 
*** คําสั่งใชงาน ฝากขอความ 

*11#     (ด-ูคูมือใชงาน) 
***  คําสั่งใชงาน ฟงขอความ 

*12#     (ด-ูคูมือใชงาน) 
ขอความที่ 11  

(Message no.11) 
Internal 
Announcement 
Message. 

ในบางครั้งผูดูแลระบบ อาจจะตองการสื่อสารกับ
หองพักโดยการออกประกาศใหทุกหอง สามารถ
ใชระบบประกาศภายในได  แต  ตองทํ าการ
โปรแกรมและบันทึกเสียงลวงหนา 
*** คําสั่งใชงาน ใหมีประกาศภายในของ
เครื่องโทรศัพท 

507[Ext.No.]#    (ด-ูคูมือใชงาน) 
*** ยกเลิกคําสั่งใชงาน ใหมีประกาศภายใน 

508[Ext. No.]#   (ด-ูคูมือใชงาน) 
ขอความที่ 12  

(Message no.12) 
Money Locked 
Message. 

สําหรับการใชโทรศัพท ของหอพัก อพารตเมนท 
หรือมีการคิดเงินกับผูใชโทรศัพท จะมีการกําหนด
วงเงินที่ใชงานในแตละเดือน บางครั้ง วงเงินเต็ม
กอนครบเดือน เมื่อยกหูโทรศัพทจะมีเสียงพูด ซ่ึง
ไดโปรแกรมและบันทึกเสียงไวลวงหนาแลว เชน 
“วงเงินเต็ม กรุณาติดตอโอเปอเรเตอร” 

ขอความที่ 13 
(Message no.13) 

Wake Up Message หลังจากมีการตั้งปลุกแลว เมื่อถึงเวลาตั้งปลุก ยกหู
จากกระดิ่งปลุก จะไดยินเสียงนี้ คาจากโรงงานเปน  
“ขณะนี้เวลา 05.30 นาฬิกา” 

ขอความที่ 14 
(Message no.14) 

Warning for Power 
Control 

ในการใชระบบเปด-ปดไฟฟาผานโทรศัพท เมื่อตั้ง
ใหเปดชั่วคราว กอนการตัดไฟ 10 นาทีจะมีเสียง
จากประโยคนี้เตือนใหเครื่องโทรศัพทในหองได 



 

 

C - 39 

ขอความที่  31  
(Message no.31) 

Message from 
Alarm sensor No.1. 

เมื่อตูสาขาโทรศัพทมีการตอระบบตรวจจับ จะ
สามารถสงสัญญาณเมื่อระบบตรวจจับไปยัง
เครื่องโทรศัพทที่ตองการได เมื่อเครื่องโทรศัพท
นั้นยกหู จะไดยินเสียง “เรียกจากสัญญาณเตือนภัย
ชุดที่ 1” 

ขอความที่ 32  
(Message no.32) 

Message from  
Alarm sensor No.2. 

“เรียกจากสัญญาณเตือนภัยชุดที่ 2” 

ขอความที่ 33  
(Message no.33) 

Message from 
Alarm sensor No.3. 

“เรียกจากสัญญาณเตือนภัยชุดที่ 3” 

ขอความที่ 34  
(Message no.34) 

Message from 
Alarm sensor No.4. 

“เรียกจากสัญญาณเตือนภัยชุดที่ 4” 

ขอความที่ 35  
(Message no.35) 

Message from 
Alarm sensor No.5. 

“เรียกจากสัญญาณเตือนภัยชุดที่ 5” 

ขอความที่ 36  
(Message no.36) 

Message from 
Alarm sensor No.6. 

“เรียกจากสัญญาณเตือนภัยชุดที่ 6” 

ขอความที่ 37  
(Message no.37) 

Message from 
Alarm sensor No.7. 

“เรียกจากสัญญาณเตือนภัยชุดที่ 7” 

ขอความที่ 38  
(Message no.38) 

Message from 
Alarm sensor No.8. 

“เรียกจากสัญญาณเตือนภัยชุดที่ 8” 

ขอความที่ 41  
(Message no.41) 

Greeting after Voice 
info 

หลังจากฟงเสยีงจาก Voice info แลวจะมีเสียง “ 
กรุณากดหมายเลขภายในทีต่องการคะ ” 

 
Tips จะมีชองแนะนําการใชงานใหเลือก 2 เร่ือง คือ 
Factory ซ่ึงเปนคาจากโรงงาน ประโยคเสียงที่มีคามากกวา 60 จะเปนเสียงจากโรงงาน 
User เปนคาที่แนะนําใหใช เมื่อตองการแกไขเสียงตางๆ จะมีประโยคเสียงใหบันทึกได 60 

ประโยค คําแนะนํานี้จะแนะนําการนําไปใชงานของแตละประโยค ซ่ึงผูติดตั้งวางระบบอาจจะวาง
ระบบใหแตกตางจากนี้ก็ได 
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เมื่อคลิกปุม Factory จะไดเมนูใหมนี ้

 

ประโยค 61  เสียงพูดตอนรับ 
ประโยค 62   เสียงพูดสายไมวาง 
ประโยค 63    เสียงพูดไมมีผูรับสาย 
ประโยค 64    เสียงพูดวางสาย 
ประโยค 65    เสียงพูดเรียกสาย 
ประโยค 66 เสียงพูดใหกดหมายเลขใหม 
ประโยค 69         เสียงพูดมีขอความฝากไว 
ประโยค 70 ฝากขอความ 
ประโยค 71 เสียงตอบรับหลังจากเขาระบบใหขอมูลเสียง 
ประโยค 72 เสียงพูด ล็อกวงเงิน 
ประโยค 76 เสียงเตือนใชงาน ECS เมื่อเวลาเหลอื 10 นาท ี
ประโยค 81 เสียงพูดหมายเลขประจําเครื่อง 
ประโยค 82 เสียงพูดกําลังเรียกสาย 
ประโยค 91 เสียงพูดบอกวนั เวลาของระบบ 
ประโยค 92 เสียงพูดบอกเวลาตั้งปลุก 

เมื่อคลิกปุม User จะไดเมนูใหมนี ้
 

 

ประโยค 1 ขอความตอนยกห ู
ประโยค 2 ล็อกวงเงิน 
ประโยค 3 เตือนปลุก 
ประโยค 4 เตือน ระบบควบคุมไฟฟา 
ประโยค 9 มีขอความเสียง 
ประโยค 10 ระบบฝากขอความไมวาง 
ประโยค 11 OGM  ตอนรับ 
ประโยค 12 OGM  สายไมวาง 
ประโยค 13 OGM  ขณะใชสายอยู 
ประโยค 14 OGM  วางสาย 
ประโยค 15 OGM  สัญญาณเรียกกลับ 
ประโยค 16 OGM  เรียกซํ้า 
ประโยค 17 OGM  เปลี่ยนภาษาใชงาน 
ประโยค 18 OGM เสียงโฆษณา 
ประโยค 41 ขอความที่สงออกลาสุด 
ประโยค 42 ขอความทีไ่มไดรับ 
ประโยค 43 ขอความสัญญาณเรียกกลับ 
ประโยค 44 ขอความแจง ผดิพลาด 
ประโยค 45 ขอความสัญญาณเรียกกลับ 
ประโยค 46 ขอความแจงหามรบกวน 
ประโยค 47 ขอความฝากสาย 
ประโยค 48 ขอความแจงวนัเวลาตั้งปลกุ 
ประโยค 50 เสียงตอบรับหลังจากเขาระบบใหขอมูลเสียง 
ประโยค 51 ขอความสําหรับสัญญาณเตือนที่ 1 
ประโยค 52 ขอความสําหรับสัญญาณเตือนที่ 2 
ประโยค 53 ขอความสําหรับสัญญาณเตือนที่ 3 
ประโยค 54 ขอความสําหรับสัญญาณเตือนที่ 4 
ประโยค 55 ขอความสําหรับสัญญาณเตือนที่ 5 
ประโยค 56 ขอความสําหรับสัญญาณเตือนที่ 6 
ประโยค 57 ขอความสําหรับสัญญาณเตือนที่ 7 
ประโยค 58 ขอความสําหรับสัญญาณเตือนที่ 8 
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P033  ปองกันการบนัทึกเสียง (Record Protection) 
 

 
 

 สําหรับกําหนดคาในกรณีที่ผูใชตองการใชงานระบบปองกันการบันทึกเสียง  ใหกําหนดให
เปนคาตัวเลข 1–99 โดยคาดังกลาวหมายถึงการเริ่มปองกันที่ประโยคที่ 1 - 99 แตถาไมตองใชระบบ
การปองกันการบันทึกเสียงใหกําหนดเปนตัวเลข 0 แทน 
 
P036  กําหนดชองทางของ Voice Logger (Voice Logger Assignment) 
 ระบบจะบันทึกการสนทนาผานตูสาขาได โดยนําออกไปเก็บไวในระบบภายนอกตูฯ ผาน
ชองสัญญาณดิจิตอล ทําใหไดคุณภาพเสียงที่ดีของคูสนทนาทั้งสองดาน 
 

 
  

กําหนดชองทางของ Voice Log  จะมีรูปแบบใหเลือกกําหนดอยู 4 รูปแบบ  คือ  E1_1 ,  E1_2 
,  E1_3   และ E1_4  แตถาไมตองการชองทางของ Voice Log  ใหกําหนดเปน  Disable 
 
P037  กําหนดการใช Logger ของกลุมการโทรภายใน (Intercom Logger Enable) 
 กําหนดกลุมการใชสายในทีจ่ะถูกบันทกึเสียงเมื่อมีการโทรภายใน 
 
P038  กําหนดการใช Logger ของกลุมการโทรสายนอก (Trunk Call Logger Enable) 
 กําหนดกลุมการใชสายในทีจ่ะถูกบันทกึเสียงเมื่อมีการโทรเขา-โทรออกสายนอก 
 
P039  กําหนดการใช Logger ของกลุมการโทรเขาของสายนอก (Trunk to Trunk Logger Enable) 
 กําหนดกลุมการใชสายในทีจ่ะถูกบันทกึเสียงเมื่อมีการใชงานโทรสายนอกออกสายนอก 

 
 
 
 
 

Note ….การใชงาน Voice Logger นั้นอาจจะตองมวีงจร E1 ในสวนของระบบโทรศัพทดวย 
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10. โปรแกรม P0XX Link Number 
คลิกเลือก P0XX General Programming -> Link Number จะแสดง Page ดังรูป  

 
 
 
 

 

 เปนกลุมของโปรแกรมเพื่อทํางานเกี่ยวกับการนําระบบมาเชื่อมตอกัน เชน การติดตั้งใหกับ
หลายๆอาคาร แตละอาคารติดตั้งระบบอิสระจากกัน มีสายนอก มีเครื่องพิมพ แยกจากกัน แตมีความ
ตองการใหโทรสายในกันได 
 

P040  กําหนดหมายเลขของการเชือ่มตอ (Link Number Assignment) 
 การกําหนดหมายเลขที่จะเรยีกออกจากระบบตนเอง 
  

P041  กําหนดการเชือ่มตอ (Link Assignment) 

กําหนดรูปแบบการเชื่อมตอ IP กําหนดเลือกเสนทาง Link หลักแบบ  E1  
กําหนดเลือกเสนทาง Link สํารองแบบ IP Address 
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กําหนดรูปแบบในการเชื่อมตอ (Link) ตูสาขาโทรศัพท ตั้งแต 2 ตูขึ้นไป โดยรูปแบบการ
 เชื่อมตอนั้น แบงออกเปน Analog Link, E1 Link, IP Link ซ่ึงการเลือกการเชื่อมตอแตละรูป
 แบบนั้น ขึ้นอยูกับความเหมาะสมในการใชงานนั้นๆ 

 
กําหนดตามเงื่อนไขดังนี้  
a.b.c.d = 0.0.0.0 (Disable)  ปดการใชงาน 
= 0.0.c.d (none IP)   กําหนดการเชื่อมตอไมใช IP address  
= a.b.c.d (IP address)  กําหนดการเชื่อมตอใช  IP Adress  

c,d  = 1-40 (Hunting1-40)  กําหนดการเชื่อมตอใช Hunting ; 
 c = เสนทาง Link หลัก,  d; เสนทาง Link สํารอง 
= 80-88 (Trunk Access)   กําหนดการเชื่อมตอใช Trunk Access 
= 91-94 (E1ที่ 1-4)  กําหนดการเชื่อมตอใช E1 
 
จากตัวอยาง 
- กําหนดหมายเลข 2000-2099 เชื่อมตอแบบ IP Address ที่หมายเลข IP  192.168.1.91 
- กําหนดหมายเลข 2100-2199  เชื่อมตอกําหนดแบบ  Link หลัก  0.0.c.d  

0.0.91.201 -> กําหนดเสนทาง Link หลัก คือ E1 ที่ 1 และเสนทาง Link สํารอง คือ IP 
Table ที่ 201   (กําหนด Link ลําดับ 201 เปน IP Address 192.168.1.90 ) 

 
 
 
 
 
 

P042  กําหนดการเขารหัสในการเชือ่มตอ VoIP (Link VoIP Codec) 
 กําหนดการเขารหัสสัญญาณ (Codec) บนมาตรฐานเทคโนโลยี VoIP เพื่อกําหนดรหัส
สัญญาณที่ใชเชื่อมตอ (Link) ตูสาขาเขาดวยกัน      เมื่อกําหนด P041 เปนการเชื่อมตอแบบ IP Link 
แลวจะตองกําหนดให Codec ใน P042 ใหกับทุกตูสาขาฯที่ทําการเชื่อมตอดวยเปน Codec เดียวกัน 
กําหนดตามเงื่อนไข 
Link VOIP Codec  = 0 (Auto)  กําหนดใหเลือกการใชงานอตัโนมัติ 

= 1 (G.711)  กําหนดการใช Codec G.711 
= 2 (GSM)  กําหนดการใช Codec GSM 
= 3 (G.729)  กําหนดการใช Codec G.729 

Note….การกาํหนด Link หลัก และ Link สํารอง สามารถใช E1 เปน Link หลัก ไดอยางเดยีว  
สําหรับ Link สํารอง สามารถใชได 3 ประเภท ดังนี้  E1, IP และ Hunting   
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11. โปรแกรม P0XX SMDR. 
คลิกเลือก P0XX General Programming -> SMDR. จะแสดง Page ดังรูป  

 

 
  
P050  บันทึกขอมูลการโทรออกของกลุมสายนอก (CO. Group to Record for Outgoing Call) 
 ใหบันทกึขอมูลการโทรออกของกลุมสายนอก 
P051  บันทึกขอมูลการโทรออกของกลุมสายใน (Ext. Group to Record for Outgoing Call) 
 ใหบันทกึขอมูลการโทรออกของกลุมสายใน 
 
 เมื่อมีการใชขอมูลการโทรออกสายนอกของเครื่องโทรศัพทภายใน เพื่อคิดเงินสําหรับหอพัก
อพารตเมนต หรือเพื่อวิเคราะหการโทรออกหาลูกคาของพนักงานในบริษัท หรือเพื่ออ่ืนๆ ที่ตอง การ
เร่ิมเก็บขอมูลของตูโทรศัพทจะมีความสําคัญ เพราะถามีการเก็บเงิน ความถูกตองในการคิดคา
โทรศัพทเปนสิ่งสําคัญมาก ดังนั้นการวางระบบเริ่มเก็บขอมูลที่ถูกตองจึงตองกําหนดตั้งเริ่มติดตั้งการ
เริ่มเก็บขอมูลมีหลายวิธี เชน 

1. การตั้งเวลา (Timer) เปนการกําหนดชวงเวลาเริ่มบันทึกขอมูลเมื่อมีการยกหู หรือกด
หมายเลขสุดทายแลวกี่วินาที จึงจะบันทึกการใชโทรศัพท ในตูรุนนี้ตั้งคาที่ P109 
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2. การกลับขั้วไฟจากชุมสายฯ (Polarity Line Reversal) เปนการสลับสัญญาณของไฟฟา เปน
ตรงขามกัน เมื่อเครื่องปลายทางรับสายแลว บริการนี้จะตองขออนุญาตจากชุมสายฯ และ
เสียคาใชจายเมื่อติดตั้ง 

3. การสงสัญญาณคิดเงินจากชุมสายฯ (Pulse Metering) เมื่อโทรออกแลวปลายทางรับสาย 
ชุมสายฯสงสัญญาณพัลซมายังตนทางเพื่อคิดเงิน เนื่องจากสวนใหญชุมสายฯจะสํารองใช
กับตูสาธารณะหยอดเหรียญ ไมใหบริการสําหรับประชาชนทั่วไป ดังนั้น ตูสาขาโทรศัพท
โฟนนิค จะมีวงจรรับสัญญาณพัลซมิเตอริ่งเมื่อส่ังซื้อพิเศษ 

4. การวิเคราะหจากขั้นตอนการโทร (Call Progress Control) เปนการวิเคราะหการโทรออก
โดยตูสาขาฯ เลียนแบบลําดับการใชงานโดยการตรวจจับสัญญาณ Dial Tone, Ring Back 
Tone, Busy Tone หรือสัญญาณอื่นๆ เนื่องจากชุมสายฯของประเทศไทยใชตูของหลายยี่หอ 
การตรวจจับสัญญาณมีโอกาสผิดพลาดไดจึงไมมีในตูสาขาโทรศัพทโฟนนิค 

 
P052  บันทึกการโทรเขาของกลุมสายนอก (CO. Group to Record for Incoming Call) 
 ใหบันทกึการโทรเขาของกลุมสายนอก 
P053  บันทึกการโทรเขาของกลุมสายใน (Ext. Group to Record for Incoming Call) 
 ใหบันทกึการโทรเขาของกลุมสายใน 
P054  บันทึกขอมูลผูเรียกโทรภายใน (Intercom Caller to Record) 
 ใหบันทกึขอมูลผูเรียกโทรภายใน 
 
P055  บันทึกขอมูลผูถกูเรียกจากเคร่ืองภายใน (Intercom Caller to Record) 
 ใหบันทกึขอมูลผูถูกเรียกจากเครื่องภายใน 

เปนกลุมของโปรแกรมเพื่อใหบันทึกขอมูลการใชงานเก็บไวในระบบ การคิดเงินจะทํางาน
ไมได ถาไมมีการเก็บบันทึกการใชงาน 
 การกําหนดคา ของ P050-055 เพื่อตองการใหระบบบันทึกขอมูลการใชงานของแตละแบบ
นั้น จะใชเครื่องหมายขีดถูกลงในชองวางสี่เหล่ียมใหตรงกับเลขกลุมที่ตองสั่งใหมีการบันทึกขอมูล
การใชงานนั้น 
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P056  กําหนดใหบันทึกคําสั่งบริการ (Service Command to Record) 
 กําหนดใหบันทึกคําสั่งบริการตางๆ ที่ตองการ ขณะนี้ในระบบมีการบันทึกคําสั่งบริการตางๆ 
ดังนี้ 
 บันทึกคําสั่งการปลดล็อกการโทรออกของเครื่องภายใน 
 บันทึกคําสั่งการล็อกการโทรออกของเครื่องภายใน 
 บันทึกคําสั่งการยายสถานะของหองพักที่เครื่องตนเอง 

บันทึกคําสั่งการยายสถานะของหองพักจากเครื่องอื่น 
บันทึกการตั้งปลุก และการรับสายจากการปลุก 
รายงานที่เกดิขึ้นจากคําสั่งบริการ จะมีคําวา “SR” ในรายการที่พิมพออกมา 
 

P057  กําหนดวิธีการบันทึกขอมูล (Record Type)  
วิธีการบันทึกขอมูลของตูสาขาฯมีหลายวธีิ ไดแก 

  -  การบันทึกรายการที่เกิดขึ้นของทุกเครื่องที่มีการโอนสายไป เชน สําหรับสํานักงาน 
เมื่อเครื่องแรกโทรออก แลวโอนไปเครื่องที่สอง แลวเครื่องที่สองโอนตอใหเครื่องที่สาม ระบบจะเก็บ
บันทึก ทุกเครื่องที่ใช จากการโทรออกแลวโอนนั้น 
  - การบันทึกรายการที่เกิดขึ้นเฉพาะเครื่องแรกที่โทรออก เชน สําหรับในหองพักของ 
อพารทเมนต เมื่อโทรออก จะไมใหโอนสายไปเครื่องอื่นอีก หรือถาใหโอนสายได รายการการใช
โทรศัพทจะเกิดขึ้นที่ผูโทรออกคนแรกเทานั้น 
  - การบันทึกรายการที่เกิดขึ้นเฉพาะเครื่องสุดทายที่ใชจากการโทรออกนั้น เชน สําหรับ
โรงแรมขนาดเล็กไมใหในหองพักโทรออก จะโทรออกไดที่โอเปอเรเตอรเทานั้น เมื่อโอเปอเรเตอร
โทรออกสายนอกแลวโอนสายเขาไปในหองพัก (หองพักหามโอนสาย) รายการจะเกิดขึ้นเฉพาะเครื่อง
สุดทายที่ใชสายนอกนั้น 

การบันทึกจะใชวิธีการ click เลือกบนรูปแบบที่ตองการบันทึก   
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12. โปรแกรม P0XX Group Event 
คลิกเลือก P0XX General Programming -> Group Event จะแสดง Page ดังรูป  
 

 
 
 

P058  กําหนดการสงสถานะของเกลุมสายนอก 
P059  กําหนดการสงสถานะของกลุมเคร่ืองสายใน 

ระบบจะสงสถานะการทํางานของเครื่องโทรศัพทภายใน และ/หรือสายนอก ออกไปให
เครื่องคอมพิวเตอร เพื่อจะไดทราบสถานะการทํางานได 

กําหนดคาโดยการทําเครื่องหมายขีดถูกลงในชองของกลุมที่ตองการจะใหเครื่องโทรศัพทใน
กลุมนั้นแสดงสถานะการทํางาน   
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13. โปรแกรม P0XX Printing 
คลิกเลือก P0XX General Programming -> Printing จะแสดง Page ดงัรูป  
 

 
 

 
P060  กําหนดใหพิมพของกลุมสายนอก (Automatic Printer Port) 
 เปนการกําหนดพอรตการพิมพแบบอัตโนมัติ  มีใหเลือกอยู 4 รูปแบบ คือ SMDR , Event , 
Event_SMDR  แตถาไมตองใชงานการพิมพแบบอัตโนมัติใหเลือกเปน Disable แทน 
 การพิมพอัตโนมัตินั้นจะพิมพรายงานออกตลอดเวลาเมื่อระบบมีรายงานเกิดขึ้น 
 
P061  พอรตพิมพเม่ือไดรับคําสัง่ (Manual Print Port) 

การกําหนดพอรตที่ตองการใชในการพิมพแบบ Manual หรือเปนการพิมพเมื่อไดรับคําสั่ง จะ
มีพอรตใหเลือกทั้งที่เปนพอรต  RS-232A , RS-232B , USB , LAN  ทั้งนี้ผูใชจะตองทราบมากอนแลว
วาเครื่องพิมพที่ใชงานนั้นตออยูกับพอรตใด   
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P062  กําหนดใหพิมพของกลุมสายใน (CO. Group to Report)  
P063  พอรตพิมพอัตโนมัติ (Ext. Group to Report) 
 เปนการกําหนดคาโดยการทําเครื่องหมายขีดถูกลงในชองวางของกลุมสายนอกและกลุม
สายในที่ตองการสั่งใหพิมพขอมูลบันทึกการใชงาน   
 
P064  กําหนดความเร็วในการพิมพ (RS-232 Bit Rate) 

กําหนดความเร็วในการพิมพ ซ่ึงจะมีใหเลือกกําหนดหลายคาตั้งแต 1200 – 115k โดยมี
ลักษณะขอมูลเปน 8 data bit, Non Parity bit, 1 Stop bit 
 
P065  กําหนดภาษาที่ใชในการพิมพ (Billing Language) 

กําหนดภาษาที่ใชในการพิมพ  ซ่ึงจะมีใหเลือกกําหนด 3 รูปแบบภาษา  คือ  English, Thai 
TIS, และ English-2 
 
P066  กําหนดความยาวหนากระดาษของเครื่องพิมพ (Page Length) 

กําหนดความยาวของหนากระดาษของเครื่องพิมพ  สามารถกําหนดเปนตัวเลขตั้งแตเลข 0 ถึง
เลข 99  
 
P067  กําหนดจํานวนรายการตอหนากระดาษ (Line per Page) 

กําหนดจํานวนรายการตอหนากระดาษ  คา default นั้นจะเปนเลข  63  แตเราสามารถกําหนด
ตัวเลขตั้งแตเลข 0 ถึงเลข 99 ถากระดาษนั้นมีความยาวเพียงพอ 
 
P068  กําหนดขอบดานบน (Top Margin) 

กําหนดขอบดานบน  เราสามารถกําหนดตัวเลขตั้งแตเลข 0 ถึงเลข 99 
 

P069  กําหนดระยะหางของการพมิพแตละชุด (Separate Margin) 
กําหนดระยะหางของการพิมพแตละชุด  คา default นั้นจะเปนเลข 99 แตเราสามารถกําหนด

ตัวเลขตั้งแตเลข 0 ถึงเลข 99 
 

โดยทั่วไปคา P066, P067, P068, P069 จะใชคาจากโรงงาน ยกเวนเมื่อตองการใชขนาด
กระดาษนอกเหนือจากที่กําหนดนี้ 
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วิธีการตอสายสัญญาณ Serial 
 
 
 
 
         
 
     

รูปที่ 1 ตัวอยางสายสัญญาณ จากตูสาขาไปยังเครื่องคอมพิวเตอร 9 ขา    
 
 
 
 
 

 
 
 
 

รูปที่ 2 ตัวอยางสายสัญญาณ จากตูสาขาไปยังเครื่องคอมพิวเตอร 25 ขา    
 
 
 
 
 
 
 

 
 
รูปที่ 3 ตัวอยางสายสัญญาณ จากตูสาขาไปยังเครื่องพิมพ Printer ( DB25 ) 

 
 
 

ตอกับ 
Computer 
( DB9 )  
ตัวเมีย 

ตอกับ  
Printer 

( DB25 )  
ตัวผู 

ตอกับแผง  
JSD-CPU 

(RJ11) 
6 PIN 

ตอกับแผง  
JSD-CPU 

(RJ11) 
6 PIN 

ตอกับ  
Computer 
( DB25 )  
ตัวผู 

ตอกับ 
แผง JSD-CPU 

(RJ11) 
6 PIN 
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วิธีการตอสายสัญญาณ Serial (ตอ) 
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14. โปรแกรม P0XX IP Network 
คลิกเลือก P0XX General Programming -> IP Address จะแสดง Page ดังรูป  
 

 
 

P0XX   IP Network  ใชกําหนดตัวเลข  IP ADDRESS , SUBNET MASK  , GATEWAY, 
และ DNS(Domain Name Server)  ของตูสาขาฯ  ใหสัมพันธกับตัวเลขตางๆ เหลานั้นที่ถูกกําหนด
ใหกับเครื่องคอมพิวเตอรที่ใชเชื่อมตอระบบ  วิธีการกําหนดนั้นเพียงแคนําตัวเลขดังที่ไดกลาวมาของ
เครื่องคอมพิวเตอรที่ตองการใชเชื่อมตอกับระบบ  มากําหนดใหตรงกับตัวเลขที่ถูกกําหนดไวใน
ตูสาขาฯ ซ่ึงหลักเกณฑของการกําหนดตัวเลขเบื้องตนสามารถดูไดจากตารางตัวอยางขางตน   
P070  กําหนดตัวเลขของ  IP Address (IP Address Assignment) 
P071  กําหนดตัวเลขของ  SUBNET MASK (SUBNET MASK Assignment) 
P072  กําหนดตัวเลขของ  GATEWAY (GATEWAY Assignment) 
P084 กําหนดตัวเลขของ  IP Address (IP Address (IPX)) 
P085 กําหนดตัวเลขของ Subnet Mask (Subnet Mask (IPX)) 
P086 กําหนดตัวเลขของ Gateway (Gateway  (IPX)) 
P087 กําหนดตัวเลขของ DNS Server (DNS Server (IPX)) 
 
 
 
 

Note…. การกําหนด IP Address  ของ P070 (CPU card) และ IP Address  ของ IPX card ตอง
กําหนดใหไมตรงกับ IP ของอุปกรณตัวอ่ืนในระบบเน็ตเวิค  
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15. โปรแกรม P0XX SIP Extension 
 คลิกเลือก P0XX General Programming -> SIP Extension จะแสดง Page ดังรูป 
 

 
 

P080 หมายเลข SIP Phone  (SIP-PHONE Number) 
P081 รหัสผาน  (SIP-PHONE Password) 
P082 กลุมสายใน  (SIP Extension Group)  
 กําหนดหมายเลขโทรศัพท (SIP Number) รหัสผาน (SIP Password) ที่ตูสาขาเรียกใชใหตรง 
กับคา UserName และ Password ที่ตั้งในเครื่อง IP PHONE 
P083 กําหนดการเขารหัสในการใชงาน SIP Number (SIP  Codec) 
 เปนการกําหนดรหัสสัญญาณ เพื่อใชติดตอกับ SIP PHONE ภายในระบบ 
กําหนดตามเงื่อนไข 

SIP Codec = 0 (Auto)  กําหนดใหเลือกการใชงานอตัโนมัติ 
= 1 (G.711)  กําหนดการใช Codec G.711 
= 2 (GSM)  กําหนดการใช Codec GSM 
= 3 (G.729)  กําหนดการใช Codec G.729 
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16. โปรแกรม P0XX Account Code    
คลิกเลือก P0XX General Programming -> Account Code  

  แสดง Page ดงัรูป  
 

 
 

P095  กําหนดรหัสประจําตัวการโทรออก (Account Code Assignment) 
P096  กําหนดหมายเลขประจําตัวของการโทรออก (Account Number Assignment) 
P097  กําหนดกลุมของรหัสประจําตัวของการโทรออก (Account Group Assignment) 
 เปนการกําหนดผูที่สามารถใชรหัสประจําตัวในการโทรออกแบบเจาะจงผูโทร คําสั่งการใช
งาน ** (P001_803_**) ตามดวยรหัสประจําตัว และเครื่องหมายสี่เหล่ียม (#) โดยการใชรหัสที่มีนี้
โทรออก แตรายงานการคิดเงินที่เกิดขึ้นจะเปนหมายเลขประจําตัวนี้ 
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บทที่ 3 
 

โปรแกรมเกี่ยวกับสายนอก P1XX Trunk Programming 
 

เปนการจัดกลุมและโปรแกรมเกี่ยวกับสายนอก หรือที่เรียกวา ซี โอ ไลน (CO. Line) 
โปรแกรมคอนฟกบิว้เดอรนี้ไดแบงการโปรแกรมเกีย่วกับสายนอกไวเปน 6 กลุม คือ 

1. P1XX CO.  Line 
2. P1XX CO.  Group 
3. P1XX Class of Trunk 
4. P1XX CO.  Direct 
5. P1XX Auto Rout 
6. P1XX SIP Account 
7. P1XX E1 Setting 
 

CO. Line Assignment 
1. P100   โปรแกรม P1XX CO. Line 

คลิกเลือก P1XX Trunk Programming -> CO. Line จะแสดง Page ดังรูป 
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ในการใชงานเราตองกําหนดวาลําดับที่ของสายนอกที่ติดตั้งใชงานจริงมีสายไหนบางโดยสาย
นอกทั้งระบบสามารถติดตั้งได 128 สายนอก ในการติดตั้งจะตองนับพอรตซึ่งเปนลําดับทางฮารดแวร
ใหถูกตอง ขึ้นอยูกับรุนของตู ดังนี้ 

 

ชองเสียบ 
แผงวงจร 

การนับพอรตสายในของตู 
JSD-64 JSD-128 Diamond Platinum (256P) Platinum (512P) 

ชองที่ 1 พอรตที่ 1-16 พอรตที่ 1-16 พอรตที่ 1-16 พอรตที่ 1-16 พอรตที่ 257-272 
ชองที่ 2 พอรตที่ 17-32 พอรตที่ 17-32 พอรตที่ 17-32 พอรตที่ 17-32 พอรตที่ 273-288 
ชองที่ 3 พอรตที่ 33-48 พอรตที่ 33-48 พอรตที่ 33-48 พอรตที่ 33-48 พอรตที่ 289-304 
ชองที่ 4 พอรตที่ 49-64 พอรตที่ 49-64 พอรตที่ 49-64 พอรตที่ 49-64 พอรตที่ 305-320 
ชองที่ 5 พอรตที่ 65-80 พอรตที่ 65-80 พอรตที่ 65-80 พอรตที่ 65-80 พอรตที่ 321-336 
ชองที่ 6 - พอรตที่ 81-96 พอรตที่ 81-96 พอรตที่ 81-96 พอรตที่ 337-352 
ชองที่ 7 - พอรตที่ 87-112 พอรตที่ 87-112 พอรตที่ 87-112 พอรตที่ 353-368 
ชองที่ 8 - พอรตที่ 113-128 พอรตที่ 113-128 พอรตที่ 113-128 พอรตที่ 369-384 
ชองที่ 9 - พอรตที่ 128-144 พอรตที่ 128-144 พอรตที่ 128-144 พอรตที่ 385-400 
ชองที่ 10 - - พอรตที่ 145-160 พอรตที่ 145-160 พอรตที่ 401-416 
ชองที่ 11 - - พอรตที่ 161-176 พอรตที่ 161-176 พอรตที่ 417-432 
ชองที่ 12 - - พอรตที่ 177-192 พอรตที่ 177-192 พอรตที่ 433-448 
ชองที่ 13 - - พอรตที่ 193-208 พอรตที่ 193-208 พอรตที่ 449-464 
ชองที่ 14 - - พอรตที่ 209-224 พอรตที่ 209-224 พอรตที่ 465-480 
ชองที่ 15 - - พอรตที่ 225-240 พอรตที่ 225-240 พอรตที่ 481-496 
ชองที่ 16 - - พอรตที่ 241-256 พอรตที่ 241-256 พอรตที่ 497-512 

 
จะเห็นวาลําดบัพอรตของสายนอกก็คือลําดับพอรตของสายในที่เสียบในชองนั้นๆ 
ถามีการใชสายนอกแบบดิจติอล E1 จะมีลําดับดังนี ้
ตู JSD-Series 
 E1 ที่ 1 ลําดับพอรตที่ 161-192 เปนอุปกรณเสริมบนแผง JSD-CPU/PRI 
ตู Diamond 
 E1 ที่ 1 ลําดับพอรตที่ 257-288 เปนอุปกรณเสริมบนแผง DX-LPU/1PRI 
 E1 ที่ 2 ลําดับพอรตที่ 289-320 เปนอุปกรณเสริมบนแผง DX-LPU/2PRI 
 E1 ที่ 3 ลําดับพอรตที่ 321-352 เปนอุปกรณเสริมบนแผง DX-AUX/1PRI 
 E1 ที่ 4 ลําดับพอรตที่ 353-384 เปนอุปกรณเสริมบนแผง DX-AUX/2PRI 
ตู Platinum 
 E1 ที่ 1 ลําดับพอรตที่ 513-544 เปนอุปกรณเสริมบนแผง DX-LPU/1PRI 
 E1 ที่ 2 ลําดับพอรตที่ 545-576 เปนอุปกรณเสริมบนแผง DX-LPU/2PRI 
 E1 ที่ 3 ลําดับพอรตที่ 577-608 เปนอุปกรณเสริมบนแผง DX-AUX/1PRI 
 E1 ที่ 4 ลําดับพอรตที่ 609-640 เปนอุปกรณเสริมบนแผง DX-AUX/2PRI 
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P101  กําหนดกลุมสายนอก (Group of CO. Line)  
เนื่องจากสายนอกอาจจะมีจํานวนมากหรือมีการใชงานที่แตกตางกัน เราจึงตองแบงกลุมสาย

นอกตามการใชงาน  ในระบบสามารถแบงกลุมได 1- 32 กลุม  
P131  กําหนดชื่อของสายนอก (CO. Line Name)   

 กําหนดชื่อแตละ CO. Line สามารถใชไดทั้งภาษาไทยและภาษาอังกฤษ สามารถกําหนดได
สูงสุด 16 ตัวอักษร 

การดับเบิ้ลคล๊ิกที่หัวตารางของ P100, P101 และ P131 จะมีหนาตาง pop up เพื่อยืนยันที่
ตองการใชคาที่กําหนดจากโรงงาน (Default)  

การคลิก หรือดับเบิ้ลคลิกในเพจของขอมูลที่ตองการแกไข จะสามารถปอนขอมูลไดโดยตรง 
แตจะตองเปนไปตามรูปแบบที่กําหนด เชน P101 คาในเพจจะเปนตัวเลข 1-32 คาใดคาหนึ่งเทานั้น 
เปนตน ดังนั้นผูใชจะตองเขาใจรูปแบบที่ถูกตองจึงจะปอนขอมูลได 

 
จากหนาจอโปรแกรมคอนฟกบิ้วเดอร 
 

          
 

 
P102  กําหนดกลุมสายนอกโทรออกแบบ DTMF (Dial DTMF Mode)  
 โดยการดับเบิ้ลคลิก เพื่อกําหนดกลุม แสดงหนาตาง Array ซ่ึงโดยทั่วไปชุมสายโทรศัพทใช
การติดตอแบบ DTMF ดังนั้นคาจากโรงงานกําหนดใหทุกกลุมเปน DTMF Mode  
 

หมายเลขกลุมสายนอก  

หมายเลขของพอรตของแผงวงจรสายนอก 

ช่ือของสายนอก 

ลําดับสายนอก 

ดับเบิ้ลคลิก เพื่อเรียก Default  
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P103  กําหนดอัตราสวน Break/Make (Dial Pulse Type) 
 เปนอัตราสวนของลูกคลื่นที่สงออกไปสําหรับการโทรออกแบบหมุนจะกําหนดตาม

ชุมสายโทรศัพท  โดยทั่วไปใชคา PPS10BM21(รูปที่ 3) 
 
 
 
 
 
 
 
P104  กําหนดการโทรออกเจาะจงกลุมสายนอกระดับ 1 (Trunk Access-1) 
 เปนการกําหนดการโทรออกโดยการเจาะจงกลุมสายนอก   เมื่อใชคาฟงกช่ันมาตรฐานจาก
โรงงาน จะเปนการกด *81-*88 ซ่ึงถูกกําหนดที่โปรแกรม P001_[881-888]  
  
P105  กําหนดการโทรออกเจาะจงกลุมสายนอกระดับ 2 (Trunk Access-2)  
 เมื่อโทรออกแบบเจาะจงกลุมสายนอกจาก P104 แลว สายไมวางหรือสายเต็ม ระบบโทรศัพท
จะใชระดับที่ 2 นี้เปนเสนทางสํารองถาใน P104 การโทรออกเจาะจงกลุมสายนอก ระดับที่ 1 ที่มีสาย
นอกเปน E1 เมื่อไมมีสัญญาณจาก E1 ระบบสามารถเลือกใชจากระดับที่ 2 เพื่อเปนเสนทางสํารองได 
 คาจากโรงงานในการโทรออกแบบเจาะจงสายนอก 
 

ฟงกชัน่  คําสั่งการใชงาน กลุมสายนอก ท่ีถูก
เรียก ระดับท่ี 1 

กลุมสายนอก ท่ีถูก
เรียก ระดับท่ี 2 

P001_881 *81 สายนอกกลุมที่ 1 - 

P001_882 *82 สายนอกกลุมที่ 2 - 

P001_883 *83 สายนอกกลุมที่ 3 - 

P001_884 *84 สายนอกกลุมที่ 4 - 

P001_885 *85 สายนอกกลุมที่ 5 - 

P001_886 *86 สายนอกกลุมที่ 6 - 

P001_887 *87 สายนอกกลุมที่ 7 - 

P001_888 *88 สายนอกกลุมที่ 8 - 

 ความหมาย: ตองการโทรออกสายนอกแบบเจาะจงกลุมสายนอก เมื่อยกหูโทรศัพท แลวกด 
*81 จะไดสายนอกในกลุมที่ 1 ที่ถูกกําหนดไวใน P101 เมื่อสายนอกกลุมนั้นวาง จะไดยินเสียงไดโทน
จากสายนอก 

คลิกเพื่อกําหนดกลุมใช DTMF Mode 

เลือกอัตราสวน B:M ในการโทรออกแบบหมุน 
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P106  กําหนดการแฟลชสายนอก (Trunk Flash)  

 เปนการกําหนดใหสายนอกสามารถพักสายไดโดยการสงสัญญาณ “Flash” ใหกับสายนอกที่
เปน Host PBX ที่สายในทํางานพักสายโอนสายแบบแฟลช 

ตามคําสั่งใชงาน #5 ของระบบโทรศัพท เมื่อสายในสนทนาผานสายในของ Host PBX 
สามารถโอนสายไปใหเครื่องภายในอื่นของ Host PBX ได 

ดับเบิ้ลคลิกที่ชองขอมูลของ P106 มีหนาตาง Array เพื่อกําหนดกลุมสายนอกที่สงสัญญาณ
แฟลช 
 
 P107  กําหนดการโชวเบอรสายนอก (Incoming CID)  

การกําหนดใหสายนอกสามารถรับสัญญาณโชวเบอรจากชุมสายโทรศัพทแบบเอฟเอสเค 
(FSK. Frequency Shift Keying) ถาชุมสายโทรศัพทไมมีสัญญาณโชวเบอรใหปดการรับสัญญาณ 
เนื่องจาก การรับสัญญาณโชวเบอร ระบบโทรศัพทจะคอยจนมั่นใจวาไมมีสัญญาณโชวเบอรมาแลว
จึงจะรับสาย ดังนั้นผูใชที่โทรเขาจะรูสึกวาระบบรับสายชากวาปกติ 

ดับเบิ้ลคลิกในชองขอมูล P107 มี Array เพื่อกําหนดกลุมสายนอกที่คอยรับสัญญาณโชวเบอร 

ดับเบิ้ลคลิกเพือ่เลือก Default 

ดับเบิ้ลคลิกเพือ่เรียก Array ชวย ดับเบิ้ลคลิกเพือ่เรียก Array ชวย 

คลิกเครื่องหมายถูก เพื่อ 
เลือกกลุมสายนอกที่ตองการ 

คลิกปุม OK เพื่อยืนยันคําสัง่  
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P118  กําหนดกระดิ่งเรียก กอนใชเสียงตอบรับอัตโนมัติ (OGM. Answer time setting) 
เปนการกําหนดระยะเวลากระดิ่งเรียกกอนจะมีเสียงตอบรับและโอนสายอัตโนมัติ ตามการ

ทํางานของการโปรแกรมที่ P110 และ P111 
 

จากหนาจอโปรแกรมคอนฟกบิ้วเดอร 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

คลิกเลือก เพื่อ 
กําหนดกลุมทีต่องการ  

คลิกปุม OK เพื่อยืนยันคําสัง่  

ดับเบิ้ลคลิกเพือ่เรียก Array ชวย 
ดับเบิ้ลคลิกเพือ่ 
     เรียก Array ชวย 

จํานวนครั้ง 
ของกระดิ่ง 
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2. โปรแกรม P1XX CO. Group 
คลิกเลือก P1XX Trunk Programming -> CO. Group แสดง Page ดังรูป 

 
 

P108  พิมพเคร่ืองหมายนําหนาหมายเลขโทรออก (Trunk Printing Prefix) 
  สําหรับสงรายงานการใชโทรศัพทใหคอมพิวเตอร เพื่อใหทราบวา การโทรออกสายนอกที่
แตกตางกัน สามารถคิดเงินตางกันได โดยอาศัยเครื่องหมายนําหนานี้ เชน เมื่อติดตั้งระบบมือถือ 
DTAC เขาระบบโทรศัพท ทําใหตองการคิดคาใชโทรศัพทแบบเหมาจายนาทีละ 2 บาท ดังนั้น ระบบ
จะสงเครื่องหมาย #5 (หรืออ่ืนๆที่ตองการ) นําหนาหมายเลขที่โทรออกใหกับคอมพิวเตอรภายนอกทํา
ใหเครื่องคอมพิวเตอรรูวา เมื่อใชสายนอกนั้น จะมีเครื่องหมายนําหนามาใหคิดเงินแบบเหมาจายตามที่
ตองการ 

การดับเบิ้ลคล๊ิกที่หัวตารางของ P จะมีหนาตาง Array เพื่อยืนยนัที่ตองการใชคาที่กําหนดจาก
โรงงาน (Default) ซ่ึงจะไมมีการสงหมายเลขนําหนาหมายเลขโทรออก 

 

P109  กําหนดชวงเวลาเริ่มการบันทึกขอมูลการใชโทรศัพท (Duration Time to Start Recording) 
 เมื่อมีการใชงานสายนอกที่ไมมีไลนรีเวิรส และตองการบันทึกการใชเพื่อคิดเงิน ระบบ
โทรศัพทจะใชชวงเวลาเริ่มการบันทึกขอมูลนี้ในการเก็บบันทึกขอมูล  โดยจะเริ่มบันทึกตั้งแตกดปุม
หมายเลขโทรออกเลขสุดทายไปอกีตามชวงเวลานี้ สวนรายงานการใชโทรศัพทจะรวมสวนนี้ดวย  

การกําหนดชวงเวลาการบันทึกแยกตามกลุมสายนอกได 
การคิดเงินจากผูใชโทรศัพทนั้น ชุมสายโทรศัพทสามารถสงสัญญาณสลับขั้วไฟในสาย (Line 

Reversal) ไปยังอุปกรณปลายทางได เมื่อผูใชกดหมายเลขปลายทางที่ถูกตอง กระดิ่งจะไปดัง
ปลายทาง เมื่อเครื่องโทรศัพทปลายทางรับสาย สัญญาณไฟในสายของเครื่องผูใชตนทางจะสลับขั้ว
เปนสัญญาณใหอุปกรณตนทางรูวาชุมสายฯเริ่มคิดเงินแลว 

ถามี Line Reverse มากอนชวงเวลานี้ จะใชเวลาที่ไดจาก Line Reverse มาเปนจุดเริ่มแทน 
 การคลิ้กที่ขอมูลจะทําการแกไขขอมูลไดโดยตรง 



 

 

    D - 9 

P110  ลักษณะการโทรเขาของกลุมสายนอก (กลางวัน Incoming Mode Day)  
P111  ลักษณะการโทรเขาของกลุมสายนอก (กลางคืน Incoming Mode Night) 
 เปนการกําหนดการตอบรับการทํางานของสัญญาณกระดิ่ง ที่มาจากชมุสายโทรศัพท   

การโปรแกรมP110 และ P111 ลักษณะการโทรเขาของกลุมสายนอกกลางวันและกลางคืน 
สามารถกําหนดรูปแบบการรับสายไดดังนี้ 

Ring -> เมื่อสายนอกไดรับสัญญาณกระดิ่งเขาจะสงสัญญาณเรียกกระดิ่งดังไปยังเครื่อง
ภายในตามที่ไดกําหนดไวใน P112, P113 

DISA-> เมื่อระบบรับสายโทรเขาจะสง Dial tone ใหผูโทรเขาสามารถกดหมายเลขภายใน
ตอไป 

OGM แบบที่ 1-> ระบบจะมีเสียงพูดตอบรับอัติโนมัติได และสามารถกดหมายเลขภายใน 
เพื่อโอนสายอัตโนมัติได และสามารถกดเปลี่ยนหมายเลขภายในไดเมื่อปลายทางไมวางหรือไมมีผู
รับสาย เมื่อปลายทางไมมีผูรับสายนานระบบจะตัดสายนอก 

OGM แบบที่ 2-> ทํางานเหมือน OGM แบบที่ 1 แตจะโอนสายให Service Port (P112,P113) 
เมื่อปลายทางไมมีผูรับสาย 

OGM. D -> หนวงเวลากอนรับสาย ใหหนวงเวลาการรับกระดิ่งกอนที่ระบบจะรับสาย เชน 
ในกรณีตอจาก ISDN ชนิด BAI ผานกลอง TA บางรุน กระดิ่งจะมาพรอมกันทั้ง 2 CO. ดังนั้นจะตอง
โปรแกรมใหระบบรับสายเพียงสายเดียวกอน 

Ring-OGM. -> ใหมีกระดิ่งกอนรับสายระบบ คือเมื่อระบบไดรับสัญญาณกระดิ่งจากสาย
นอก จะสงตอไปใหเครื่องโทรศัพทภายใน เมื่อเครื่องโทรศัพทภายในไมรับสาย ตามระยะเวลาที่
กําหนด ใน P118 ระบบจึงจะรับสายอัตโนมัติ  

V_Info  -> เมื่อสายนอกไดรับสัญญาณกระดิ่งเขาจะตอบรับดวยเสียงพูดตอบรับจากระบบ 
Voice Information จากแผงวงจร EVM. 

 
P112  กําหนดหมายเลขผูใชบริการกลางวัน (User Service Number Day) 
P113  กําหนดหมายเลขผูใชบริการกลางคืน (User Service Number Night) 
 เปนการกําหนดหมายเลขของเครื่องภายในที่จะรองรับการทํางานของ P110/P111 ขึ้นอยูกับ
การทํางานกลางวัน/กลางคืน ดังนี ้

ถากําหนด P110/P111 ใหกลุมสายนอกรับสายเปนแบบ Ring เมื่อมีการโทรเขาจากสายนอก 
ระบบโทรศัพทจะสงสัญญาณกระดิ่งไปหมายเลขภายในนี้ 

ถากําหนด P110/P111 ใหกลุมสายนอกรับสายเปนแบบ DISA. เมื่อผูโทรเขาจากสายนอกได
ยินสัญญาณ DISA. แลวไมกดหมายเลขภายในที่ตองการ ระบบโทรศัพทจะเรียกไปยงัหมายเลข
ภายในนี ้
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ถากําหนด P110/P111 ใหกลุมสายนอกรับสายเปนแบบ OGM.-1 เมื่อผูโทรเขาจากสายนอก
ไดยินเสียงพูดตอบรับอัตโนมัติ แลวไมมีการกดตอหมายเลขภายใน (เครื่องโทรศัพทตนทางอาจจะกด
ปุมสงสัญญาณ DTMF. ไมได) ระบบโทรศัพท จะเรียกไปยังหมายเลขภายในนี้ 

ถากําหนด P110/P111 ใหกลุมสายนอกรับสายเปนแบบ OGM.-2 จะทํางานเหมือน OGM.-1 
แตจะเพิ่มการทํางาน เมื่อสามารถกดไปหมายเลขภายในที่ตองการแลวไมมีผูรับสาย ระบบโทรศัพท 
จะเรียกไปยังหมายเลขภายในนี้ดวย 

ถากําหนด P110/P111 ใหกลุมสายนอกรับสายเปนแบบ OGM.D จะทํางานเหมือน OGM.-1 
ถากําหนด P110/P111 ใหกลุมสายนอกรับสายเปนแบบ Ring-OGM. ในชวงตนจะทํางาน

เหมือน Ring คือมีสัญญาณกระดิ่งไปยังหมายเลขนี้ เมื่อไดยินเสียงพูดตอบรับอัตโนมัติจะทํางาน
เหมือน OGM.-1 

ถากําหนด P110/P111 ใหกลุมสายนอกรับสายเปนแบบ V_Info ระบบจะเรียกเขาแผงวงจร 
EVM. จะไมใช P112/P113 โดยจะทํางานอิสระจากระบบ 
 
P114  กําหนดเครื่องแฟกซอัตโนมตัิ (กลางวัน Fax Service Number Day) 
P115 กําหนดเครื่องแฟกซอัตโนมตัิ (กลางคืน Fax Service Number Night) 

เมื่อกําหนดใหการรับสายการโอนเขาจากสายนอกเปน DISA. หรือ OGM. ระบบจะตรวจจับ
สัญญาณแฟกซจากตนทางอัตโนมัติ เมื่อไดแลวจะโอนไปหมายเลขภายใน ที่ไดกําหนดไวใน
โปรแกรมนี้ 
 
 

 
 
 
 
 
 
 

หมายเลขภายในที่
ตอกับเครื่องแฟกซ 

หมายเลขภายในที่ 
ใหบริการ 

ระยะเวลาเริ่มบันทึก 
การใชโทรศัพท 

เครื่องหมายทีต่องการ 
สงออกหนาหมายเลข 
ที่โทรออก 

    เลือกคาที่ตองการกําหนดลักษณะการโทรเขา 
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3.   โปรแกรม P1XX Class of Trunk 
คลิกเลือก P1XX Trunk Programming -> Class of Trunk แสดง Page ดังรูป  
 

 
 
P116  ระดับการโทรออกของสายนอก กลางวัน (Class of Trunk Day) 
P117  ระดับการโทรออกขอกลุมสายนอก กลางคนื (Class of Trunk Night) 
 เปนการกําหนดระดับความสามารถในการโทรออกของสายนอก โดยทั่วไปจะกําหนดที่กลุม
สายในที่ P226/P227 แตในบางครั้งอาจจะมีความตองการตั้งระดับการโทรออกของสายนอกดวย ซ่ึง
วิธีการจะเหมือนกับการตั้งในกลุมสายใน คือ 
 หมายเลข 1-20 ถูกกําหนดการล็อกการโทรที่ P006/P007 
 หมายเลข 21-31 เปนคาที่ถูกกําดหนดจากโรงงาน ซ่ึงเปนคาที่เหมาะกับการใชงานใน
กรุงเทพฯ 
 หากมีการตั้งระดับการโทรออกทั้งสายในและสายนอก ระบบจะตรวจทั้งของสายในและสาย
นอกวาความสามารถของระดับการโทรออกที่มีอยูนั้น ผูใชจะโทรออกไปยังหมายเลขที่โทรไดหรือไม 
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ความหมายของตัวเลขท่ีทานสามารถตัง้คาไดเพื่อเปนระดับการโทรออกมีดังนีค้ือ   

ระดับ 
การโทรออก 

ความหมาย 

1-20 จะตองตั้งคาทีต่องการที่ P006, P007 
21 สามารถโทรออกไดทั้งหมด 
22 สามารถโทรออกหมายเลขที่ขึ้นตนดวย  0 , 1 , 2 , 3 , 4 , 5 , 6 , 7 , 8 , 9 

(ใชโทรออกตางประเทศได) 
23 หามโทรออกหมายเลขที่ขึ้นตนดวย  00 , 100 , * , # 

(หาม 00=โทรตางประเทศ, หาม 100=โทรตางประเทศผานพนักงาน) 
24 หามโทรออกหมายเลขที่ขึ้นตนดวย  00 , 100 , 1113 , 1900 ,* , # 

(โทรภายในประเทศได แตโทร 1133 และ 1900 ไมได) 
25 หามโทรออกหมายเลขที่ขึ้นตนดวย  0 , * , # , 100 , 101 , 1113 , 1900 - 02 , 08 

(ใชโทรพื้นที่กรุงเทพฯ, มือถือ, และ 1xxx ไดบางสวน) 
26 หามโทรออกหมายเลขที่ขึ้นตนดวย  0 , * , # , 100 , 101 , 1113 , 1900 , 1234- 02 

(ใชโทรพื้นที่กรุงเทพฯ, และ 1xxx ไดบางสวน) 
27 หามโทรออกหมายเลขที่ขึ้นตนดวย  0 , * , # 
28 สามารถโทรออก หมายเลขที่ขึ้นตนดวย  1133 , 1177 , 191 , 199 , 108 
29 สามารถโทรออก หมายเลขที่ขึ้นตนดวย  1133 , 1177 , 191 , 199 
30 หามโทรออก 
31 ใหโทรออกจากหมายเลขยอ 

 
คาจากโรงงาน กําหนดโทรออกสายนอกอยูในระดับโทรออกไดทั้งหมด 
 ***  - การโทรออกดวย 00 เปนการโทรออกตางประเทศ 
 - การโทรออกดวย 100 เปนการโทรไปโอเปอเรเตอร เพือ่ขอโทรออกตางประเทศ  

- 0 การโทรออกภายในประเทศ 
- 08 การโทรออกไปยังหมายเลขของโทรศัพทมือถือ 
- 1113 สอบถามหมายเลข BUG 
- 1177 แจงซอม 
- 1900 ออดิโอ เท็กซ 
- 191โทรหาตาํรวจ 
- 199 โทรหาดบัเพลิง 
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P119  เลือกภาษา OGM ของกลุมสายนอก  
 โดยแตละกลุมสายนอก (CO. Line) กําหนดใหภาษาที่รับสายตางกันได (แสดงการโปรแกรม
ดังรูปที่ 11 โดยคาจากโรงงานกําหนดใหเปนภาษาไทย 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
P120  ตั้งเวลาการใชสายนอกเมื่อโทรออก กลางวัน (Trunk Outgoing Limit Day) 
P121  ตั้งเวลาการใชสายนอกเมื่อโทรออก กลางคืน (Trunk Outgoing Limit Night) 
P122  ตั้งเวลาการใชสายนอกจากการโทรเขา กลางวัน (Trunk Incoming Limit Day) 
P123  ตั้งเวลาการใชสายนอกจากการโทรเขา กลางคืน (Trunk Incoming Limit Day) 
 เนื่องจากในบางครั้งระบบโทรศัพทจะมีสัดสวนของสายนอกนอยกวาสายใน ดังนั้นในบาง
ชวงเวลา เมื่อมีผูใชสายนอกจนเต็ม ทําใหเครื่องภายในอื่นไมสามารถใชงานติดตอภายนอกได จึงมี
การตั้งเวลาจํากัดระยะเวลาการใชโทรศัพทที่แตกตางกันในชวงกลางวันกับกลางคืน 
 การแยกการตั้งเวลาจํากัดระยะเวลาการใชโทรศัพทที่แตกตางกันจากการโทรเขาและโทรออก 
เนื่องจากบางครั้งในการโทรออกอาจจะตองการใชงานอินเตอรเน็ตผานทางโมเด็ม ซ่ึงตองการใชเวลา
การติดตออินเตอรเน็ตมากกวาการโทรเขา 

การตั้งเวลาการใชกลุมสายนอกของกลุมเครื่องภายใน นอกจากกลุมการโปรแกรมสายนอก 
P120/P121, P122/P123 แลวยังสามารถกําหนดไดจากกลุมการโปรแกรมสายใน P220/P221, 
P222/P223 
 

ระดับการใหบริการของกลุมสานอก 

    กําหนดเลือกภาษา OGM ของกลุมสายนอก 
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P124  กําหนดโทรกลุมสายนอกกับกลุมสายนอก (Trunk to Trunk Assignment) 
 เปนการกําหนดใหกลุมสายนอกนั้นสามารถใชงานการโทรออกจากสายนอกอืน่ 
 
P125  ใชการคิดเงินแบบ พัลซ มิเตอรริ่ง (Pulse Metering Assignment)  

การคิดเงินการใชโทรศัพทของชุมสายโทรศัพทสามารถสงสัญญาณพัลซไปคิดเงินกับ
อุปกรณปลายทาง ทําใหสามารถคิดเงินไดถูกตองยิ่งขึ้น 

สัญญาณพัลซมิเตอริ่ง สวนใหญจะตดิตั้งใหกับระบบโทรศัพทหยอดเหรียญ 
 
*** จะตองใชแผงวงจรสายนอกชนิด COL/P ซ่ึงสามารถรับสัญญาณพัลซจากชุมสายได 
 
P130  กําหนดชื่อของกลุมสายนอก (CO. Group Name)    

กําหนดชื่อแตกลุมสายนอก สามารถใชไดทั้งภาษาไทยและภาษาอังกฤษ สามารถกําหนดได
สูงสุด 16 ตัวอักษร  
 
 

กลุมสายนอกที่ใช 
การโทรสายนอกออกสายนอกได 

กลุมสายนอกที่ใช 
การคิดเงินแบบพัลซมิเตอริ่งได 

ตั้งชื่อของกลุมสายนอก 
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4.   โปรแกรม P1XX CO. Direct 
คลิกเลือก P1XX Trunk Programming -> CO. Direct แสดง Page ดังรูป  

 
P126  กําหนดกลุมสายนอกสําหรับระบบเครือขายกระจาย (Distribute network) 

ระบบการติดตั้งเครือขายแบบกระจาย เปนการติดตั้งตูสาขาที่อยูคนละพื้นที่ ใหสามารถ
ติดตอกันไดโดยผานสายนอกที่มาจากชุมสายโทรศัพท 

เชนการทํางานจากสํานักงานที่ 1 กับสํานักงานที่ 2 ทั้งสองสํานักงานจะมีสายนอกที่ถูกยกหู
ถึงกันตลอดเวลา ไมสามารถนําไปใชโทรไปที่อ่ืนได ยกเวนอยูในชวงที่ไมใชตอเปนเครือขาย 

ในการโทรหากัน เพื่อความสะดวกทั้งสองสํานักงาน ใหใชหมายเลขยอสวนรวมที่ตําแหนง
เดียวกันเก็บหมายเลขที่จะโทรออกไปสํานักงานตรงขาม ผูใชงานจะโทรออกไปหาอีกสํานักงานดวย
หมายเลขยอนี้ (ดู-การโปรแกรมบันทึกหมายเลขยอสวนรวม และการโทรออกดวยหมายเลขยอ
สวนรวม) 

เมื่อทั้งสองฝายวางหู ระบบจะยังคงคางสายนอกไวไมวางหู หากดูปุมสัญญาณไฟที่เครื่องคีย 
จะเห็นการกระพริบสีแดงของปุมสายนอกนั้นเครื่องอื่นในระบบสามารถใชงานตอได 

เมื่อฝายใดฝายหนึ่งตองการโทรออกไปหาฝายตรงขาม ใหกดหมายเลขยอ ถาสายของทั้งสอง
ฝายยังตอกันอยู จะไดยินเสียงพูดตอบรับของฝงตรงขาม สามารถกดหมายเลขปลายทางของระบบตรง
ขามได แตถาสายขาดระบบจะโทรออกใหใหมจากหมายเลขยอ ถาโทรออกไปใหมแลวไดยินเสียง
สายไมวาง ใหกด “FLASH” ตามดวย #5 แลววางหู คอยสักพัก (อยางนอยเทากับเวลา Hand Shake 
ของ P127) เพื่อใหสายปลายทางวางสายอัตโนมัติ จึงกดหมายเลขยอเพื่อตอสายใหม  
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ระบบเครือขายแบบกระจาย เหมาะสําหรับการเสียคาโทรศัพทตอคร้ัง เนื่องจากในระหวางที่
ไมมีผูใชงานสายจะตอถึงกันตลอดเวลา ผูใชที่มาใชในระหวางที่สายยังตอกันอยูจะไมตองเสียคาโทร 
จะเสียคาโทรเมื่อสายทั้งคูหลุดจากกันแลวตอสายใหม 

การดับเบิ้ลคล๊ิกที่ขอมูล P126 จะมีหนาตาง Array เพื่อยืนยันที่ตองการใชคาที่กําหนดจาก
โรงงาน (Default) คล้ิกถูกในชองที่ตองการ แลวระบบจะเติมคาใหอัตโนมัติ 

 
P127  ระยะเวลาตรวจสอบที่ตอเปนเครือขายกระจาย (Distribute Network Handshake) 

ในระบบเครือขายกระจาย ในระหวางที่สายของทั้งสองฝายยังตอกันอยู จะสามารถกําหนดให
สงสัญญาณตรวจสอบวาสายฝงตรงขามยังอยูหรือไม หากมีการตั้งคานี้ ระบบทั้งคูจะตองมีคาเดียวกัน 

คาจากโรงงาน กําหนดไว 2 นาที หากเกินเวลาแลวไมมีสัญญาณจากฝงตรงขาม ระบบจะทํา
การวางสายนี้อัตโนมัติ 
 
P128 เวลาหนวงของระบบเครือขายกระจายกลางวัน (Distribute Network Hold Time Day) 
P129  เวลาหนวงของระบบเครือขายเครือกระจายกลางคนื (Distribute Network Hold Time Night) 
 การกําหนดระยะเวลาที่สายจะหนวงการเชื่อมตอเอาไวหากไมมีการใชสายนั้นเปนเวลานาน
 เชนคาจากโรงงาน ในเวลากลางวันจะเปน 00:00 หมายความวา จะถือสายไวตลอดเวลา ไมวา
จะไมมีผูใชนานเทาไรก็ตาม สวนในเวลากลางคืนจะเปน 02:00 หมายความวา จะถือสายไว 2 ช่ัวโมง
หลังจากการใชงานครั้งสุดทาย หากถึงเวลานี้แลว ระบบจะตัดสายวางหูสายนอกอัตโนมัติ 
 
 
 

 
 
 
 
 
 
 
 

  กําหนดเวลาตรวจสอบสัญญาณ 

เวลาหนวง กลางวัน 
เวลาหนวง กลางคืน 

ดับเบิ้ลคล้ิก เพื่อเรียก Check Array ชวยงาน 
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P132  บริการโทรเขาสายตรง (Direct Number of CO. Line) 
การใชงานสายนอกทั้ง 128 สายนั้น บางครั้งอาจจะตองการใหสายนอกแตละสายเปนสายตรง

ของเครื่องโทรศัพทภายใน เมื่อมีผูโทรเขาที่สายนอกที่เปนสายตรงนี้ สัญญาณกระดิ่งจะไปดังที่เครื่อง
ภายในตามหมายเลขที่กําหนดในขอนี้ โดยไมใช P110/P111 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
P133  บริการโทรออกสายตรง (Direct Outgoing Mode) 
 เมื่อมีการเชื่อมตอตูสาขาฯ แบงสายนอก-สายใน (CO.Line – SLT) สามารถกําหนดใหตูสาขา
สงหรือไมสง A-Number (Caller ID) ได โดยหากตองการใหแสดง Caller ID ของตูที่ Link ดวย ให
กําหนดเปน “4” แตถาหากไมตองการใหแสดง Caller ID ของตูที่ Link ดวยใหกําหนดเปน “1”  
 

 
  
 เครื่องภายในที่เปนสายตรงสามารถทําอินเตอรคอมกับเครื่องอื่นได และมีคุณสมบัติการใช
งานตามกลุมสายในของเครื่องนั้น  

การโทรเขา-โทรออกดวยสายตรง สามารถทํารายงานการใชโทรศัพทได เหมือนสายในทั่วไป 
 
 
 

  กําหนดหมายเลขเครื่องภายใน 
ที่จะเปนสายตรงของสายนอกนั้น 
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5.   โปรแกรม P1XX Auto Rout 
คลิกเลือก P1XX Trunk Programming -> Auto Rout แสดง Page ดังรูป  
 

 
 

  กลุมของโปรแกรมสําหรับรองรับคําสั่งการใชงานฟงกช่ันที่ P001_889_*89 เปนคําสั่งการใช
 งานออโตรูท หรือการเลือกเสนทางโทรออกอัตโนมัติ 
  เมื่อผูใชงาน ยกหูโทรศัพทจะไดยินเสียงไดโทน แลวกด *89 (อาจจะเปนหมายเลขอื่นกําหนด
 ที่ P001_889_X) จะไดยินสัญญาณไดเทียมที่สรางจากระบบ (เสียงไดโทนเทียมนี้สามารถเปลี่ยน
 เสียงไดที่ P018_2_X) ผูใชงานจะกดหมายเลขปลายทางที่ตองการหลังจากนั้นระบบจะวิเคราะห
 หมายเลขนั้น แลวเลือกเสนทางการโทรออกที่โปรแกรมไวในกลุมของโปรแกรมนี้โดยอาจจะปรับ
 เปลี่ยนหมายเลขโทรออก 

 
P140  กําหนดหมายเลขที่จะใหเลือกเสนทางโทรออก (Auto-Route Number) 
 เปนการโปรแกรมกลุมหมายเลขขึ้นตนทีผู่ใชจะใชโทรออก 
 
P141  กําหนดหมายเลขที่โทรออก (Auto-Route Outgoing Number) 
 เปนหมายเลขที่ระบบใชโทรออก โดยการแทนที่หมายเลขที่ผูใชโทรออกจาก P140 ตามดวย
หมายเลขที่เหลือจากผูใช 
 
P142  กําหนดจํานวนหลักนอยสุด (Auto-Route Minimum Digits) 
P143  กําหนดจํานวนหลักมากสุด (Auto-Route Maximum Digits) 
 เปนการกําหนดจํานวนหลักที่นอยที่สุด และจํานวนหลักที่มากที่สุด ที่ผูใชจะโทรออกในกลุม
หมายเลขนั้น ถากําหนดไดดี จะทําใหการทํางานรวดเร็วข้ึน 
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P144  กําหนดเวลาเริ่มใชงานของแตละเสนทาง (Auto-Route Start Time) 
P145  กําหนดเวลาเลิกใชงานของแตละเสนทาง (Auto-Route Start Time) 
 เปนการกําหนดระยะเวลาที่จะใหใชเสนทางนั้นได หากการโทรออกนั้นระยะเวลาไมอยู
ในชวงที่กําหนดนี้ จะไมสามารถโทรออกได 
  
P146  กําหนดเสนทางที่โทรออก (Auto-Route Trunk Access)  
 เปนการกําหนดการเลือกเสนทางการโทรออกสายนอกแบบเจาะจงกลุมสายนอกลําดับที่ 81-
88 ในการโปรแกรมกลุมสายนอกที่ตองการ ดูที่ P104, P105  

 

ตัวอยาง 

Route 
P140 P141 P142 P143 P144 P145 P146 

Auto-Route 
Number 

Outgoing 
Minimum 

Digits 
Maximum 

Digits 
Start Time End Time 

Trunk 
Access 

1 02 02 9 9 08:00 20:00 1 
2 03 123403 9 9 08:00 08:00 2 
3 04 123404 9 9 08:00 20:00 2 
4 053 1234053 9 9 08:00 20:00 2 
5 054 1234054 9 9 08:00 20:00 2 
6 055 1234055 9 9 08:00 20:00 2 
7 056 1234056 9 9 08:00 20:00 1 
8 073 1234073 9 9 08:00 20:00 3 
9 074 1234074 9 9 08:00 20:00 3 

10 075 1234075 9 9 08:00 20:00 3 
11 076 1234076 9 9 08:00 20:00 3 
12 077 1234077 9 9 08:00 20:00 3 
13 08 08 10 10 08:00 00:00 4 
14 00 00 9 20 08:00 00:00 5 
15 1 1 3 4 08:00 00:00 1 
16 - - - - - - - 
17 - - - - - - - 
18 - - - - - - - 
19 - - - - - - - 
20 - - - - - - - 
21 - - - - - - - 
22 - - - - - - - 
23 - - - - - - - 
24 - - - - - - - 
25 - - - - - - - 
26 - - - - - - - 
27 - - - - - - - 
28 - - - - - - - 
29 - - - - - - - 
30 - - - - - - - 
31 - - - - - - - 
32 - - - - - - - 
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6.  โปรแกรม P1XX SIP Account 
 คลิกเลือก P1XX Trunk Programming -> SIP Account แสดง Page ดงัรูป  
 

 
 

P150 หมายเลขผูใชงานสายนอก IP (IP-Trunk Username) 
P151 รหัสผานของสายนอกแบบ IP (IP-Trunk Password) 
P152 IP-Trunk Realm 
P153 IP-Trunk Proxy Server 
 กําหนดคา SIP Account ซ่ึงไดมาจากผูใหบริการ VOIP ซ่ึงมี USERNAME, Password, 
REALM, PROXY SERVER 
 
P154 หมายเลขสายนอก IP (IP-Trunk Number) 
 กําหนดหมายเลขที่ใชตัดออกสายนอกของเครื่อง IP PHONE ซ่ึงควรตั้งใหสัมพันธกับ
หมายเลขที่ใชตัดออกของโทรศัพทสายในธรรมดา (ดู Port 880-888 ของ P001) 
 
P155 กลุมสายนอก IP (IP-Trunk Group) 
 กําหนดกลุมของกลุมสายนอก 
 
P156 IP-Trunk Codec 
 กําหนดการเขารหัสสัญญาณ บนมาตรฐานของเทคโนโลยี VoIP เพื่อใชติดตอกับระบบ VoIP 
ภายนอกโครงขายของตนเอง โดยแตละการเขารหัสสัญญาณ (Codec) จะมีขอดี ขอเสียที่แตกตางกนั 
ซ่ึงจะขึ้นอยูกบัการเลือกใชงานใหเหมาะสมกับระบบนัน้ ๆ 
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7.    โปรแกรม P1XXE1 Setting 
คลิกเลือก P1XX Trunk Programming -> E1 Setting แสดง Page ดังรูป  

 

 
 

เปนกลุมของโปรแกรมสําหรับกําหนดคาใหกับสายสัญญาณดิจิตอลความเร็วสูง E1 2 Mbps.  
ตู JSD-Series version 3 จะม ีE1 จํานวน 1 วงจร บนแผงวงจร JSD-CPU/PRI  
ตู Diamond version 3 และตู Platinum จะม ีE1 ไดสูงสุด 4 วงจร โดยขึน้กับแผงวงจรที่ใชงาน  

แผงวงจร DX-LPU/1PRI มี E1 จํานวน 1 วงจร  
แผงวงจร DX-LPU/2PRI มี E1 จํานวน 2 วงจร  
แผงวงจร DX-AUX/1PRI มี E1 จํานวน 1 วงจร  
และแผงวงจร DX-AUX/2PRI มี E1 จํานวน 2 วงจร 

  
P160  กําหนดการใช E1 (E1 Enable Type)   
 การโปรแกรมกําหนดคาโปรโตคอลที่ใชของแตละ E1 โดยมีขอกําหนดคือ  

เมื่อ E1 Type มีคาเปน 0 = ไมอนุญาตใหใชงาน, 2 = ISDN.-PRI., 6 = E1-R2 
 หรืออาจจะมีคาอื่นๆที่จะกําหนดในอนาคต 
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P161  กําหนดลักษณะของ E1 (E1 Feature)  
การโปรแกรมกําหนดคาของขอนี้ ใหใช 3 สําหรับแกไขโดยผูเขียนโปรแกรมระบบ  

 
P162  กําหนดฟงกชนัของ E1 (E1 Link Setting) 

การโปรแกรมกําหนดคาใหสายวงจร E1 นั้นทํางานเปนสายนอกหรือสายใน 
คาที่ติดตั้งจากโรงงานจะตั้งใหทุก E1 เปนสายนอก (ด-ูการนับพอรตที่ P100) 
เมื่อใช E1 เปนสายนอก และทราบพอรตแลว สามารถนําหมายเลขพอรตไปทําการโปรแกรม

 ตางๆได เชน ไปกําหนดปุมของเครื่องคียใหแสดงสถานะและเรียกใชโดยตรงของ Time Slot 
 นั้นได 
 เมื่อมีการใช P040, P041 ตองโปรแกรมให E1 นั้นทํางานเปนกลุมสายใน มีคุณสามบัติการ
 ทํางานตามกลุมสายในที่ถูกตั้งคาไว 
 
P163  กําหนดประเภทของ E1 (E1 Type Number) 

การโปรแกรมกําหนดคา ของอุปกรณปลายทางวาเปน Unknown หรือ ISDN. ที่จะแจงให
 ชุมสายไอเอสดีเอ็นทราบถึงชนิดอุปกรณปลายทาง ดังนั้นจะใชคาจากโรงงานคือ ISDN. 
 
P164  กําหนดแบบของสายสัญญาณ E1 (Line Impedance) 

ขอกําหนดของ E1 สามารถใชสายสัญญาณ แบบ 75 โอหมซึ่งเปนสายโคแอ็กเชี่ยล (Coaxial) 
 หรือสายแบบ 100 โอหมซึ่งเปนสายทวิสแพร (Twist Pair) 

การเลือกคาของโปรแกรมขอนี้จะขึ้นกับสายสัญญาณที่ใช 
BALUN เปนอุปกรณเพื่อปรับคาอิมพีแดนซใหสายสัญญาณตรงกับอปุกรณ 
 

P165  กําหนดหมายเลขเรียก E1 (E1 Caller Number) 
เปนการกําหนดหมายเลขของสาย E1 นั้นเมื่อใชโปรโตคอลแบบ PRI หมายเลขนี้ถูกกําหนด

มาจากชุมสายฯ ซ่ึงผูใชงานโทรศัพทจากที่อ่ืนจะเรียกมาหมายเลขนี้ 
 

 

 
 
 

ลําดับ E1 กําหนดประเภทของ E1 

กําหนดการใช E1 กําหนดแบบของสายสัญญาณ E1 

กําหนดหมายเลข E1 
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P166  กําหนดหมายเลขนําหนา DDI (DDI Table)  

DDI (Direct Dialing In) เปนบริการเสริมของโปรโตคอลแบบ ISDN.PRI. ซ่ึงทํางานคลายกับ
ระบบ DID (Direct In Dialing) ซ่ึงทํางานแบบอนาล็อกสงสัญญาณความถี่ สวน DDI จะใชสัญญาณ
โปรโตคอลคําสั่งระหวางอุปกรณกับชุมสายฯเปนชุดคําสั่งดิจิตอล 

การทํางาน DDI เปนการเรียกตรงจากภายนอกเขาเครื่องภายใน นั่นคือ เมื่อผูโทรเขาหมายเลข
ที่เปนเบอรตรงที่กําหนดนี้จะตรงไปหมายเลขภายในที่ตองการได ใน P167 โดยหมายเลขภายในจะ
ตรงกับ 3-4 หลักสุดทายของเบอรตรงหรือไมก็ได แตการทําใหตรงกับ 3-4 หลักสุดทายของสายนอก
ทําใหใชงานไดงาย 
 
P167  กําหนดหมายเลขปลายทางของ DDI ไปเคร่ืองภายใน (DDI To Extension Number)  

การกําหนดหมายเลขภายในที่จะเปนสายตรงของหมายเลขที่ถูกเรียกมาจาก P166 
 
P168  กําหนดหมายเลขปลายทางของ DDI ไปเปนกลุมสายนอก (DDI To Trunk Group) 
 การกําหนดใหเมื่อผูโทรเขามาหมายเลขที่เปนเบอรตรง ระบบจะสามารถตอบรับดวยเสียง
ตอบรับอัตโนมัติไดตามลักษณะการทํางานของกลุมสายนอกนั้น 
 
P169  Rx-Digit Number 
 เปนการกําหนดจํานวนหลกัที่จะรับจาก E1 ประเภท R2 

 
ตัวอยางเชน เมื่อผูใชไดรับหมายเลขจากชุมสายฯ มา 100 เลขหมาย สมมุติ 02-206-5500 ถึง 

02-206-5599 (สังเกตเบอรทาย 00-99) อาจจะจัดสรรการใชงานดังนี้ 
ใชหมายเลข 02-206-5500 เปนไพล็อตนัมเบอร (Pilot Number) ใชเปนหมายเลขรวมกันทั้ง

ระบบ เมื่อมีผูโทรเขาหมายเลขนี้ ระบบจะตอบรับดวยเสียงตอบรับและโอนสายอัตโนมัติ สําหรับ
เครื่องภายในที่ไมเปนสายตรง เมื่อโทรออกไปเครื่องปลายทางจะแสดงหมายเลขนี้   

ดังนั้นโปรแกรมให  
  P160_1_2 (คา P161-164 ใชคาจากโรงงาน) 
  P165_1_022065500 
ใชหมายเลข 02-20655XX เปนสายตรง ตรงกับหมายเลขภายใน 5XX ยกเวน หมายเลขของ

 ฝายตางๆดังนี้  
หมายเลข 02-206-5510 เปนหมายเลขประจําฝายขายเปนการใชสายนอกกลุมที่ 11 
หมายเลข 02-206-5520 เปนหมายเลขประจําฝายบริการเปนการใชสายนอกกลุมที่ 12 

 หมายเลข 02-206-5550 เปนหมายเลขประจําฝายสํานักงานกลางเปนการใชสายนอกกลุมที่ 14 
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ที่โปรแกรมกําหนดหมายเลขภายใน (P001) มี 3 หลัก เปน 5XX แตจะไมมีหมายเลขภายใน 

500, 510, 520, 550 หมายเลขที่มีคู DDI การโทรเขาจะเขาที่เครื่องภายในนั้นโดยตรง การโทรออกที่
เครื่องปลายทางจะโชวเบอรถึงเครื่องภายในดวย เชน 02-2065561 

กรณีคูของ DDI ที่หมายเลขทายไมตรงกับหมายเลขเครื่องภายใน การโทรเขาจะโทรตรงเขา
เครื่องนั้นได แตการโทรออกจะโชวเบอรแรก (ตัวอยางนี้ไมไดแสดง) 

กรณีไมมีคูหมายเลขภายใน เปน DDI การโทรเขาระบบจะทํางานโดยเสียงตอบรับแลวคอย
กดหมายเลขภายใน เมื่อโทรออกจะแสดงหมายเลขแรก (ตัวอยางนี้ไมไดแสดง) 

สวนหมายเลขภายในที่ไมเปนสายตรงใหกําหนดเปน 1XX, 2XX, 3XX หรือ 4XX หมายเลข
ที่ไมสายตรง เมื่อโทรออกจะโชวเบอรของ 02-205-5500 

การใชหมายเลข 02-206-5588, 02-206-5599 เปนเครื่องแฟกซ ก็ใชฟงกช่ัน DDI นี้ โดยเครื่อง
แฟกซจะมีหมายเลขเครื่องภายในเปน 588 และ 599 
 เพื่อใหการโทรเขาของสายนอกกลุมที่ 1, 11, 12 และ 13 ใหใชเสียงตอบรับที่แตกตางกัน โดย
ตองการใหสายนอกกลุมที่ 1 ใชเสียงตอบรับของสวนรวม สวนเสียงตอบรับกลุมที่ 11, 12, 13 ใชเสียง
ตอบรับของแผนก ตั้งคาที่ P110, P111 ตั้งคาใหใชเสียงตอบรับกอน 
 การใชเสียงตอบรับสายนอกที่แตกตางกนัจะตองตั้งแผนกการใชงานใหสายนอกที่ P028 
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 ทําการบันทึกเสียงที่ตองการดวย *5341[01-60]# ในที่นี้เลือกใชเสียงที่ 11 สําหรับเสียงตอบ
รับสวนรวม สวนเสียงตอบรับของแตละแผนก ใชเสียงที่ 1,2,3 ตามลําดับ 
 
 ที่โปรแกรม P030 นําเสียงทีบ่ันทึกไวไปใชตอบรับการโทรเขา โดยแยกตามแผนกทีต่องการ 
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บทที ่4 
 

โปรแกรมเกี่ยวกับสายใน P2XX Extension Programming 
  

เปนการโปแกรมเกี่ยวกับสายภายใน ซ่ึงในระบบโทรศัพทโฟนนิคจะตองแบงการใชงานของ
เครื่องโทรศัพทภายในเปนกลุม หรือประเภทการใชงานดวย P091 กอนแลวจึงจะทําการคอนฟกการ
ทํางานของเครื่องโทรศัพทภายใน 
 โปรแกรมคอนฟกบิว้เดอรนี้ไดแบงการโปรแกรมเกีย่วกับสายในไวเปน 5 กลุม คือ 

1. P2XX Parameter1 
2. P2XX Parameter2 
3. P2XX Key Operation & User ID 
4. P2XX Group Name 
5. P2XX Control Group 

 
1. โปรแกรม P2XX  Parameter 1 
คลิกเลือก P2XX Extension Programming -> Parameter1 จะแสดง Page ดังรูป 
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Out going Call 
P200  กําหนดการอนุญาตโทรออกสายนอก กลางวัน (Outgoing Call Day) 
P201  กําหนดการอนุญาตโทรออกสายนอก กลางคืน (Outgoing Call Night) 

คือการกําหนดวาใหกลุมสายในไหนสามารถโทรออกไดในชวงเวลา กลางวัน /กลางคืนไดที่
กลุมสายนอกไหนไดบาง โดยสามารถเลือกกําหนดกลุมสายนอกไดได 1- 32 กลุม    

การดับเบิ้ลคล๊ิกที่หัวตารางของ P200 / 201   จะมีหนาตาง Array เพื่อยืนยันที่ตองการใชคาที่
กําหนดจากโรงงาน (Default)  

                                                   
 

การคลิกในเพจของขอมูลที่ตองการแกไข จะสามารถปอนขอมูลไดโดยตรง แตจะตองเปนไป
ตามรูปแบบที่กําหนด เชน 1-32 หรือ 1, 3-5 เปนตน ดังนั้นผูใชจะตองเขาใจรูปแบบที่ถูกตองจึงจะ
ปอนขอมูลได 

การดับเบิ้ลคลิกในเพจของขอมูลที่ตองการแกไข จะได Array เมนูใหมขึ้นมาดังภาพ ใหทาน
ทําเครื่องหมายถูกในชองหมายเลขที่ทานตองการกําหนด จากนั้นกด OK เพื่อยืนยันการตั้งคา ดังภาพ 
 

 
 
 
 
 
*** เนื่องจากการในโทรออกของเครื่องโทรศัพทภายในมีหลายวิธี เชน การกด “9” (ถูกกําหนดจาก 
P001_809_9) หรือการกด *80 (ถูกกําหนดจาก P001_880_*80) หรือการโทรออกดวยวิธีอ่ืนๆ 
โปรแกรมนี้จะอนุญาต/ไมอนุญาตใหใชกลุมสายนอกนั้นจากการโทรออกทุกวิธี 

คลิกเครื่องหมายถูก เพื่อกําหนดกลุมสายนอก
ที่จะโทรออกที่ตองการ  

คลิกปุม OK เพื่อยืนยันคําสัง่  

ดับเบิ้ลคลิก เพื่อเรียก Default  

หมายเลขของกลุมสายนอก ที่จะใชโทรออกได 

หมายเลขของกลุมกลุมสายใน ที่จะโทรออก 
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Incoming Call 
P202  การกําหนดการโทรเขาของสายนอก กลางวนั (Incoming Call Day) 
P203  การกําหนดการโทรเขาของสายนอก กลางคนื (Incoming Call Night) 

คือการกําหนดวาใหกลุมสายในไหน  ที่สายนอกสามารถโทรเขาไดไดบาง เมื่อผูโทรเขาได
ยินเสียงตอบรับเพื่อโอนสายอัตโนมัติในชวงเวลา กลางวัน /กลางคืน (OGM.) จะกดหมายเลข
เครื่องโทรศัพทภายในที่ตองการไดถากําหนดใหโทรเขาจากสายนอกนั้นได โดยแตละกลุมสายใน
สามารถกําหนดเลือกกลุมสายนอกได 1- 32 กลุม    

การดับเบิ้ลคลิกที่หัวตารางของ P202 / 203    จะมีหนาตาง Array เพื่อยืนยันที่ตองการใชคาที่
กําหนดจากโรงงาน (Default)  

การคลิกในเพจของขอมูล จะสามารถปอนขอมูลไดโดยตรง แตจะตองเปนไปตามรูปแบบที่
กําหนด เชน 1-32 หรือ 1,3-5 เปนตน ดังนั้นผูใชจะตองเขาใจรูปแบบที่ถูกตองจึงจะปอนขอมูลได 

การดับเบิ้ลคลิกในเพจของขอมูลที่ตองการแกไข จะได Array เมนูใหมขึ้นมาดังภาพ ใหทาน
ทําเครื่องหมายถูกในชองหมายเลขที่ทานตองการกําหนด จากนั้นกด OK เพื่อยืนยันการตั้งคา ดังภาพ 
 
 

 
 
 
 
 

คลิกเครื่องหมายถูก เพื่อกําหนดกลุมสายนอก
ที่โทรเขาที่ตองการ  

คลิกปุม OK เพื่อยืนยันคําสัง่  

ดับเบิ้ลคลิก เพื่อเรียก Default  

หมายเลขของกลุมสายนอก ที่จะใชโทรเขาได 
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Intercom Call 
P204  กําหนดกลุมการเรียกสายภายใน กลางวนั (Intercom Call Day) 
P205  กําหนดกลุมการเรียกสายภายใน กลางคืน (Intercom Call Night) 

คือการกําหนดกลุมการอนุญาต/ไมอนุญาตใหเรียกสายภายใน ชวงเวลา กลางวัน /กลางคืน 
โดยสามารถกําหนดไดตามกลุมสายในที่ถูกเรียก 1- 32 กลุม    

การดับเบิ้ลคล๊ิกที่หัวตารางของ P204 / P205  จะมีหนาตาง Array เพื่อยืนยันที่ตองการใชคาที่
กําหนดจากโรงงาน (Default)  

การคลิกในเพจของขอมูล จะสามารถปอนขอมูลไดโดยตรง แตจะตองเปนไปตามรูปแบบที่
กําหนด เชน 1-32 หรือ 1,3-5 เปนตน ดังนั้นผูใชจะตองเขาใจรูปแบบที่ถูกตองจึงจะปอนขอมูลได 

การดับเบิ้ลคลิกในเพจของขอมูลที่ตองการแกไข จะได Array เมนูใหมขึ้นมาดังภาพ ใหทาน
ทําเครื่องหมายถูกในชองหมายเลขที่ทานตองการกําหนด จากนั้นกด OK เพื่อยืนยันการตั้งคา ดังภาพ 

 
 

 

คลิกเครื่องหมายถูก เพื่อกําหนดกลุมในที่ถูก
เรียกที่ตองการ  

คลิกปุม OK เพื่อยืนยันคําสัง่  

ดับเบิ้ลคลิก เพื่อเรียก Default  
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Automatic Trunk 
P208  โทรออกอัตโนมัติ ระดับท่ี1 (Automatic Trunk access (1st)) 

คือการกําหนดการโทรออกอัตโนมัติ (คาจากโรงงานคือการกด ”9” โปรแกรมเปลี่ยนเบอรได
ที่ P001_809_9) โดยสามารถกําหนดไดวาจะโทรออกที่สายนอกกลุมที่ 1- 32     

การดับเบิ้ลคล๊ิกที่หัวตารางของ P208 จะมีหนาตาง Array ขึ้นมาดังภาพ ใหทานทํา
เครื่องหมายถูกในชองหมายเลขที่ทานตองการกําหนด จากนั้นกด OK เพื่อยืนยันการตั้งคา  ดังภาพ 

 

       
 
P209  โทรออกอัตโนมัติ ระดับท่ี2 (Automatic Trunk access (2nd)) 

คือการกําหนดการโทรออกอัตโนมัติ  โดยสามารถกําหนดได 1- 32 กลุม คลาย P208 แตคา
ในโปรแกรมนี้จะทํางานเมื่อกลุมสายนอกใน P208 เต็มหรือสายขาดกรณีเปนสาย E1 

ดวยการดับเบิ้ลคล๊ิกที่หัวตารางของ P208 จะมีหนาตาง Array ขึ้นมาดังภาพ ใหทานทํา
เครื่องหมายถูกในชองหมายเลขที่ทานตองการกําหนด  จากนั้นกด OK เพื่อยืนยันการตั้งคา  ดังภาพ  
 

 
 
 

คลิกเครื่องหมายถูก เพื่อกําหนดกลุมสายนอก
ที่ตองการ  

คลิกปุม OK เพื่อยืนยันคําสัง่  

คลิกเครื่องหมายถูก เพื่อกําหนดกลุมสายนอก
ที่ตองการ  

คลิกปุม OK เพื่อยืนยันคําสัง่  
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Call Transfer 
P210  กําหนดโอนสายนอกจากการโทรออก กลางวัน (Outgoing Transfer Day) 
P211  กําหนดโอนสายนอกจากการโทรออก กลางคืน (Outgoing Transfer Night) 

คือการกําหนดอนุญาต/ไมอนุญาตใหโอนสายนอกจากการโทรออก ในชวงเวลา   กลางวัน /
กลางคืน โดยสามารถกําหนดไดไดตามกลุมสายนอก 1- 32 กลุม    

การดับเบิ้ลคล๊ิกที่หัวตารางของ P210 / P211 จะมีหนาตาง Array เพื่อยืนยันที่ตองการใชคาที่
กําหนดจากโรงงาน (Default)  

การคลิกในเพจของขอมูล จะสามารถปอนขอมูลไดโดยตรง แตจะตองเปนไปตามรูปแบบที่
กําหนด เชน 1-32 หรือ 1,3-5 เปนตน ดังนั้นผูใชจะตองเขาใจรูปแบบที่ถูกตองจึงจะปอนขอมูลได 

การดับเบิ้ลคลิกในเพจของขอมูลที่ตองการแกไข จะได Array เมนูใหมขึ้นมาดังภาพ ใหทาน
ทําเครื่องหมายถูกในชองหมายเลขที่ทานตองการกําหนด จากนั้นกด OK เพื่อยืนยันการตั้งคา ดังภาพ 
 
 

 
 
 
 
 
 
*** การโอนสายนอกจากการโทรออกสําหรับการติดตั้งของกลุมของเครื่องภายในที่ติดตั้งในหองพัก
ของ หอพัก คอนโดมีเนียม โรงแรม หรือเมื่อตองการคิดเงินกับผูโทรออก มักจะไมอนุญาตใหโอน
สายได 
 
 

คลิกเครื่องหมายถูก เพื่อกําหนดกลุมสายนอก
ที่ตองการอนญุาต/ไมอนุญาตใหโอนสาย  

คลิกปุม OK เพื่อยืนยันคําสัง่  

หมายเลขของกลุมสายนอก ที่จะโอนสายได 

หมายเลขของกลุมกลุมสายใน ที่จะโอนสาย 

ดับเบิ้ลคลิก เพื่อเรียก Default  
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P212  กําหนดโอนสายนอกจากการโทรเขา กลางวนั (Intercom Trans Day) 
P213  กําหนดโอนสายนอกจากการโทรเขา กลางคืน (Intercom Trans Night) 

คือการ กําหนดอนุญาต/ไมอนุญาตใหโอนสายนอกจากการโทรเขา ในชวงเวลา   กลางวัน /
กลางคืน โดยสามารถกําหนดไดตามกลุมสายนอก 1- 32 กลุม    

การดับเบิ้ลคล๊ิกในเพจของขอมูลที่ตองการแกไข จะได Array เมนูใหมขึ้นมาดังภาพ ใหทาน
ทําเครื่องหมายถูกในชองหมายเลขที่ทานตองการกําหนด จากนั้นกด OK เพื่อยืนยันการตั้งคา ดังภาพ 

 

 
 
 
P214  กําหนดการโอนสายภายใน กลางวัน (Intercom Trans Day) 
P215  กําหนดการโอนสายภายใน กลางวคืน (Intercom Trans Night) 

คือการ กําหนดอนุญาต/ไมอนุญาตใหโอนสายนอกจากการโทรอินเตอรคอม ในชวงเวลา  
กลางวัน /กลางคืน โดยสามารถกําหนดไดตามกลุมสายใน 1- 32 กลุม    

การดับเบิ้ลคล๊ิกในเพจของขอมูลที่ตองการแกไข จะได Array เมนูใหมขึ้นมาดังภาพ ใหทาน
ทําเครื่องหมายถูกในชองหมายเลขที่ทานตองการกําหนด จากนั้นกด OK เพื่อยืนยันการตั้งคา  ดังภาพ 

 

 
 

คลิกเครื่องหมายถูก เพื่อกําหนดกลุมสายนอก
ที่ตองการโอนสาย  

คลิกปุม OK เพื่อยืนยันคําสัง่  

คลิกเครื่องหมายถูก เพื่อกําหนดกลุมสายในที่
ตองการโอนสาย 

คลิกปุม OK เพื่อยืนยันคําสัง่  
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Intrusion & Observation 
P216  กําหนดกลุมการแทรกสาย กลางวัน (Intrusion Day) 
P217  กําหนดกลุมการแทรกสาย กลางคืน (Intrusion Night) 

คือการกําหนดอนุญาต/ไมอนุญาตใหกลุมสายในนั้นสามารถแทรกสายไปยังกลุมที่ตองการ 
ในชวงเวลา กลางวัน /กลางคืน โดยสามารถกําหนดกลุมสายในที่จะถูกแทรกสายได 1- 32 กลุม    

การดับเบิ้ลคล๊ิกในเพจของขอมูลที่ตองการแกไข จะได Array เมนูใหมขึ้นมาดังภาพ ใหทาน
ทําเครื่องหมายถูกในชองหมายเลขที่ทานตองการกําหนด จากนั้นกด OK เพื่อยืนยันการตั้งคา ดังภาพ 
 
 
 
 
 
 
 
 
P218  กําหนดการดักฟงกลุมภายใน กลางวัน (Service Observe Day) 
P219  กําหนดการดักฟงกลุมภายใน กลางคืน (Service Observe Night) 

คือการกําหนดอนุญาต/ไมอนุญาตใหดักฟงกลุมสายในที่ตอการได ในชวงเวลา   กลางวัน/
กลางคืน โดยสามารถกําหนดไดตามกลุมสายในที่จะถูกดักฟงได 1- 32 กลุม    

การดับเบิ้ลคล๊ิกในเพจของขอมูลที่ตองการแกไข จะได Array เมนูใหมขึ้นมาดังภาพ ใหทาน
ทําเครื่องหมายถูกในชองหมายเลขที่ทานตองการกําหนด จากนั้นกด OK เพื่อยืนยันการตั้งคา ดังภาพ 
 
 
  
 
 
 
 
 
*** การแทรกสายมีสัญญาณเสียงเตือนเครือ่งโทรศัพทปลายทาง แตการดักฟงไมม ี

คลิกเครื่องหมายถูก เพื่อกําหนดกลุมสายในที่
ตองการถูกแทรกสายได 

คลิกปุม OK เพื่อยืนยันคําสัง่  

คลิกเครื่องหมายถูก เพื่อกําหนดกลุมที่
ตองการใหถูกดักฟงได 

คลิกปุม OK เพื่อยืนยันคําสัง่  
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2. โปรแกรม P 2XX Parameter 2 
คลิกเลือก P2XX Extension Programming -> Parameter 2  

 
Timer Usage Limitation 

ตั้งแต   P220 – P225 จะเกี่ยวกับการตั้งเวลาการใชสาย   กลางวัน / กลางคืน   โดยการตั้งคาจะ
คลายๆ กันแตจะแตกตางกันที่ ความหมายในการใชงานดังนี้ 
P220  ตั้งเวลาใชเม่ือโทรออกสายนอก กลางวัน (Outgoing Timer Limit Day) 
P221  ตั้งเวลาใชเม่ือโทรออกสายนอก กลางคืน (Outgoing Timer Limit Night) 
P222  ตั้งเวลาใชเม่ือโทรเขาสายนอก กลางวัน (Incoming Timer Limit Day) 
P223  ตั้งเวลาใชเม่ือโทรเขาสายนอก กลางคืน (Incoming Timer Limit Night) 
P224  ตั้งเวลาใชสายจากการโทรภายใน กลางวนั (Intercom Timer Limit Day) 
P225  ตั้งเวลาใชสายจากการโทรภายใน กลางคืน (Intercom Timer Limit Night) 

โดยการตั้งเวลาสามารถตั้งไดตั้งแต 1- 255 นาที ดวยการคลิกเลือกตารางที่ตองการตั้งคา แลว
สามารถ พิมพตัวเลขที่ตองการตั้งคาไดทันที  

 การดับเบิ้ลคล๊ิกที่หัวตารางของ P จะมีหนาตาง Array เพื่อยืนยันที่ตองการใชคาที่กําหนดจาก
โรงงาน (Default)  
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Class Of Service 
P226  ระดับความสามารถในการโทรออก กลางวัน (Class of Service Day) 
P227  ระดับความสามารถในการโทรออก กลางคืน (Class of Service Night) 

ทานสามารถกําหนดการใชโทรศัพทไดวาใหกลุมสายในไหนสามารถโทรออกไดบาง โทร
ออกตางจังหวัดได   โทรออกตางประเทศได   รวมทั้งเบอรตางๆ แลวแตทานกําหนด   หรือสามารถ
โทรออกไดทั้งหมด   และสามารถแยกความแตกตางไดในชวงเวลา กลางวัน / กลางคืน 

การดับเบิ้ลคล๊ิกที่หัวตารางของ P226 / P227 จะมีหนาตาง Array เพื่อยืนยันที่ตองการใชคาที่
กําหนดจากโรงงาน (Default)  
 

 
 
 
 

 การเคลื่อนเมาสไปวางบนหัวตารางของ P จะมีหนาตางแนะนําการเติมคาขึ้นใหเห็นใน
ชวงเวลาสั้นๆ ดังภาพ 
 

 
 
 
 
 

หมายเลขของระดับการโทรออก 
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ความหมายของตัวเลขท่ีทานสามารถตัง้คาไดเพื่อเปนระดับการโทรออกมีดังนีค้ือ   

ระดับ 
การโทรออก 

ความหมาย 

1-20 จะตองตั้งคาทีต่องการที่ P006, P007 
21 สามารถโทรออกไดทั้งหมด 

22 
สามารถโทรออกหมายเลขที่ขึ้นตนดวย  0 , 1 , 2 , 3 , 4 , 5 , 6 , 7 , 8 , 9 
(ใชโทรออกตางประเทศได) 

23 
หามโทรออกหมายเลขที่ขึ้นตนดวย  00 , 100 , * , # 
(หาม 00=โทรตางประเทศ, หาม 100=โทรตางประเทศผานพนักงาน) 

24 
หามโทรออกหมายเลขที่ขึ้นตนดวย  00 , 100 , 1113 , 1900 ,* , # 
(โทรภายในประเทศได แตโทร 1133 และ 1900 ไมได) 

25 
หามโทรออกหมายเลขที่ขึ้นตนดวย  0 , * , # , 100 , 101 , 1113 , 1900 - 02 , 08 
(ใชโทรพื้นที่กรุงเทพฯ, มือถือ, และ 1xxx ไดบางสวน) 

26 หามโทรออกหมายเลขที่ขึ้นตนดวย  0 , * , # , 100 , 101 , 1113 , 1900 , 1234- 02 
(ใชโทรพื้นที่กรุงเทพฯ, และ 1xxx ไดบางสวน) 

27 หามโทรออกหมายเลขที่ขึ้นตนดวย  0 , * , # 
28 สามารถโทรออก หมายเลขที่ขึ้นตนดวย  1133 , 1177 , 191 , 199 , 108 
29 สามารถโทรออก หมายเลขที่ขึ้นตนดวย  1133 , 1177 , 191 , 199 
30 หามโทรออก 
31 ใหโทรออกจากหมยเลขยอ 

 
*** คา default จากโรงงาน ตั้งคาตามลักษณะการใชงานของกลุมสายใน เชน กลุมของผูจัดการ 
(Manager) จะไมจํากัดการโทรออก นั่นคือเปนระดับการโทรออกที่ 21  
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P228  ชนิดของสายดวน กลางวนั (Hot-line Day) 
P229  ชนิดของสายดวน กลางคืน (Hot-line Night) 

เปนการตั้งคาให เมื่อผูใชมีการยกหูโทรศัพท ระบบจะโทรไปหมายเลขปลายทางที่กําหนดไว
อัตโนมัติ โดยไมตองกดปุม สายดวนมี 2 ชนิด คือ 
 สายดวนแบบทันที เมื่อยกหโูทรศัพท ระบบจะโทรออกอัตโนมัติทันท ี
 สายดวนแบบหนวงเวลา เมื่อยกหู ระบบจะหนวงเวลาไว แลวจึงจะโทรออกอัตโนมัติ หากกด
หมายเลขปลายทางภายในชวงหนวงเวลา   การโทรสายดวนจะไมทํางาน 
  (เวลาที่หนวงกําหนดที่ P8XX) 

การดับเบิ้ลคล๊ิกที่หัวตารางของ P จะมีหนาตาง Array เพื่อยืนยันที่ตองการใชคาที่กําหนดจาก
โรงงาน (Default) ซ่ึงจะเปนคาที่ไมใชการโทรสายดวน 
 การเคลื่อนเมาสไปวางบนหัวตารางของ P228 / P229 จะมีหนาตางแนะนําการเติมคาขึ้นให
เห็นในชวงเวลาสั้นๆ ดังภาพ 
 

 
                    
 หมายเลขแสดงลักษณะของการใชสายดวน 
 
 
 
 
 
 
 
 
 
 

 10 – 99       ทํางานทันทีที่เลขยอตําแหนง   910 - 999 
 110 – 199   หนวงเวลาที่เลขยอตําแหนง    910 - 999 
 อ่ืนๆ               ไมใช 
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3. โปรแกรม P 2XX  Key Operation & User ID 
คลิกเลือก P2XX Extension Programming -> Key Operation & User ID แสดง Page ดังรูป  
 

 
 

P230  การใชเคร่ืองคยีเปน โอเปอเรเตอร กลางวัน (Key Tel Operator Day) 
P231  การใชเคร่ืองคยีเปน โอเปอเรเตอร กลางวัน (Key Tel Operator Night) 
   เมื่อหมายเลขเครื่องโทรศัพทภายในถูกกําหนดใหเปนโอเปอเรเตอร ในโปรแกรมนี้เปนการ
เพิ่มลักษณะการใชงานของกลุมนี้ เมื่อมีผูโทรหาโอเปอเรเตอรจะไดยินสัญญาณเรียกถึงแมวาสายนั้น
จะไมวาง ถาเครื่องนั้นเปนเครื่องคียจะมีไฟแสดงการคอยสาย 
 การดับเบิ้ลคล๊ิกที่หัวตารางของ P230 /P231 จะมีหนาตาง Array เพื่อยืนยันที่ตองการใชคาที่
กําหนดจากโรงงาน (Default) 

คล้ิกเครื่องหมายถูกในกลุมสายในที่ตองการใหการถูกเรียกมีสัญญาณเรียกถึงแมสายไมวาง 
 

P232  ใชประกาศออกเครื่องคีย กลางวัน (Paging to Key Tel Day) 
P233  ใชประกาศออกเครื่องคีย กลางคืน (Paging to Key Tel Night) 
 เมื่อผูใชโทรศัพทกด *44# เครื่องคียทุกครื่องที่อยูในกลุมที่รองรับการทํางานประกาศออก
เครื่องคียจะมีเสียงออกประกาศทันที 
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 การดับเบิ้ลคล๊ิกที่หัวตารางของ P232/233 จะมีหนาตาง Array เพื่อยืนยันที่ตองการใชคาที่
กําหนดจากโรงงาน (Default) 
 

จากหนาจอโปรแกรมคอนฟกบิ้วเดอร 
 

 
 
 
 
 
 
 
 
 
 
 
 เครื่องคียที่มีเสียงออกประกาศสามารถรับสายที่ออกประกาศได เมื่อรับสายแลวจะเกิดการ
สนทนากับผูออกประกาศ สวนเครื่องอื่นๆที่กําลังออกประกาศจะวางหูอัตโนมัติ 
 
P234  ผูใชขอใชงานดวยรหัสประจําเครื่อง กลางวัน (User Identification Day) 
P235  ผูใชขอใชงานดวยรหัสประจําเครื่อง กลางคืน (User Identification Night) 
 โปรแกรมนี้เปนการเปดใหผูที่ตั้งรหัสประจําเครื่องตองการนําไปใชโทรออกตามชวงเวลา
กลางวัน/กลางคืนได และใชงานรวมกับ P236/P237 

User ID. คําสั่งใชงานเกีย่วกบัการใชรหัสประจําเครื่อง  
 

การตั้งรหัสประจําเครื่อง *503#[ID. Code]# 
การลบรหัสประจําเครื่อง *5030#[ID. Code]# 
การลบรหัสประจําเครื่องใหเครื่องอื่น (*0) *5030#[Ext. No.]# 
ใชรหัสประจําเครื่องล็อคการโทรออกของเครื่องนั้น *501#[ID. Code]# 
ใชรหัสประจําเครื่องปลดล็อคการโทรออกของเครื่องนั้น *502#[ID. Code]# 
ใชรหัสประจําเครื่องเพื่อโทรออกเครื่องตนเอง *504#[ID. Code]#.... 
ใชรหัสประจําเครื่องเพื่อโทรออกเครื่องอื่น *504*[Ext. No.]#[ID. Code]#.... 

 

 คล้ิกถูกในกลุมที่ตองการใหทํางาน 
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P236  ระดับการโทรออกดวยรหัสประจําเครื่อง กลางวัน (Class of User Identification Day) 
P237  ระดับการโทรออกดวยรหัสประจําเครื่อง กลางคืน (Class of User Identification Night) 

จะเปนการตั้งระดับการโทรออกเมื่อโทรออกดวยรหัสประจําเครื่อง  
 การใชงานรหัสประจําเครื่องเพื่อโทรออก ผูใชจะกดรหัสเพื่อโทรออกโดยใชรหัสประจํา
เครื่องแลวระบบจะยายระดับการโทรออกเดิมจาก P226/P227 เปน P236/P237 เมื่อกดรหัสถูกตองจะ
ไดไดโทนเพื่อโทรออกหมายเลขที่ตองการ 
 การดับเบิ้ลคล๊ิกที่หัวตารางของ P232/233 จะมีหนาตาง Array เพื่อยืนยันที่ตองการใชคาที่
กําหนดจากโรงงาน (Default) 

 

จากหนาจอโปรแกรมคอนฟกบิ้วเดอร 
 

 
 

 
 
 
 

 การเคลื่อนเมาสไปวางบนหัวตารางของ P236/P237 จะมีหนาตางแนะนําการเติมคาขึ้นใหเห็น
ในชวงเวลาสั้นๆ ดังภาพ 

 
 
 
 
 
 

 หมายเลขระดบัการโทรออก  กลุมสายใน  คล้ิกถูกในกลุมที่ตองการใหทํางาน 
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ความหมายของตัวเลขท่ีทานสามารถตัง้คาไดเพื่อเปนระดับการโทรออกเมื่อใช User ID.มีดังนี้คือ   

ระดับ 
การโทรออก 

ความหมาย 

1-20 จะตองตั้งคาทีต่องการที่ P006, P007 
21 สามารถโทรออกไดทั้งหมด 
22 สามารถโทรออกหมายเลขที่ขึ้นตนดวย  0 , 1 , 2 , 3 , 4 , 5 , 6 , 7 , 8 , 9 

(ใชโทรออกตางประเทศได) 
23 หามโทรออกหมายเลขที่ขึ้นตนดวย  00 , 100 , * , # 

(หาม 00=โทรตางประเทศ, หาม 100=โทรตางประเทศผานพนักงาน) 
24 หามโทรออกหมายเลขที่ขึ้นตนดวย  00 , 100 , 1113 , 1900 ,* , # 

(โทรภายในประเทศได แตโทร 1133 และ 1900 ไมได) 
25 หามโทรออกหมายเลขที่ขึ้นตนดวย  0 , * , # , 100 , 101 , 1113 , 1900 - 02 , 08 

(ใชโทรพื้นที่กรุงเทพฯ, มือถือ, และ 1xxx ไดบางสวน) 
26 หามโทรออกหมายเลขที่ขึ้นตนดวย  0 , * , # , 100 , 101 , 1113 , 1900 , 1234- 02 

(ใชโทรพื้นที่กรุงเทพฯ, และ 1xxx ไดบางสวน) 
27 หามโทรออกหมายเลขที่ขึ้นตนดวย  0 , * , # 
28 สามารถโทรออก หมายเลขที่ขึ้นตนดวย  1133 , 1177 , 191 , 199 , 108 
29 สามารถโทรออก หมายเลขที่ขึ้นตนดวย  1133 , 1177 , 191 , 199 
30 หามโทรออก 
31 ใหโทรออกจากหมยเลขยอ 

 
*** คา default จากโรงงาน จะหามโทรออก คลาส 30  
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P238  อนุญาตใหใช Account Code กลางวัน (Account Code Day) 
P239  อนุญาตใหใช Account Code กลางคืน (Account Code Night) 
 

 
 
 

 คล้ิกถูกในกลุมที่ตองการใหทํางาน 
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4. โปรแกรม P 2XX Group Name 
คลิกเลือก P2XX Extension Programming -> Group Name แสดง Page ดังรูป  

 
 
 การโปรแกรมในเพจนี้นอกจากจะเปนการตั้งชื่อกลุมของเครื่องโทรศัพทภายใน จะเปนการ
การโปรแกรม P อ่ืนๆ ที่ไมมีการแยกการทํางานระหวางกลางคืน 
 
P250  ชื่อของกลุมสายใน (Extension Group Name) 
               เปนการกําหนดชื่อของกลุมสายใน  เพื่องายในการจดจําตอการทํางานของระบบ ทําใหเรา
ทราบถึงการวางระบบใหกับการใชงานวาเครื่องโทรศัพทในกลุมนั้นไดถูกวางรูปแบบการทํางาน
พิเศษอะไรไวบาง โดยที่ทานสามารถตั้งคาของตัวอักษร ไดสูงสุด 16 ตัวอักษร ทั้งไทยและอังกฤษ 
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P251  จํานวนเงินการโทรออกที่ถูกจํากัด (Money Limited) 
ทานสามารถกําหนดวงเงินการใชโทรศัพทของแตละเครื่องได โดยหากเมื่อสายที่ทานจํากัด

วงเงินไวนั้นโทรเกินอัตราที่ตั้งไว จะไมสามารถโทรออกได ตองทําการเคลียรคาที่เกินกอน  จึงจะ
สามารถใชงานได โดยทานสามารถกําหนดคาไดตั้งแต 1 – 65535 สวน 0 คือการไมจํากัดวงเงิน 

 

 
 
P252  กําหนดกลุมอนุญาตการพักสายกอนเวลา (Transfer before Timeout) 
 การกําหนดปุมอนุญาตพักสายกอนเวลา เมื่อมีการโทรออกจากโอเปอเรเตอร อาจจะมีความ
ตองการโอนสายใหรวดเร็ว จึงไมตองหนวงเวลากอนพักสาย แตหากเปนเครื่องภายในของหอพัก 
อพารตเมนทควรตั้งหนวงเวลากอนที่จะพักสายได เพื่อปองกันการทํา “Double Flash” ทําใหรายการที่
โทรออกไมมีหมายเลขปลายทาง  
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P253  กําหนดสายขอมูล (Data Line) 
 การกําหนดสายขอมูล คือการกําหนดสายที่จะตอ ออกโมเด็ม เพื่อใชสําหรับโปรแกรม 
Billing หรือการสงขอมูลผานระบบโทรศัพท 
 การดับเบิ้ลคล๊ิกที่หัวตารางของ P253 จะมีหนาตาง Array เพื่อยืนยันที่ตองการใชคาที่กําหนด
จากโรงงาน (Default) 
 

 
 
P254  กําหนดกลุมสายในที่สามารถใชระบบฝากขอความ (Voicemail Service) 
 การกําหนดกลุมสายในที่สามารถใชระบบฝากขอความไดโดย หากขณะที่สายทานไมวางทาง
ระบบโทรศัพทจะมีขอความเสียงแจงเตือนคูสนทนาวา  “กรุณาฝากขอความหลังไดยินเสียงสัญญาณ” 
การฝากขอความจะใชงานรวมกับแผงวงจรฝากขอความ EVM. (Embedded Voice Mail) 

การดับเบิ้ลคล๊ิกที่หัวตารางของ P254 จะมีหนาตาง Array เพื่อยืนยันที่ตองการใชคาที่กําหนด
จากโรงงาน (Default) 
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คําสั่งใชงานสาํหรับการฝากและฟงขอความ 

ฝากขอความเครื่องตนเอง *11# 
ฝากขอความใหเครื่องภายในอื่น *11#[Ext. No.]# 
การโอนสายใหคูสนทนาเขาระบบฝากขอความ “Flash” *11#[Ext. No.]# 
ฝากขอความจากสายนอก (ตองเรียกเบอรภายในกอน) *11# 
ฟงขอความจากเครื่องตนเอง *12# 
ขอความจากเครื่องภายในอื่น (อาจจะมีรหสัผาน) *12#[Ext. No.]# 
ฟงขอความจากสายนอก (อาจจะมีรหัสผาน) *12# 

 
P255  เตือนดวยเสียงเมื่อมีขอความมาฝากไว   (Voicemail Message) 

เมื่อระบบมีการติดตั้งใชงานระบบฝากขอความ จะตองมีการเตือนใหผูที่มีขอความฝากไวได
ทราบ การเตือนดวยเสียงนั้น เมื่อมีขอความฝากไว เมื่อเครื่องภายในนั้นที่ไดรับฝากขอความ เมื่อยกหู
จะมีเสียงจากระบบพูดวา “ขณะนี้ทานมีขอความฝากไว กด *12# เพื่อรับฟงขอความ“  

การเตือนดวยเสียงเปนการทํางานมาตรฐานไมตองการอุปกรณเสริม สามารถเลือกปด-เปด
การใชงานนี้ไดโดยการ  คลิกเลือกถูกในชองตารางสี่เหล่ีอมสําหรับกลุมสายในที่ตองการใชงาน 
 
P256  เตือนดวยไฟสญัญาณเมื่อมีขอความมาฝากไว (Voicemail Lamp) 
 การแจงเตือนดวยสัญญาณไฟเมื่อมีขอความฝากถึง คือ เครื่องโทรศัพทจะแสดงสัญญาณไฟ
สวางเตือนตลอด หากยังไมไดกดฟงขอความ การใชงานตองใชแผงวงจรสายในที่ออกแบบเฉพาะโดย
แผงสายใน SLT จะตองมี /M (Message Lamp) ตองกําหนดเมื่อส่ังซื้อ ติดตั้ง สามารถเลือกการใชงาน
นี้ไดโดยการ คลิกเลือกถูกในชองตารางสี่เหล่ียม 
 การเตือนฝากขอความดวยเสียงสามารถทํางานรวมกับการเตือนดวยไฟ 
 

 
 
  (* แผงภายใน SLT จะมี /C = Caller ID , /M = Massage Lamp ใหเลือก เพื่อติดตั้งในระบบ) 
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P257  ใหสงสัญญาณโชวเบอรผูเรียก (CID Service) 
การเลือกที่จะโชวเบอรภายในของผูเรียกที่กลุมเครื่องโทรศัพทภายใน ทําใหทราบวาเครื่อง

ภายในหมายเลขไหน หรือสายนอกเบอรอะไรโทรเขามาหา เพื่อสะดวกในตัดสินใจรับสาย สามารถ
เลือกการใชงานนี้ไดโดยการ  คลิกเลือกถูกในชองตารางสี่เหล่ียม 
 

 
 

( แผงสายในตองเปนแบบ SLT มี /C เพื่อสงสัญญาณโชวเบอร สวนการรับสัญญาณโชวเบอรสายนอก
จะตองมีสัญญาณจากชุมสายโทรศัพท และใชแผงวงจร COL มี /C ดวย) 
 
P258  ใหสงสัญญาณเสียงตอบตามคําสั่งได (Voice Response) 

การเลือกการใชงานเสียงตอบตามคําสั่งนั้น ทานสามารถเลือกการใชงานนี้ไดโดยการ  คลิก
เลือกในชองวางของตารางสี่เหล่ียม  

 

 
 
 
 



 

 

  E - 23

เสียงตอบตามคําสั่ง  ขณะนีม้ีการใชงานหลายลักษณะ เชน 

1. สอบถามหมายเลขประจําเครื่อง ยกหู  กด * 544  # 
2. สอบถามลําดับของเครื่องนั้น ยกหู  กด * 545 # 
3. สอบถามวงเงินที่ใชไปในเครื่องตนเอง ยกหู  กด * 547 # 
4. สอบถามวงเงินที่ใชไปในเครื่องอื่น ยกหู  กด * 547 *[EXT. No.] # 

[EXT. No.]  = หมายเลขของเครื่องโทรศัพทภายใน 
5. สอบถามวันเวลาปจจุบันของระบบ ยกหู  กด * 548 # 
6. เปลี่ยนภาษาของเสียงตอบตามคําสั่ง ยกหู  กด * 544 [ 1 - 4 ] 

[ 1 - 4 ] ใหเลือกกด  1  หรือ 2  หรือ 3 หรือ 4 
7. เสียงจากการตั้งปลุกเครื่องตนเอง ยกหู  กด * 58 [HHMM]  # 

จะไดยินเสียงบอกเวลาปจจบุัน และเวลาตัง้ปลุก 
[HHMM] คือ  ช่ัวโมง 2 หลัก , นาท ี2 หลัก 

8. เสียงจากการตั้งปลุกเครื่องอื่น ยกหู  กด * 58 [HHMM]  *[EXT. No.] # 
จะไดยินเสียงบอกเวลาปจจบุัน และเวลาตัง้ปลุก 

9. เสียงจากเครื่องภายในถูกตั้งปลุก ยกห ู

 
      

P259  สงสัญญาณเตอืนเมื่อบันทึกขอมูลใชโทรศัพท (Record tone) 
การสงสัญญาณเตือนเมื่อมีการบันทึกการใชโทรศัพท จะไดยินเสียงสัญญาณดัง “ตื๊ด” หลัง 

จากกดหมายเลขปลายทางสักระยะเวลาหนึ่ง เปนการแจงเตือนวาจะมีการเริ่มบันทึกการใช หากทาน
ไมตองการใหคิดเงินกรุณาวางหูโทรศัพท ทานสามารถเลือกการใชงานนี้ไดโดยการ คลิกเลือกถูกใน
ชองวางของตารางสี่เหล่ียม 
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5. โปรแกรม P2XX Control  Group 
ในเพจนี้เปนการกําหนดความสามารถหรือระดับความสําคัญการใชงานของเครื่องโทรศัพท

ภายใน และสถานะของเครื่องโทรศัพทภายในหองพักโรงแรม 
จากคูมือดัชนีการใชงานจะเห็นหมายเหตุหลังคําสั่งการใชงาน ซ่ึงแสดงความสามารถหรือ

ระดับความสําคัญของคําสั่ง ดังนี้ 
- คําสั่งใชงานที่ไมมีหมายเหต ุแสดงวาเครื่องโทรศัพทภายในใชคําสั่งนี้ไดทุกเครื่อง 
- หมายเหต ุ(*0) แสดงวากลุมของเครื่องโทรศัพทภายในที่ตองถูกกําหนดใน P260 
- หมายเหต ุ(*1) แสดงวากลุมของเครื่องโทรศัพทภายในที่ตองถูกกําหนดใน P261 
- หมายเหต ุ(*2) แสดงวากลุมของเครื่องโทรศัพทภายในที่ตองถูกกําหนดใน P262 
- หมายเหต ุ(*3) แสดงวากลุมของเครื่องโทรศัพทภายในที่ตองถูกกําหนดใน P263 
 
คลิกเลือก P2XX Extension Programming -> Control Group จะแสดง Page ดังรูป 
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P260  กําหนดกลุมการควบคุมสายภายใน (Control Group) 
  คืการกําหนดกลุมควบคุมเครื่องโทรศัพทภายในโดยทานสามารถใชเครื่องโทรศัพทคีย หรือ 
เครื่องโทรศัพทที่ถูกกําหนดไวในโปรแกรมนี้ ใหควบคุมเครื่องอื่นได   

ดับเบิ้ลคลิก ที่ตาราง ดังภาพ จะมีหนาตาง Array ขึ้นมาดังภาพที่ปรากฎ ทานสามารถเลือก
กลุมสายในที่ทานตองการใหถูกควบคุมได ดวยการคลิกเลือกที่ชองวาง 1–32 จากนั้นคลิก ปุม OK 
เพื่อยืนยันการตั้งคา     
 

 
 

 
 
 
 
 
 
 
P261  กําหนดกลุมสายในควบคุมระบบ (System Control) 
 การกําหนดกลุมสายในควบคุมระบบนั้น เปนการกําหนดใหกลุมสายภายในนั้นสามารถใช
เครื่องโทรศัพทคีย หรือเครื่องโทรศัพทภายใน สามารถควบคุมการทํางานของระบบ เชน การเปลี่ยน
การทํางานกลางวัน/กลางคืน การเปลี่ยนเสียงเพลงพักสาย เปนตน 

โดยทานสามารถเลือกกลุมที่ทานตองการใหสามารถควบคุมสายภายในได ดวยการคลิกเลือก
ที่ชองวาง  จากนั้นคลิก ปุม OK เพื่อยืนยันการตั้งคา     
 

 
 
 

กลุมสายใน ผูควบคุม กลุมสายใน ผูถูกควบคุม 

กาถูกกลุมสายใน ที่สามารถควบคุมระบบ 
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P262  กําหนดกลุมสายในที่สามารถควบคุมการพิมพ (Printing Control) 
 การกําหนดกลุมสายในควบคุมการพิมพ คือ  การกําหนดใหเครื่องโทรศัพทคีย หรือ
เครื่องโทรศัพทในกลุมสายในนี้ สามารถควบคุมการสั่งพิมพรายการตางๆ ได ไมวาจะเปนคูมือตู 
รายการบิลล่ิงตางๆ ได 
 ทานสามารถกําหนดคาไดโดยการคลิกเลือกตารางกลุมที่ทานตองการ  หากไมตองการเลือก
ใหเวนวางไว 
 

 
 
 
 
 
 
 
 
 
 
 
P263  กําหนดกลุมสายในที่สามารถควบคุมรีเลย (Relay Control) 
 การกําหนดกลุมสายในที่สามารถควบคุมเปด-ปดรีเลย เพื่อไปเปด-ปด สวิตชไฟฟาได 
 

 
 
 
 
 
 
 
 
 
 

กาถูกกลุมสายใน ที่สามารถควบคุมรีเลย 

กาถูกกลุมสายใน ที่สามารถควบคุมการพมิพ 
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P264  กําหนดใหใชสถานะหองพัก (Room Status) 
การกําหนดใหกลุมสายในนั้นสามารถถูกควบคุมใหเปลี่ยนสถานะของเครื่องโทรศัพท ของ

หองพักในโรงแรมได ดวยคําสั่งใชงาน *59[0-9]*[Ext. No.] เมื่อ 0-9 คือสถานะของหอง  
 

 
 
  
P265  กําหนดชื่อของสถานะหองพัก (Room Status Name) 

สถานะของหอง 10 ระดับ สามารถเปลี่ยนชื่อไดจากโปรแกรมในขอนี้ 
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สถานะของเครื่องโทรศัพท ช่ือสถานะ ความหมาย การใชงาน 

สถานะที่ 0 Vacant หองวาง พรอมใชงาน หามโทรออกสายนอก 
สถานะที่ 1 Cleaning หองกําลังทําความสะอาด หามโทรออกสายนอก 
สถานะที่ 2 Check Out หองที่เช็คเอาทแลว หามโทรออกสายนอก 
สถานะที่ 3 Reserve หองที่สํารองไว หามโทรออกสายนอก 
สถานะที่ 4 Booking หองที่ลูกคาจองแลวยังไมมา หามโทรออกสายนอก 
สถานะที่ 5 Check In หองไมวาง มลูีกคาเขาพัก ใหโทรออกสายนอก 
สถานะที่ 6 Check In หองไมวาง มลูีกคาเขาพัก ใหโทรออกสายนอก 
สถานะที่ 7 Check In หองไมวาง มลูีกคาเขาพัก ใหโทรออกสายนอก 
สถานะที่ 8 Check In หองไมวาง มลูีกคาเขาพัก ใหโทรออกสายนอก 
สถานะที่ 9 Check In หองไมวาง มลูีกคาเขาพัก ใหโทรออกสายนอก 

 
 
P266 กําหนดกลุมสายในที่ใชเชื่อมตอ (Ext.-Link Assignment) 
 กําหนดกลุมสายในที่ใชเชื่อมตอ (Link) แบบ Analog Link โดยจะกําหนดใหกลุมสายใน
 นั้นๆ เชื่อมตอ (Link) แบบ Analog Link ไดหรือไม   
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P267 กําหนดสัญญาณ  (E&M Signaling ) 
 กําหนดสัญญาณ Signaling สําหรับแผงวงจร E&M 
 

 
 
 

P269 กําหนดการโอนกลับ  (Transfer Back Assignment ) 
  - เมื่อมีการเปดใชงาน : หากโอนสายไปแลวไมมีผูรับสาย ระบบจะทําการโอนสาย
 กลับไป ยังผูที่โอนสายให 
  - เมื่อปดการใชงาน : หากโอนสายไปแลวไมมีผูรับสาย ระบบจะทําการโอนสาย
 กลับไปยัง OGM เพื่อใหกดเรียกหมายเลขภายในใหมอีกครั้ง 
 

 
 

 คล้ิกถูกในกลุมที่ตองการใหทํางาน 
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บทที่ 5 
 

โปรแกรมการคิดเงิน P3XX Relay & Sensor Programming 
 การโปรแกรมเกี่ยวกับการทํางานของรีเลยที่อยูบนแผง AUX (Auxiliary) JSD-AUX /DX-
AUX จะมีรีเลยพอรตอยู 4 พอรต, แผง ONO (Output Normal Open) JSD -ONO / DX -ONO จะมี
รีเลยพอรต 16 พอรต และในสวนโปรแกรมการทํางานของ Sensor-Alarm ใน DX-AUX/JSD-AUX 
และที่จะมีในอนาคต ในที่นีถู้กแบงเปน 5 กลุม คือ 
 1. P3XX Relay 
 2. P3XX Relay Time Control 
 3. P3XX Sensor 

4. P3XX Alarm 
5. P3XX User Code 

1. Relay 
คลิกเลือก P3XX Sensor & Relay Programming -> Relay จะแสดง Page ดังรูป  
 

 
 
P300  กําหนดหมายเลขรีเลย (Number of Relay) 
 เปนการกําหนดหมายเลขใหกับรีเลยเพื่อใหรับคําสั่งการใชงาน โดยคาจากโรงงานจะกําหนด 
ให รีเลย 1-16 เปนหมายเลข 1-16 ตามลําดับ และรีเลยที่ 17-256 เปนหมายเลข 1001-240 ตามลําดับ 
คําสั่งการใชงานรีเลยมี 2 แบบดังนี ้
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 1. คําสั่งควบคุมการปด-เปดรีเลย บนแผง JSD-AUX/DX-AUX และ JSD-ONO/DX-ONO 
 *56*0[Relay]#[Relay]#[ ]#[ ]#...  ; 0 = off, Relay = Relay Number in P300 
 *56*1[Relay]#[Relay]#[ ]#[ ]#...  ; 1 = on, Relay = Relay Number in P300 

2. ควบคุมการเปด/ปดระบบ ECS บนแผง JSD-AUX/DX-AUX และ JSD-ONO/DX-ONO 
 *56[0-9]*[Relay]# [Relay]#[ ]#... 
 *56[0-9]*[Relay]*[Money]# 
โดย Relay Number ตามคําสั่งการใชงานนี้ จะอางอิงหมายเลขตามโปรแกรม P300 นี้ 

หมายเลขนี้จะตรงกับหมายเลขโทรศัพทก็ได  
 

P301  กําหนดกลุมรีเลย (Group of Relay) 
 กําหนดกลุมของรีเลย โดยคาจากโรงงาน กําหนดใหรีเลยทุกตวัอยูกลุมที่ 32 สามารถกําหนด
ไดกลุมที่ 1-32 เทานั้น P301 เปนการกาํหนดกลุมใชงานใหกับรีเลย เพื่อกําหนดความแตกตางของ
รีเลยในแตละตัว โดยมีโปรแกรม P302, P303, P304, P306 เปนตัวกําหนดความแตกตาง 
 
P302  การควบคุมรีเลย (Relay Mode) 
 กําหนดลักษณะโหมดการทํางานของรีเลย แบงออกเปน 4 โหมด 
 โหมดที่ 1 ปกติ เปนโหมดที่รีเลยจะทํางาน เมื่อไดรับ คําสั่งปด-เปดจากตูสาขาฯ เทานัน้ 
ตองการใหรีเลยทํางานในโหมดนี้ให กําหนดเปน “0” โดยคาจากโรงงานจะอยูในโหมดนี ้
 โหมดที่ 2 รีเลยทํางานพรอมกับ Extension โดยรีเลยจะทํางาน เมื่อมีสัญญาณกระดิ่งเรียก 
Extension หรือมีการยกหูโทรศัพท Extension นั้นๆ ตองการใหงานในโหมดนีใ้ห กําหนดเปน “1” 
เหมาะสําหรับนํารีเลย ไปควบคุมการปด-เปด เครื่องแฟกซ  
 โหมดที่ 3 รีเลยทํางานเมื่อมกีารสั่ง Paging หากตองการทํางานในโหมดนี้ Paging 1 กําหนด
เปน “11” และ Paging 2 กําหนดเปน “12” เหมาะสําหรับนํารีเลย ไปควบคุมการปด-เปดเครื่องเสียง 
 โหมดที่ 4 รีเลยทํางานเมื่อมีการใชงาน พอรต RS232A, RS232B หากตองการทาํงานใน
โหมดนี้ กําหนดเปน “21” พอรต RS232A และ กําหนดเปน “22” พอรต RS232B เหมาะสําหรับไป
ควบคุมการปด-เปด Printer 
 การเลือกโหมด 2-4 จะตองกาํหนดการหนวงเวลาปดทีเ่หมาะสมตามตองการ  
 
P303  กําหนดการหนวงเวลาปดชดุควบคุมรีเลย (Hold Time Setting) 
 กําหนดระยะเวลาการหนวง เมื่อทําการเปดรีเลยไวแลวระบบจะหนวงเวลาไวสักครูแลวจะทํา
การปดอัตโนมัติ โดยคาจากโรงงานกําหนดระยะเวลาการหนวงเทากบั 5 วินาท ี เปนการทํางานบน
แผงวงจร JSD-AUX/DX-AUX และ JSD-ONO/DX-ONO 
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P304  เลือกรีเลยใหกลับทิศทาง ปด-เปด (Relay Inverse Mode) 
 กําหนดขั้วของรีเลยทํางานตรงกันขามบนแผงวงจร JSD-AUX/DX-AUX และ JSD-ONO 
/DX-ONO 
 
P306  กําหนดหมายเลขโทรศัพทท่ีจะไปแจงเตือน (ECS. Warning Number) 
 เมื่อตั้งใหเปดใชงานไฟฟาชัว่คราว แลว กอนการตัดไฟ 10 นาที จะมสัีญญาณกระดิง่เตือนที่
หมายเลข Extension ที่เราไดกําหนดไว สามารถระบุ Extension ที่จะมีสัญญาณกระดิ่งเตือนกอนการ
ตัดไฟ 10 นาทีไดเลย  
 
P305  กําหนดการเลือกใชงานรีเลย Relay Slot 
 กําหนด (แผง JSD-AUX/DX-AUX และ JSD-ONO/DX-ONO) วาเสยีบใหงานอยู Slot ไหน, 
และใหใชงาน Relay Hardware ที่เทาไหร, Relay Hardware ใน P305 จะรองรับรีเลยพอรตทั้งหมด 
256 พอรต โดยแบงเปน Relay Hardware ที่ 1 อยูระหวางพอรต 1-16, Relay Hardware ที่ 2 อยู
ระหวางพอรต 17-32 ตามลําดับ จนถึง Hardware ที่ 16 อยูระหวางพอรต 241-256 เชน เสียบแผงใช
งานอยูที่ Slot 3 และ 4 ตามลําดับ โดยใหแผงใชงาน Slot ที่ 3 เปน Relay Hardware ที่ 1 (พอรต 1-16)
และแผงใชงาน Slot ที่ 4 เปน Relay Hardware ที่ 2 (พอรต 17-32)  

   
จากโปรแกรม  
 - Slot ที่ 3 เปนRelay Hardwareที่ 1(พอรต 1-16 เทากับหมายรีเลย 1-16): Default P300 
 - Slot ที่ 4 เปนRelay Hardwareที่ 2(พอรต 17-32 เทากับหมายรีเลย 1001-1016): Default P300 
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2. Relay Time Control 
คลิกเลือก P3XX Sensor & Relay Programming -> Relay Time Control จะแสดง Page ดังรูป  
 

 
 

P309  การเปด-ปด ชดุควบคุมรีเลย ตามเวลา Timer Control Setting 
 ตั้งเวลาควบคมุการเปด-ปด รีเลย เมื่อถึงเวลาที่กําหนด ตามรูปแบบที่ตองการโดยสามารถ
 กําหนด Step การควบคุมไดสูงถึง 200 Step โดยที่ใน 1 Step สามารถกําหนดวนั/เวลาในการ
 ควบคุมได จนัทร-อาทิตย ระหวางเวลา 08:00-23:59 (ช่ัวโมง:นาที) และกําหนดรปูแบบการ
 หนวงเวลาปดไดสูงถึง 32 รูปแบบใน 1 Step นอกเหนือจากการสั่งเปด-ปดแบบธรรมดา  
 
P307  การตั้งคาเวลาของระบบควบคุมไฟฟา (ECS. Timer) 

จากคําสั่งการเปดไฟ *56[0-9]*[Relay]# [Relay]#[ ]#... 
 [0-9] นั้น ปุมกดหมายเลข 0 เปนการสั่งปดไฟ ไมวาจะเปดแบบไหน 
  ปุมกดหมายเลข 9 เปนการสั่งเปดไฟถาวร จนกวาจะสั่งปดไฟ 
                 ปุมกดหมายเลข 1-8 เปนการสั่งเปดไฟชัว่คราวตามเวลาที่ตั้งไวในขอนี้และจะ 
                                                              อางอิงโหมดการทาํงาน ตาม P308 ดวย 
  ปุมกดหมายเลข 10-16 สํารองไวใชงาน 
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P308  โหมดการทํางานของระบบควบคุมไฟฟา (ECS.Mode) 
 เปนการเลือกโหมดการทํางานของระบบควบคุมไฟฟา แบงออกเปน 7 โหมดคือ 
 ปุมกด 1 (โหมด1)  กําหนดเวลาเริม่ตนใชงาน เชน เร่ิมตน 3 ช่ัวโมง เปนตน ตองกดใชงาน
  โหมดนี้ใหกําหนดเปน “1” 

ปุมกด 2 (โหมด2) เปนโหมดตอเวลาใชงานจากเวลาเริ่มตนเดิม เชน เดิมตัง้เวลาไว 3 ช่ัวโมง 
 และตอเวลาเพิม่อีก 1 ช่ัวโมง รวมจะมีเวลาใชงานเปน 4 ช่ัวโมง ใชงาน
 โหมดนี้กด “2” 

ปุมกด 3(โหมด3)   เปนการกําหนดเวลาเริ่มตนเชนกัน โดยจะระบุเวลาใชตามเวลานาฬกิา 
 จะแตกตางกับโหมด 1 คือ 03:00 โหมด 1 หมายถึง 3 ช่ัวโมง, แตโหมด 3 
 หมายถึง ตีสาม ใชงาน โหมดนี้กด “3”  
ปุมกด 4 (โหมด4) จะเหมือนกับโหมดที่ 1 ตางกันที่ โหมด 4 เมื่อใกลหมดเวลาใชงาน 10 
 นาทีจะไมมีการแจงเตือน ใชงานโหมดนีก้ด “4” 
ปุมกด 5(โหมด5)   จะเหมือนกับโหมดที่ 2 ตางกันที่ โหมด 5 เมื่อใกลหมดเวลาใชงาน 10 
 นาที จะไมมีการแจงเตือน ใชงานโหมดนีก้ด “5” 
ปุมกด 6 (โหมด6) จะเหมือนกับโหมดที่ 3 ตางกันที่ โหมด 6 เมื่อใกลหมดเวลาใชงาน 10 
 นาที จะไมมีการแจงเตือน ใชงานโหมดนีก้ด “6” 

 ปุมกด 7 (โหมด7) กําหนดเวลาเริม่ตนใชงาน หนวยเปน วินาที 
 ปุมกด 8 (โหมด8) เปดการใชงานจนกวาจะมีการสั่งปด แบบที่ 1 
 ปุมกด 9 (โหมด9) เปดการใชงานจนกวาจะมีการสั่งปด แบบที่ 2 
 ปุมกด 10-16 (โหมด10-16) สํารองไวใชงาน  
 
P311  กําหนดอัตราใชงานของชดุควบคุม เปด-ปด ไฟฟา  (ECS. Rate) 
 เปนการกําหนดการใชงาน การใชไฟฟาโดยสามารถใสได 1- 65535 Rate โดยจะอางอิงการ
 ทํางานรวมกับ P306, P307 
 
P310 กําหนดชวงเวลาเริ่มตนเปด ชุดควบคุมรีเลย  (Relay Initial Time) 
 กําหนดชวงเวลาการเริ่มตนของรีเลยเมื่อเปดระบบ สามารถกําหนดคาไดตั้งแต 0-64 (วินาท)ี 
 คาจากโรงงาน  เทากับ 8 เปนการตั้งคาหนวงเวลาการเริ่มตนทํางานของรีเลยทั้งหมดใน
 ระบบ เชน กําหนดคา เปน 10 (วินาที), โดยมีรีเลยพอรตใชงานทัง้หมด 32 พอรต ที่ส่ัง On 
 รีเลยอยู เมื่อเกดิไฟดับ  หรือ Reset ระบบ รีเลยทั้ง 32 ตัว Off และ On ตัวเองใหมโดยจะ
 คอยๆ On รีเลยใหครบทั้ง 32 ตัว ในเวลา 10 วินาท ี 
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P312 กําหนดเวลาเตอืนเมื่อ ECS.ใกลหมดเวลาใชงาน (ECS. Warning Times)   
 เราสามารถกําหนดใหมีสัญญาณกระดิ่งแจงเตือนที่เครือ่งโทรศัพท เมื่อ ECS ใกลหมดเวลาใช
 งานได (กําหนดการใชงานที่ P306 ECS. Warning Number) โดยใน P312 จะเปนตัวกําหนด
 วาเหลือเวลาใชงาน ECS. อีกกี่นาทจีึงจะแจงเตือน (Default : 10 นาที) 
 โหมด 1  :  กําหนดเวลาแจงเตือนเมื่อ ECS. ใกลหมดเวลาใชงาน สามารถกําหนดคาไดตั้งแต 
 0-99 นาที เชน กําหนดคาเปน “5” หมายความวาจะมีสัญญาณกระดิ่งเตอืนที่เครื่องโทรศัพท 
 เมื่อเวลาใชงาน ECS. เหลืออีก 5 นาท ี
 โหมด 2 : กําหนดระยะเวลาการแจงเตอืนที่เครื่องโทรศัพท (สัญญาณกระดิ่ง) สามารถ
 กําหนดคาตั้งแต 0-99 วินาที เชน กําหนดคาเปน “30” จะมีสัญญาณกระดิ่งเตือนนาน 30 
 วินาท ี
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3. Sensor 
คลิกเลือก P3XX Sensor & Relay Programming -> Sensor จะแสดง Page ดังรูป  
 

 
 

P321  กําหนดชื่อเซ็นเซอร (Sensor Name) 
 สามารถกําหนดชื่อของอุปกรณตรวจจับไดทั้งหมด 256 โซน เพื่อความสะดวกในการจดจํา
 ในภายหลัง 
 

P322 กําหนดการทํางานของเซ็นเซอร  (Sensor Assignment) 
 เปนการกําหนดเอาทพุตของ Sensor ที่ 1-256 ใหไป Alarm ที่ไหน โดยในระบบจะมี Alarm 
 ทั้งหมด 8 Alarm (Alarm ที่ 1-4 ยังใชงานไมไดจะใชงานในอนาคต, Alarm ที่ 5-8 ปจจุบันใช
 งานไดแลว) โดยระบบสามารถโปรแกรมวาเมื่อ Sensor ทํางานให Alarm ทํางานทันที หรือมี
 เวลา Delay กอนที่จะ Alarm ทํางาน (อางอิงและ Delay จาก P331, P332) 
 

P320  กําหนดสลอตของเซ็นเซอร (Sensor Slot) 
 กําหนด (แผง JSD-AUX และ DX-AUX) วาเสียบใชงานอยู Slot ไหน ซ่ึงในปจจุบัน 
 Hardware ของ Sensor และ Alarm จะติดตั้งอยูบนแผง AUX เทานั้น Sensor Hardware 
 ทั้งหมดมี 256 พอรต โดยแบงเปน Sensor Hardware ที่ 1 อยูระหวางพอรต 1-16, Sensor 
 Hardware ที่ 2 อยูระหวางพอรต 17-32 ตามลําดับ 
 หมายเหตุ... แผง AUX จะถูกกําหนดเปน Sensor Slot “33” 
 

P324 กําหนด (INVERSE) 
 เปนการเลือกกลับการทํางานของเซ็นเซอร (จะทํางานในอนาคต) 
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4.    Alarm  
คลิกเลือก P3XX Sensor & Relay Programming -> Alarm  จะแสดง Page ดังรูป 
 

 
 

P 330    การกําหนดชื่อของ Alarm (Name of Alarm ) 
              สามารถกําหนดชื่อไดสูงสุด 8 อักษร 
P 331    การกําหนดชวงเวลา Delay 1 (Entry Delay1 ) 
              เปนการกําหนดชวงเวลาหนวงชวงแรก สามารถกําหนดชวงเวลาหนวงไดสูงสุด 255 วินาท ี
 (คาจากโรงงานกําหนดเปน 20 วินาท)ี 
P 332    การกําหนดชวงเวลา Delay 2 (Entry Delay2 ) 
              เปนการกําหนดชวงเวลาหนวงชวงแรก สามารถกําหนดชวงเวลาหนวงไดสูงสุด 255 วินาท ี
 (คาจากโรงงานกําหนดเปน 180 วินาที) 
P 333    การกําหนดเวลาสิ้นสุดการหนวงเวลา (Exit Delay) 
            เปนการกําหนดชวงเวลาสิ้นสุด ของชวงเวลาทีห่นวงไว  สามารถกําหนดชวงเวลาหนวงได
 สูงสุด 255 วินาที (จะทํางานในอนาคต) 
P 334    การกําหนดการหนวงเวลาใชงานของ Alarm (Reset Time) 
              เปนการตั้งเวลาหนวงใชงานหลังจาก Alarm เร่ิมทํางานแลว โดยคาจากโรงงานตั้งเวลาหนวง
 ให Alarm 5 นาที เชน ตั้งเวลาหนวงไว 1 นาที คือเมื่อ Alarm เร่ิมทํางานแลวจะหยุดทํางาน
 ภายใน 1 นาท ี
P 335    การกําหนดการทํางานของรีเลยเพื่อสั่งสัญญาณเตือน (Alarm Option) 
            เปนการกําหนดการทํางานของรีเลยเพื่อส่ังสัญญาณเตือน โดยใชการเลือกการทํางานของ
 รีเลยตัวตางๆในชองของรีเลย 1-8 (จะทํางานในอนาคต) 
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P 336   การกําหนดสญัญาณเตือนท่ีรีเลย (Alarm Output) 
             สามารถกําหนด Alarm Output ใหมีสัญญาณแจงเตือนที่รีเลยไดสูงสุด 4 พอรตพรอมกนั 
P 337    การกําหนดสญัญาณเตือนไปท่ีเบอรภายใน (Alarm to Extention) 
             สามารถกําหนดระดับสัญญาณเตือนออกทีเ่ครื่องโทรศัพท ภายใน  ได 4 Extension พรอมกัน 
P 338    การกําหนดสญัญาณเตือนท่ีสายนอก (to CO. Line) 
             สามารถกําหนดระดับสัญญาณเตือนออกทีส่ายนอก (จะมใีนอนาคต) 
P 339    การกําหนดสญัญาณเตือนท่ีเบอรท่ีกําหนด (Alarm Dial Number) 
            เปนการกําหนดใหสัญญาณเตือนโทรออกไปที่เบอรที่เรากําหนดไวได 4 เบอร (จะมใีน
 อนาคต) 
 
5.  User Code  
             คลิกเลือก P3XX Sensor & Relay Programming -> User Code  จะแสดง Page  ดังรูป 

 

 
 
P 340   การกําหนดรหัสของผูใชงาน (User Code) 
              เปนการรหัสของผูใชเพื่อในการสั่งงานรีเลย (จะมีในอนาคต) 
 

P 341   การกําหนดสัญญาณเตือนตําแหนงท่ีติดตัง้ไว (User Area) 
              เปนการกําหนดสัญญาณเตือนในตําแหนงที่ตดิตั้งไว (จะมใีนอนาคต) 
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บทที่ 6 

โปรแกรมการคิดเงิน P4XX Billing Programming 

เปนโปรแกรมเกี่ยวกับการคิดเงิน โดยอาศัยฐานขอมูลการคิดเงินภายในระบบ สําหรับ
โปรแกรมคอนฟกบิ้วเดอร แบงโปรแกรมเกี่ยวกับการคิดเงินออกเปน 5 กลุม คือ 

1. Incoming/Intercom Charge 
2. Outgoing Charge 
3. Telephone Mapping Table 
4. Tax & Service Charge 
5. Mini Bar 

1. Incoming / Intercom Charge 
 เปนการโปรแกรมระบบการคิดเงินของตูสาขา ใหสามารถคิดเงินการโทรเขา และคิดเงินการ
โทรภายในตามความตองการของผูใช 

คลิกเลือก P4XX Billing Programming -> Incoming/Intercom Charge จะแสดง Page ดังรูป  
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P400 ใหคิดการโทรภายใน (Intercom Call Charge)   
 การตั้งคาใหคดิเงินจากการโทรภายใน  
 
P401 กําหนดเวลาชวงแรก ของการโทรภายใน (Intercom First Time) 
 ชวงเวลาแรกของการโทรภายในกําหนดไดดังนี้  คือ 0-255 (จํานวนหนวยเปนนาท)ี  
 คาจากโรงงานกําหนด 30 นาที   (การอานคาสมมติเปน X นาที) 
 
P402 กําหนดอัตราการใชชวงแรก ของการโทรภายใน (Intercom First Rate) 

อัตราการใชชวงแรก คาที่สามารกําหนดไดดังนี้  คือ 0-65534 (จํานวนหนวยเปนบาท) 
คาจากโรงงานกําหนดศูนยบาท   (การอานคาสมมติเปน Y บาท) 

 
P403 กําหนดหนวยเวลา ของการโทรภายใน (Intercom Unit Time) 

การคิดคาโทรตอหนวยเวลา คาที่สามารถกําหนดได  คือ 0 (1 คร้ังตอหนวย) 
  หรือ 1-60 (1-60 นาที ตอหนวย)  หรือ 61-90 (1-30 วินาทีตอหนวย) 

คาจากโรงงานกําหนด 15   คือ 15 นาที ตอหนวย    (การอานคาสมมติเปน U หนวยนาที) 
 

P404  กําหนดอัตราคาใชตอหนวยของหนวยการโทรภายใน (Intercom Unit Time)  
 การโปรแกรมคาที่สามารกําหนดไดดังนี้  คือ 0-65534 (จํานวนหนวยเปนบาท) 
 คาจากโรงงาน 0 บาท   (การอานคาสมมติเปน Z บาท) 
  
P405  กําหนดกลุมสวนลดคาบริการของการโทรภายใน (Intercom Discount) 
 การโปรแกรมคาที่สามารกําหนดไดดังนี้  คือ 1-32 (กลุมสวนลดที่ 1-32) 
 

                     
 
 ** การอานคา X นาทีแรก Y บาท ตอไป Z บาทตอหนวยเวลา U 

  
เลือกคาที่ตองการ 
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P410  ใหคิดเงินการโทรเขา (Incoming Call Charge)  
การตั้งคาใหคดิเงินการโทรเขาจากสายนอก  

 
P411  กําหนดเวลาชวงแรก ของการโทรเขา (Incoming First Time) 
 ชวงเวลาแรกของการโทรเขากําหนดไดดังนี้  คือ 0-255 (จํานวนหนวยเปนนาท)ี  
 คาจากโรงงานกําหนด 15 นาที    (การอานคาสมมติเปน X นาที) 
 
P412  กําหนดอัตราการใชชวงแรก ของการโทรเขา (Incoming First Rate) 

อัตราการใชชวงแรก คาที่สามารถกําหนดไดดังนี้  คือ 0-65534 (จํานวนหนวยเปนบาท)
  
คาจากโรงงานกําหนดศูนยบาท   (การอานคาสมมติเปน Y บาท) 
 

 P413  กําหนดหนวยเวลาของการโทรเขา (Incoming Unit Time) 
การคิดคาโทรตอหนวยเวลา คาที่สามารถกําหนดได  คือ 0 (1 คร้ังตอหนวย) 

  หรือ 1-60 (1-60 นาที ตอหนวย)  หรือ 61-90  (1-30 วินาทีตอหนวย) 
คาจากโรงงานกําหนด 0 (1 คร้ังตอหนวย)    (การอานคาสมมติเปน U หนวยนาท)ี 
 

 P414   กําหนดอัตราการใชตอหนวยเวลาของการโทรเขา (Incoming Unit Rate)  
การโปรแกรมคาที่สามารถกําหนดไดดงันี้  คือ 0-65534 (จํานวนหนวยเปนบาท) 
คาจากโรงงานกําหนดเปน 0    (การอานคาสมมติเปน Z บาท) 
 

P415  กําหนดกลุมสวนลดคาบริการของการโทรเขา (Incoming  Discount Group)  
การโปรแกรมคาที่สามารถกําหนดไดดังนี้  คือ 1-32 (กลุมสวนลดที่ 1-32) 
คาจากโรงงานกําหนดกลุมที่ 1 
  

                                                        
 

 ** การอานคา X นาทีแรก Y บาท ตอไป Z บาทตอหนวยเวลา U 

เลือกคาที่ตองการ
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P437  กําหนดลักษณะการพิมพบิล (Billing Mode)  
การโปรแกรมคลิกเลือกกําหนดการใชงานดังนี ้
Mode1_Normal   หมายถึง  รูปแบบการพมิพปกต ิ

 Mode2_Second Rounding หมายถึง  รูปแบบการพมิพปดเศษวินาที 
 Mode3_Delete Repeated  หมายถึง  ตัดขอมูลซํ้าในเวลาเดยีวกัน 
 Mode4_Second Rounding & Delete Repeated item หมายถึง ตัดขอมูลซํ้าและปดเศษวินาที 
 
คาจากโรงงานกําหนด กําหนด Mode3_Delete Repeated (ตัดซ้ําขอมูลเดียวกัน) 
 

             
 
การโปรแกรมใหคิดเงินดวยสญัญาณ Pulse Metering 
P440  กําหนดใหคิดเงินดวยสัญญาณ Pulse Metering  
 

                    
 
P441   กําหนดอัตราเมื่อไมไดรับพลัส (Pulse Metering First Rate) 

การโปรแกรมคาที่สามารถกําหนดไดดังนี้  คือ 0-65534 (จํานวนหนวยเปนบาท) 
คาจากโรงงานกําหนด 0 

P442  กําหนดอัตราคาใชชวงแรกของ Pulse (Pulse Metering Unit Rate) 
การโปรแกรมคาที่สามารถกําหนดไดดังนี้  คือ 0-65534 (จํานวนหนวยเปนบาท)  
คาจากโรงงานกําหนด 2 

P443  กําหนดอัตราคาโทรตอพัลส (Pulse Metering Unit Rate)  
การโปรแกรมคาที่สามารกําหนดไดดังนี้  คือ 0-65534 (จํานวนหนวยเปนบาท) 
คาจากโรงงานกําหนด 1 

    คลิกเครื่องหมายถูก กําหนดใหคิดเงินดวย Pulse metering 

    คลิกเลือกลักษณะการพิมพบิล 
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2. Outgoing  Charge  
คลิกเลือก P4XX Billing Programming -> Outgoing Charge จะแสดง Page ดังรูป  

 
 
รายละเอียดและขอกําหนดในการโปรแกรมแตละ Pxxx ของ Page Outgoing Charge  มีดังนี้  
P420 ใหคิดเงินการโทรออกสายนอก (Outgoing Call Charge)   

การโปรแกรมคลิกเครื่องหมายถูกที่ชอง enable เพื่อกําหนดใหคิดเงินการโทรออกสายนอก 
คาจากโรงงานจะตั้งใหระบบคิดเงินการโทรออกสายนอก 

 
P429 พิมพรายงานใหรายละเอียดของกลุมการโทรออก (List of Outgoing Group) 

การตั้งใหลิสตรายละเอียดการโทรออกของแตลกลุมหรือไม 
การดับเบิ้ลคลิกเลือกกลุมการโทรออก มีหนาตาง Array ชวย   
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กลุมการโทรออก    Outgoing Group เปนกลุมที่จะนํามาคิดเงินการโทรออก  ในระบบจะมี
ตารางการโทรออกเพื่อคิดเงิน 2,048 ตาราง (ที่ P424, P425, P426, P427) ซ่ึงจะกลาวถึงในหัวขอตอไป 
โดยจะนําตารางการโทรออกทั้งหมดมาจัดเปนกลุมของตารางการโทรออกเพื่อสะดวกในการคํานวณ 
เชน กลุมการโทรออกที่ 1 สําหรับคิดเงินการโทรออกไปหมายเลขปลายทางทองถ่ิน หรือ กลุมการ
โทรออกที่ 3 สําหรับคิดเงินการโทรออกไปหมายเลขที่เปนทางไกล 

 
 จากหนาจอของ Config Builder 
  
 

 
 

อัตราคาโทรออก 
P421  กําหนดชวงเวลาชวงแรกของการโทรออก (Outgoing First Time) 
 ชวงเวลาแรกของการโทรออกกําหนดไดดงันี้  คือ 0-255 (จํานวนหนวยเปนนาท)ี  
 (การอานคาสมมติเปน X นาที) 
 
P422  กําหนดอัตราคาใชชวงแรก ของการโทรออก (Outgoing First Rate) 

อัตราการใชชวงแรก คาที่สามารถกําหนดไดดังนี้  คือ 0-65534 (จํานวนหนวยเปนบาท) 
(การอานคาสมมติเปน Y บาท) 
 

P423  กําหนดเวลาตอคาบของการโทรอก (Outgoing  Unit Time) 
การคิดคาโทรตอหนวยเวลา คาที่สามารถกําหนดได  คือ 0 (1 คร้ังตอหนวย) 

  หรือ 1-60 (1-60 นาที ตอหนวย)  หรือ 61-90 (1-30 วินาทีตอหนวย) 
 (การอานคาสมมติเปน U หนวยนาท)ี 
 

** การอานคา X (P421) นาทีแรก Y (P422) บาท ตอไป Z (P424) บาทตอหนวยเวลา U (P423) 

กลุมการโทรออก กําหนดใหคดิเงินการโทร ดับเบิ้ลคลิกเลือกกลุม 
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P428   กําหนดชื่อของกลุมตารางการโทรออก (Outgoing Group Name) 
ช่ือของกลุมการโทรออก การโปรแกรมคาที่สามารถกําหนดไดดังนี้  คอื  

Local = พื้นที่เดยีวกัน 
Mobile = มือถือ 
Long Distance = ตางจังหวัด 
Over Sea = ตางประเทศ 
Free = ฟรี 
Y-Tel = Y-Tel 
A-Text&Bug = A-Text&Bug 
Pin-P = Pin-P 
Other = อ่ืนๆ 
Malaysia = มาเลเซีย 
Cambodia, Burma = กัมพูชา, พมา 
Loa = ลาว 
Group 13 =  กลุมที่ 13 
Group 14 =  กลุมที่ 14 
Group 15 =  กลุมที่ 15 
Group 16-32 =  กลุมที่ 16-32 

 
การตั้งสวนลดตามชวงเวลา 
P430  กําหนดชวงเวลาของกลุมสวนลดคาบริการ (Time Bank Setting) 
 ในแตละกลุมการโทรออก สามารถตั้งสวนลดตามชวงเวลาในแตละวนั เปน 4 เวลา ตั้งเวลา
แบบ 24 ช่ัวโมง โดยมีเงื่อนไข ดังนี้ ชวงเวลาที่ 1 < ชวงเวลาที่ 2 < ชวงเวลาที่ 3 < ชวงเวลาที่ 4 
 ตัวอยางการแบงชวงเวลาในกลุมที่ 3 
 
 
 
 
 
 
 
 

 

 นาฬิกา 24 ช่ัวโมง 

    24 

    12 

    6     18 
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P431 กําหนดตัวคูณของอัตราสวนลดคาใชตอหนวย (Unit Rate Multiplier) 
P432  กําหนดตัวหารของอัตราสวนลดคาใชจายตอหนวย (Unit Rate Divider) 

การตั้งคาตัวคณู หรือตวัหาร จะมีคาเปน 1-255  
เชน กลุมที่ 3 การโทรทางไกลตางจังหวัด แบงเวลาเปน  
 ชวงที่ 1 เวลา 07.00-18.00 สวนลด คูณ 1 หาร 1 คาโทรในชวงเวลานี้ ไมลด 
 ชวงที่ 2 เวลา 18.00-22.00 สวนลด คูณ 1 หาร 2 คาโทรลดเหลือคร่ึงหนึง่ 
 ชวงที่ 3 เวลา 22.00-24.00 สวนลด คูณ 1 หาร 3 คาโทรลดเหลือหนึ่งสาม 
 ชวงที่ 4 เวลา 24.00-07.00 สวนลด คูณ 1 หาร 3 คาโทรลดเหลือหนึ่งสาม 
 

การวิเคราะหการโทรออก หรือ ไลนรีเวิรสเทียม  
 การวิเคราะหการโทรออกจะตองกําหนดตั้งแตคร้ังแรกที่ติดตั้งระบบใหลูกคา ระบบจะอาศัย
คาที่กําหนดนี้ในการคํานวณ หรือพิมพรายงานการคิดเงิน 
P433   กําหนดเวลานอยท่ีสุดท่ีจะพิมพบิล (Minimum Time Margin) 

ถาเวลานอยกวาที่กําหนดนี้ จะไมคิดเงินคาโทร คาที่สามารถกําหนดได คือ 0-255 (เวลาหนวย
เปนนาที) 
 

P434   กําหนดจํานวนหลักนอยท่ีสุดท่ีจะพิมพบิล (Minimum Digit Margin) 
ถาจํานวนหลักที่โทรออกนอยกวาที่กําหนดจะไมพิมพบิล คาที่สามารถกําหนดได คือ 0-20 
(จํานวนหลัก) 
 

P435  เวลาบวกเพิ่มจากการใชงานเพื่อการพิมพบิล (Additional Billing Time) 
เพื่อใหมีความถูกตองในการออกบิลมากขึ้น โดยการบวกเวลาเพิ่มในแตละเลขหมายโทรออก 

คาที่สามารถกําหนดได คือ 0-255 (เวลาหนวยเปนนาท)ี 
 

P436  กําหนดใหพิมพบิล ออกมาก่ีหลักของรหัสท่ีโทรออก (Printed Billing Digit) 
ไมวาลูกคาจะกดหมายเลขโทรออกกี่หลัก จะพิมพรายงานไดเพียงไมเกินจํานวนหลักที่
กําหนดนี้ 

คาที่สามารถกําหนดได คือ 0-20 (จํานวนหลัก) 
 

P437  กําหนดลักษณะการพิมพบิล (Billing Mode) ดูในที่อธิบายแลว ในหนากอนหนานี ้
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3. Telephone Mapping Table  
คลิกเลือก P4XX Billing Programming -> Telephone Mapping Table จะแสดง Page ดังรูป  

 
  

 
 

 

 
 
 

 

 

 

ตาราง 

การโทรออก 

กําหนดอัตราคาใชตอ  
หนวยเวลาโทรออก 

หมายเลข 
ปลายทาง 

กําหนดชื่อของเลขหมายปลายทาง 

กําหนดกลุมของตารางการโทรออก 
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รายละเอียดและขอกําหนดในการโปรแกรมแตละ Pxxx ของ Page Telephone Mapping Table  มีดังนี้  

P424 กําหนดอัตราคาใชตอหนวยเวลาโทรออก (Outgoing Unit Rate) 
คาในโปรแกรมนี้ขึ้นกับคาของ P427 ซ่ึงเอาตารางทั้งหมดไปเขากลุม 
ถาคาของ P427 เปนกลุมการโทรออก 1-32 คาที่สามารถกําหนด คือ 0-65534 (จํานวนเงิน 
บาท) 
ซ่ึงจะใชงานรวมกับ P421, P422, P423 
ถาคาของ P427 เปนกลุมการกระโดด คาในโปรแกรม P424 นี้ จะเปนระยะทางการกระโดด 
 

 ** สังเกต คา X, Y, U คิดเปนกลุม แตคา Z คิดตามหมายเลขที่โทรออกจาก 2,048 ตารางการ
โทรออก 
 
P425 หมายเลขปลายทางของตารางการโทรออก (Table of Outgoing Dial Number) 

กลุมหมายเลขขึ้นตนของการโทรออก 
คาที่สามารถโปรแกรมไดเปนตัวเลข 14 หลัก 
 

P426 ชื่อของหมายเลขปลายทางของตารางโทรออก (Name of Outing Dial Number) 
ช่ือของกลุมหมายเลขขึ้นตนของการโทรออก 
คาที่สามารถโปรแกรมไดตวัอักษรหรือตัวเลขขนาด 8 หลัก 
 

P427 กําหนดกลุมของตารางโทรออก (Outgoing Group Assignment) 
เปนการนําตารางทั้ง 2,048 ตารางไปจัดกลุมการโทรออก หรือ การกระโดดไปยังตารางที่
ตองการ  
คาที่สามารถกําหนดได คือ 1-32 (กลุมการโทรออกที่ 1-32) 
   = 98 (กระโดดไปทีต่าราง T+(P424)) 
   = 99 (กระโดดไปทีต่าราง P424) 
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4. Tax & Service Charge  
คลิกเลือก P4XX Billing Programming -> Tax & Service Charge จะแสดง Page ดังรูป  

 

 
 

P445  กําหนดตัวคูณจํานวนเงิน (Money Multiplier)    
ระบบตัวเลขการคิดเงินภายในตูฯถูกออกแบบอัตราคาโทรเปนเงินบาท หากมีการติดตั้งตูฯ 

และตองการการคิดเงินภายในตูฯที่ไมใชเงินบาทอาจจะไมสามารถใชตัวเลขที่เหมาะสมได ดังนั้น 
ระบบจึงถูกออกแบบใหสามารถนําคาตัวคูณไปคูณกับจํานวนเงินเมื่อคิดเงินได 

ตัวคูณสามารถโปรแกรมไดตามที่กําหนดไวดังนี ้ = × 1   (คูณหนึ่ง)                             
 = × 10  (คูณสิบ) 

 = × 100  (คูณหนึ่งรอย) 
 = div10  (หารสิบ) 
 = div100 (หารหนึ่งรอย) 

 
 
 

  คลิกเลือกตัวคูณจํานวนเงนิที่ตองการ 
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P446  กําหนดชื่อภาษี (Name of Tax)  
เมื่อทํารายงานการคิดเงินคาโทรศัพทของแตละหอง  ระบบสามารถเพิ่มรายการคา

 ภาษีมูลคาเพิ่มตามที่ตองการได 
สามารถกําหนดชื่อไดสูงสุด 16 ตัวอักษร 
 

P447  กําหนดเปอรเซ็นตของภาษี (Percent of TAX) 
การคิดมูลคาภาษี สามารถเปลี่ยนแปลงได เมื่อตองการ เชน การเปลี่ยนภาษีมูลคาจาก 7% เปน 
10% 
คาตัวคูณของภาษี สามารถกําหนดไดเปนตัวเลข 0-255 (หนวยเปนเปอรเซนต) 
 

P448 กําหนดชื่อคาใชจายเพิ่ม (Name of Charge) 
เมื่อทํารายงานการคิดเงินคาโทรศัพทของแตละหอง ระบบสามารถเพิ่มรายการคาบริการ หรือ

 อ่ืนๆตามที่ตองการได 
สามารถกําหนดชื่อสูงสุด 16 ตัวอักษร 
 

P449  ตั้งราคาคดิเงินเพิ่ม (Value of Charge) 
คาใชจายเพิ่มเติม สามารถตั้งชื่อใหม เชน คาบริการ 
คาตัวคูณของภาษี สามารถกําหนดไดเปนตัวเลข 0-255 (หนวยเปนเปอรเซนต) 

 
 
 
 

 
 

 
 
 

  กําหนดชื่อรายการที่ตองเสยีภาษ ี
ตั้งชื่อคาบริการ ที่ตองการ 

ตัวเลขที่จะคณู คาภาษ ี

  ตั้งชื่อของภาษี ที่ตองการ 

ตัวเลขที่จะคณู คาบริการ 
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5. Mini bar 
Mini Bar เปนการคิดเงินคาอาหารของหองพัก โดยสามารถทํารายการจากภายในหองพัก

หรือนอกหองพัก  คาอาหารนี้จะพิมพรายงานออกมาพรอมกับรายงานการใชโทรศัพทของ
เครื่องโทรศัพทภายในนั้นๆ 

JSD-Series สามารถแบงการใชงาน Mini Bar เปน 2 รูปแบบ คือ 
 1.  Room Bar   เปนการปอนรายงานการคิดเงินคาอาหารจากเครื่องโทรศัพทในหองพัก เพื่อ
คิดเงินคาอาหารในหองพักนั้น 

2. Counter Bar เปนการปอนรายการคิดเงินคาอาหารจากเครื่องอื่นๆ ในระบบตูสาขา (ที่
ไมใชเครื่องในหองพัก)เพื่อคิดเงินคาอาหารในหองพักนั้น 
 คําสั่งการปอนมินิบารจากโทรศัพทภายในหองพัก 
   *49[xxxx]*mm1nn1*mm2nn2*mm3nn3*…# 
 คําสั่งการปอนมินิบารจากเครื่องโทรศัพทอ่ืน 
   *48[Ext. No.]*[xxxx]*mm1nn1*mm2nn2*mm3nn3*…# 
 

กอนใชงานจะตองโปรแกรมใหมีรายการอาหารกอน โดยการตั้งชื่ออาหาร และราคาตอหนวย 
ในลําดับของรายการเมนูอาหาร แลวผูปอนรายการอาหาร(หรือแมบาน) จะปอนจํานวน และ ลําดับ
ของรายการอาหาร 

ลําดับของรายการเมนูอาหาร มีลําดับตั้งแต 01-99 
การตั้งราคาตอหนวย ได 0-65534 บาท โปรแกรมที่ P451 
การตั้งชื่ออาหาร เปนภาษาองักฤษ ตั้งได 8 หลัก ที่ P452 
สําหรับผูปอนรายการอาหาร (หรือแมบาน) จะมีหมายเลขประจําตัว ซ่ึงผูดูแลระบบตอง

กําหนดใหแมบานแตละคน ไมมกีารโปรแกรมควบคุมหมายเลขประจําตัวจากตูสาขาโทรศัพท 
 

** ตูสาขาโทรศัพทสามารถปอนคาอาหารจากการพิมพใบเสร็จรับเงิน ซ่ึงสวนนั้นไมเกี่ยวกับมนิิ
บาร 
** รายการคาใชจายของมินิบารจะออกมารวมกันกับคาใชโทรศัพท 

 
P450  ใหคิดเงินรายการอาหาร (Mini bar Charge) 

การโปรแกรม ใหมีการทํางานจะเปน Enable  
 

P451  การตั้งราคารายการอาหาร (Price name) 
การตั้งราคาของอาหารทั้ง 99 รายการ แตละรายการมีราคาได 0-65534 หนวย (บาท) 
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P452  การตั้งชื่อรายการอาหาร (Food name) 

การตั้งชื่อของอาหารทั้ง 99 รายการ ตั้งชื่อได 8 หลัก 
 

จากหนาจอของ Config Builder 
 

 
 

 
 

 
 

กําหนดใหคดิเงินมินิบาร 

ลําดับรายการอาหาร 

กําหนดชื่อรายการอาหาร 

กําหนดราคาอาหาร 
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บทที่ 7 

โปรแกรมการคิดเงิน P8XX System Programming 

เปนโปรแกรมเกี่ยวกับการเวลาทั้งหมด ของตูสาขาโทรศัพท โดยแบงออกเปน การตั้งเวลาใน
สวนของสัญาณกระดิ่ง การหนวงเวลา และในสวนของการตั้งปลุกตางๆ 

1. Parameter 1 เกี่ยวกับฐานเวลาของระบบ 
2. Parameter 2 เกี่ยวกับการตั้งปลุก 
 

1. Parameter 1 
 

 
 

P 801    ชวงตรวจจับสัญญาณกระดิ่งตดิ ( Ringing –on Time Setting ) 
เปนการกําหนดชวงตรวจจับสัญญาณกระดิง่ติด 

P 802    ชวงตรวจจับสัญญาณกระดิ่งดับ ( Ringing –off Time Setting ) 
เปนการกําหนดชวงตรวจจับสัญญาณกระดิง่ดับ 

P 803    ตั้งเวลาการตัดสัญญาณ ( CO. Line Disconnect Time Setting ) 
เปนการตั้งเวลาการตัดสัญญาณ 
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P 804    ตั้งเวลาสัญญาณพักสาย (CO. Line Flash Time Setting) 
เปนการตั้งสัญญาณการพักสายเมื่อเวลาที่สายนอกสงสัญญาณ Flash ออกทางสายนอก 

P 805    กําหนดเวลาการหนวงสัญญาณ (CO. Line Dialing Delay  Time Setting) 
เปนการหนวงเวลา 2 วินาที กอนที่จะสงสัญญาณการโทรออก ไปยังสายนอกตามคําสั่ง

หมายเลขยอ  

P 806    กําหนดเวลาสัญญาณเมื่อทวนซ้ําเลขหมาย  
             (CO. Line  Dialing Delay Time for Redial Setting) 

เปนการหนวงเวลา 2 วินาที กอนที่จะสงสัญญาณการโทรออก ไปยังสายนอกตามคําสั่งการ

โทรซ้ํา  

P 807    กําหนดเวลาการกดรหัสติดตอ (CO. Line  Prefix Code Dialing Delay Time Setting) 
เปนการกําหนดเวลาการกดรหัสติดตอ ระบบจะหนวงเวลาไว 0.4 วินาท ี

P 808    กําหนดเวลาโทรสายดวนอัตโนมัติ (Hot Line Delay  Time Setting) 
เปนการกําหนดเวลาโทรสายดวนอัตโนมตัิ ระบบจะหนวงเวลาไว 4 วินาที กอนที่เครือ่งจะ

ทํางานเปนสายดวน 

P 818   กําหนดชวงเวลาสูงสุดของการใช Flash (Maximum Flash Time Setting) 

         เปนการกําหนดชวงเวลาที่สามารถใช Flash สูงสุดได 

P 811   ตั้งเวลาการเรียกสายนอก (CO. Line Calling Time Setting) 

         เปนการกําหนดชวงเวลาเมื่อทําการโทรออกแลว ไมมีผูรับ ระบบจะมีเสียงตอบรับ หรือใหทํา

การฝากขอความไว (กรณีใชรวมกับ OGM.) 

P 812   ตั้งเวลาการตัดสายนอกเมื่อวางหู (CO. Line Busy Time Setting) 

         เปนการตั้งเวลาการตัดสายนอกเมื่อวางห ูใชรวมกับ OGM. เมื่อเรียกไปยังสายในแลวไมวาง

ระบบจะใหคอย 1 นาที โดยจะมเีสียงแนะนําวา กรุณารอซักครู สวนผูถูกเรียกกจ็ะมสัีญญาณเตือนวามี

สัญญาณคอยจากสายนอก หากเมื่อเลยเวลา ระบบ จะทําการตัดสายใหทนัที 
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P 814   ตั้งเวลาใหยอนกลับผูโอนเมื่อไมมีผูรับสาย (CO. Line Transfer Time Setting) 

         เปนการกําหนดเวลาใหยอนกลับผูโอนเมื่อไมมีผูรับสาย เมื่อมีการโอนโดยที่ไมแจงใหผูรับ

สายทราบ ระบบจะโอนสายไป 2 นาที หากไมมีผูรับสาย ระบบจะตัดสายอัตโนมัติ 

P 815   ตั้งเวลาการรับสายเมือ่มีการโอนกลับ (CO. Line Transfer Time Setting) 

         เปนการกําหนดการรับสายเมื่อมีการโอนกลับ โดยเมื่อสายที่โอนไปไมมีผูรับจะโอนกลับมา

ยังผูโอยอัตโนมัติ หากไมรับสายภายในเวลาที่กําหนด ระบบจะตัดสายทันที 

P 816   ตั้งเวลาการคางสาย  (CO. Line System Hold Time Setting) 

 ตั้งเวลาการใช ปุม Hold ของเครื่องคีย เมื่อพักเกิน 5 นาที ระบบจะเรียกกลับมายังผูที่ทําการ 

Hold สายนั้นไว 

P 817   ตั้งเวลาการรับฝากสาย (CO. Line System Park Time Setting) 

 การพักสายโดยการ กดรหัสพักสายโดยการปารค หากพกัเกิน 5 นาที แลวไมมีผูรับ ระบบจะ

เรียกกลับไปยงัผูที่ทําการปารคสายนั้น 

P 809   กําหนดเวลากดเลขหมายโทรออกหลักแรก (CO. Line Frist-Digit Time Setting) 

 เปนการตั้งเวลากดเลขหมายโทรออกหลักแรก สวนของ OGM. จะคอยสัญญาณการกดหลัก

แรกอีก 5 นาท ีหลังเสียงพูดจบหากไมมแีลว จะทาํงานอืน่ตอไป 

P 810   กําหนดเวลากดเลขหมายโทรออกหลักตอไป (CO. Line Inter-Digit Time Setting) 

 เวลาที่ OGM. จะคอยรับหมายเลขตอๆไปเปนเวลา 5 วนิาที เมื่อไดรับหมายเลขหลักแรกแลว

เมื่อเกินเวลาทีก่ําหนด ระบบจะรองขอใหทาํรายการใหม 

P 819   กําหนดชวงเวลาในการโอนสาย (No Answer Transfer Time Setting) 

 เปนการกําหนดชวงเวลาในการโอนสาย วาตองการให วางสายเมื่อไมมกีารตอบรับ 
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2. Parameter 2 

 
 
P 820   กําหนดการตัง้ปลุก วนซ้ํา (Retry Wake up) 

 เปนการกําหนดชวงเวลาในการปลุกวนซ้ํา (เปนครั้ง) 

P 821   กําหนดชวงเวนระยะเวลาปลุกคร้ังแรก (Frist Wake up Duration) 

 เปนการกําหนดการเวน ระยะการตั้งปลุก  

P 822   กําหนดชวงเวลารวมการปลุก (Extend Wake up Time) 

 เปนการกําหนดวาตองการใหตั้งปลุกนานเทาไร 

P 823   กําหนดระยะเวลาการตั้งปลุก ลาสดุ (Last Wake up Duration) 

 เปนการกําหนดชวงเวลาการตั้งปลุกครั้งลาสุด 

P 824   กําหนดชวงเวลาการตั้งปลุกเปน ชวงๆ (Flash Extend wake up Time) 

 เปนการกําหนดชวงเวลาการตั้งปลุกเปน ชวงๆ  
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P 829   กําหนดตารางการตั้งปลุก (Scheduled Task) 

             การกาํหนดการตั้งปลุกเปนตาราง 

 

 

 
 
 
P 830   กําหนดระดับสัญญาณของสายใน (DTMF Level for Extension) 

             การกาํหนดระดับสญัญาณ DTMF ของสายใน (0-255) 

P 831   กําหนดระดับสัญญาณของสายนอก (DTMF Level for CO.) 

             การกาํหนดระดับสญัญาณ DTMF ของสายนอก  (0-255) 

P 832   กําหนดระดับความดังของสัญญาณโทน  (Call Progress Tone Level) 

             การกาํหนดระดับความดังของสัญญาณโทน  (0-255) 

 

 

00000000       =   ไมต้ังปลุก 

WW  00           =    ต้ังปลุกทุกวัน (01‐07 : จ. – อ.) 

HH    00 ‐ 23    =    ช่ัวโมง 

MM  00 ‐ 59    =    นาที 

SS      00 ‐ 59    =    วินาที 

Note…. สําหรับ P8XX สามารถ Load Defalut  ไดโดยการ ดับเบิ้ลคล๊ิก ที่ตารางที่ตองการ คืนคา
โรงงาน 
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บทที่ 8 

โปรแกรมพิเศษสําหรับชวยงาน  P9XX Special Programming 

เปนโปรแกรมที่ทําใหการโปรแกรมตูสาขาโทรศัพททําไดอยางถูกตองและรวดเร็ว กลุมของ
โปรแกรมนี้จะเปนโปรแกรมสําหรับผูจัดการระบบจะทําเมื่อติดตั้งตูใหม 

คลิกเลือกที่ Operation->Special Program จะแสดง Page ดังรูป  
 

 
 
P100#900  เรียงลําดบัสายนอกอัตโนมัติ (Auto arrange CO.Line) 
 โปรแกรมจะทาํการเรียงลําดบัสายนอก ในตูสาขาฯ ใหอัตโนมัติ  
 
P900 กําหนดคาจากโรงงานทั้งหมด (All Default Config) 
 โปรแกรมกําหนดคาพารามิเตอรตาง ๆ จากโรงงาน สําหรับตูที่ติดตั้งใหมทกุครั้งจะตอง
 ทําโปรแกรมนี้ หรือเมื่อขณะโปรแกรมตูแลวตองการลางคาพารามิเตอรที่ไดแกไขแลวใหเปน
 คาจากโรงงานทั้งหมด 
 
P901 บริการกลางวนัเหมือนกลางคืน (Night Mode Copy) 
 โปรแกรมกาํหนดใหการทํางานในเวลากลางคืนเหมือนกลางวัน เมื่อติดตั้งตูที่ไมมีการ ใชงาน
 ที่แตกตางกนัระหวางกลางวนักับกลางคืน  
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P902 กําหนดคาจากโรงงานแบบเลอืกได (Selectable Default Config) 
 โปรแกรมกําหนดคาพารามิเตอรบางสวนจากโรงงานซึ่งบางครั้งในระหวางการโปรแกรมตู 
 อาจตองการกลับไปใชคาโรงงานบางสวน (สามารถเลือกใชโปรแกรมได) 
 

 
P903 ปรับปรงุใหเปนโปรแกรมใหม (Version Update) 
 เปนการโปรแกรมเพื่อส่ังงานใหตูใชโปรแกรมรุนใหมที่เปลี่ยนใหสําหรับควบคุมระบบ  
 

P904 พื้นท่ี ท่ีติดตั้งตูสาขา(Billing Zone) 
 โปรแกรมพื้นที่ติดตั้งตูสาขาโทรศัพท เพือ่สะดวกในการกําหนดการคิดเงินคาโทรศัพท ใน
 การติดตั้งตูและมีการใชระบบคิดเงินภายในตู ระบบจะใชตารางคิดเงนิเมื่อติดตั้งในกรุงเทพฯ 
 หากติดตั้งตูฯ นอกเขตพื้นที่กรุงเทพฯ จะตองทําการโปรแกรมขอนี้เพื่อใหตูรูวาจะเปลี่ยนไป
 ใชตารางคิดเงนิของจังหวัดใด (แบงเปนภาค) 
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บทที่ 9 

Monitor 

1. แนะนําความสามารถใหมๆ บน Config builder Version 1.5.0  

 1.1. Config builder Version 1.5.0 ถูกพัฒนาใหรองรับใชงาน การ System Monitor 

 1.2. เพิ่มความเร็วในการ รับสงขอมูล ผานทาง LAN Port เร็วข้ึน 3-4 เทา (ใกลเคียง Serial Port) 

 1.3. สามารถดูรายงาน/พิมพ SMDR ของคาโทรศัพทและ ECS(Energy Control System) 

 1.4. เชื่อมตอระหวางโปรแกรม Config builder กับ ตูสาขาฯ แบบอัตโนมัติ 

Interface ของ  System Monitor 

1. แสดงหนาของ สายใน (Extension) 
2. แสดงหนาของ สายนอก (Co. Line) 
3. แสดงหนาของ Power 

หมายเหต:ุ ระบบจะแสดงจํานวนพอรต ของสายใน, สายนอก, Power โดยอัตโนมัติ (ตอง Connect กับ
ตูสาขาฯ แลวเทานั้น) 
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2. ความสามารถใชงานของ System Monitor  

 2.1. แสดงสถานะ การใชงานของ สายใน, สายนอก, Power 

 2.1.1 สายใน แสดงสถานะ(Idle, Off Hook, Calling Out, Talking, Call in, Hold, Caller ID, 
การใชงาน Function) 

       ความหมายของสถานะแตละ Function 

 

L = Lock, C= Call Forward, W=Wake UP, 1-9 = Room Type 1-9  

           และในระหวาง Intercom, Outgoing, Incoming ก็จะแสดงหมายเลขคูสนทนาดวย 

Intercom จะแสดงหมายเลขคู สนทนาดวย  

    

Outgoing จะแสดงลําดับสายนอกที่ใชโทรออก และหมายเลขที่โทรออก 

 

Incoming จะแสดงลําดับสายนอกที่ใชโทรเขา และหมายเลขที่โทรเขา 

 

      2.1.2 สายนอก แสดงสถานะ(Idle, Off Hook, Calling Out, Talking, Call in, Hold, Caller ID) 

            และในระหวาง Intercom, Outgoing, Incoming ก็จะแสดงหมายเลขคูสนทนาดวย 

 Outgoing จะแสดงหมายเลขที่โทรออก และสายในที่ใชโทรออก 

 

Incoming จะแสดงหมายเลขที่โทรเขาและสายในงาน 
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หมายเหต:ุ ในชองของ Ext.และ Co. เราสามารถกําหนดสีแตละสถานะ ได (จะกําหนด Color of 
status ไดตองอยูใน Offline Mode เทานั้น) โดยเขาไปที่(Setting>Color of status) แลวคลิกเลือกสีที่
ตองการ 

 

                                  

 

 

 2.1.3 Power แสดงสถานะ (ระยะเวลาการใชงานPower, สถานะของ Power) 

   สถานะของ Power 

ปดการใชงาน=  (ไมปรากฏสี) 

 

เปดมีการจาํกัดเวลาใชงาน=  (สีเหลือง) 

 

เปดแบบไมมีการจํากัดเวลา=   (สีแดง) 
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3. การ Config คาพารามิเตอรผาน System Monitor ไดทั้ง Extension และ Power 

    3.1 Extension สามารถ Config คาพารามิเตอรอะไรไดบาง 

Name of Extension 

Lock โทรออก 

Room Type 

Wake Up 

Language 

การใชงาน User ID 

Call Forward  

Do not disturb  

  

 

 



 

 

J - 5 

3.2 Power สามารถ Config คาพารามิเตอรอะไรไดบาง 

      สงปด-เปด Power โดยอางอิง P307-308-311 

 

 

                                                                    

 

 

 

 

 

 

 

 

อางอิง Mode การทํางาน แลว ระยะเวลา คือใชจายที่ P307-

308-311 ตามลําดับ 
จะปรากฎชองใส คาใชจาย หากไมได 

โปรแกรมที่ P311 

Power Custom คือ เมนูกําหนดคาใชจาย Power แบบกําหนดเองโดยไมไปอางอิงที่ 

P307,308,311  

การเขาไป Config เขาไปที่ 

Setting > Power Customize 



J - 6 

 

4. ระบบ SMDR 

ขอควรระวัง ของการเชื่อมตอ SMDR ก็คือ เมื่อใช System Monitor ดู SMDR ตูที่ 1 แลว หากนํา  

System Monitor ไปดู SMDR ตูที่ 2 ระบบจะทําการลบขอมูล SMDR ของตูที่ 1 ออกทั้งหมด ใหเหลือ 

เพียงขอมูล SMDR ของตูที่ 2 เทานั้น  เพื่อปองกันการนํา SMDR ของตูที่ 1 และ 2 มารวม กัน 

 

ในสวนของ System Monitor จะมจีุดแสดง SMDR อยู 3 จุดดวยกัน คือ 

1. จะมีการแสดง SMDR ที่หนาแรกของ System Monitor (SMDR ในหนานี้ จะแสดง แบบ Circuit  

    กลาวคือ จะแสดงขอมูลลาสุด ตอจากครั้งที่แลว) 

 

2. ชองแสดง SMDR ที่ Extension (จะสามารถรายงานขอมูล SMDR ที่ Extension นั้นๆ หรือ จะดูทกุ 
Extension ก็ได หรือเลือกขอมูล SMDR ที่เราอยากจะด ูแลวสามารถพิมพออกมาไดดวย) 

ขั้นตอน    

- ดับเบิ้ลคลิกที่ Extension นั้นๆ                               แลวคลิกเขาที่ เมน ูView SMDR  
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- กําหนดเงื่อนไขการเขาดู SMDR  

    1. กําหนด Start Date และ End Date 

    2. กําหนดวาจะใหแสดงคาอะไรบาง 

       แสดงขอมูลการโทรเขา 

    แสดงขอมูลการโทรออก 
    แสดงขอมูล System 
    แสดงขอมูล Service 
    แสดงขอมูล ทุกๆ Extension 
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และสามารถสั่ง Print ไดดวยโดยการคลิกกดที่เมนู Print จะปรากฏ หนาที่ปรากฏจะสั่ง Print ขึ้นมา 

 

 

 

 

 

 

 

 

 

3. ชองแสดง SMDR ที่ Power (จะสามารถรายงานขอมูล SMDR ที่ Power นั้นๆ หรือ จะดูทุก Powerก็ 

ได หรือเลือกขอมูล SMDR ที่เราอยากจะด ูแลวสามารถพิมพออกมาไดดวย) 

- ดับเบิ้ลคลิกที่ Power นั้นๆ                                   แลวคลิกเขาที่ เมนู View SMDR  

 

 

 

 

 

 

 

 
 


